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Read This First

This Maintenance Information (MI) is intended for use only by trained, IBM service personnel.

About This Information
v Go to the Maintenance Starting Point on page 1-1 to begin all service procedures.

v Examples of screens that are depicted in this MI may appear differently for you.

v The glossary, beginning on page B-1, provides terms and abbreviations that are used throughout this
MI.

What's New In This 27th Edition (August 2011)
Revision bars (|), like the one to the left of this text, appear next to information that has been added or
changed since the previous edition.

Significant changes that were made:
v In Chapter 2, new topic added: "Adding a 3584 Model SC1 Complex System."
v In Chapter 2, new TSSC model added: "x3250 M3, Type 4252 Model PCJ."

Modified:
v In Chapter 2, new topic added: "Delete InfoCenter."
v In Chapter 2, new screens and procedures added to topic: "Configuring Call Home Settings Electronic

Customer Care."
v In Chapter 3, topic "Importing and Launching InfoCenter From Web Interface" was modified and

renamed to, "Managing InfoCenter From Web Interface".
v In Chapter 3, topic, "Configuring Assist On-Site (AOS)," added information "To Add or Edit Proxy

Support."

Send Us Your Feedback
Send us your comments about this MI by e-mail to starpubs@us.ibm.com. When sending your comments,
be sure to include:
v Exact publication title
v Form number, or part number and EC level (located on the back cover)
v Page numbers to which you are referring
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Preface

This manual is for use by service personnel who intend to install, remove, diagnose, repair, or test the IBM
TS3000 System Console.

Related Information
Additional information related to the system console is available in the following publications:

v IBM Virtualization Engine TS7700 Information Center

v IBM Virtualization Engine TS7700 Installation Roadmap for use with IBM System Storage TS3500, IBM
3584 Tape Library

v Systems Safety Notices (formerly known as "eServer Safety Notices"), G229-9054

IBM 3584 Information
Additional information related to the IBM 3584 Automated Tape Library is available in the following
publications:

v IBM System Storage TS3500 Tape Library with ALMS Introduction and Planning Guide, GA32-0593

v IBM System Storage TS3500 Tape Library with ALMS Operator Guide, GA32-0594

v IBM System Storage TS3500 Tape Library SCSI Reference, GA32-0561

v IBM System Storage TS3500 Tape Library (3584) Maintenance Information

IBM 3494 Automated Tape Library Information
Additional information related to the IBM 3494 Automated Tape Library is available in the following
publications:

v IBM 3494 Tape Library Operator's Guide, GA32-0449

v IBM 3494 Tape Library Operator's Quick Reference, GX35-5049

v IBM 3494 Tape Library Operator's Introduction and Planning Guide, GA32-0448

v IBM 3494 Tape Library Maintenance Information

IBM 3953 Information
Additional information related to the IBM 3953 is available in the following publications:

v IBM System Storage 3953 Tape System Introduction and Planning Guide, GA32-0557

v IBM System Storage 3953 Library Manager L05 Operator Guide, GA32-0558

v IBM 3953 Installation Road Map

IBM System p (AIX) Information
See “Web Site Information” on page xviii for access to the latest System p information and publications.

IBM 7133 SSA Disk Subsystem Information
Additional information related to the 7133 SSA Disk Subsystem and software is available in the following
publications:

v 7133 SSA Disk Subsystem: Operator Guide, GA33-3259

v 7133 SSA Disk Subsystem: Service Guide, SY33-0185

v 7133 Models D40 and T40 Serial Disk Systems: Service Guide, GY33-0192

v 7133 Models D40 and T40 Serial Disk Systems: D40 Installation Guide, GA33-3279

v 7133 Models 010 and 020 SSA Disk Subsystem Installation Guide, GA33-3260

v Adapters, Devices, and Cable Information for Micro Channel Bus Systems, SA23-2764
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v SSA Adapters: User's Guide and Maintenance Information, SA33-3272

Device Drivers Information
v IBM Tape Device Drivers Installation and User's Guide, GC27-2130

Web Site Information
Table 1. Information Web Site URLs

IBM® RMSS product manuals http://www.storage.ibm.com/hardsoft/tape/pubs/pubs3592.html

Minimum microcode requirements http://www-03.ibm.com/servers/storage/tape/drives/

FIPS PUB 140-2, Security Requirements
for Cryptographic Modules

http://www.itl.nist.gov/fipspubs/

RMSS PFE home page http://snjlnt02.sanjose.ibm.com/tape/tapetec.nsf

Device drivers ftp://ftp.software.ibm.com/storage/devdrvr/Doc/

Terms not found in Glossary www-01.ibm.com/software/globalization/terminology/index.jsp
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Chapter 1. Maintenance Starting Point

Complete this task before starting any maintenance activity.

Attention: Some system console keyboards include an integral USB port. Do not use this USB port
while using the system console.

Before beginning any maintenance activity using the IBM TS3000 System Console (System Console or
TSSC, for short), you must determine the proper microcode (code) level of the System Console.

1. Go to the TS3000 System Console Screen Login screen and determine the code level.

2. Refer to the TSSC documentation for your symptom or reason.

Quick Reference Table
Table 1-1. Maintenance Starting Point - Quick Reference Table. For Code Level V3.0.0 and Above

If you are here to . . . . . . then go to this section:

Install new System Console “Performing Installation” on page 2-7

Configure remote system “Tape System Call Home Setup for VTS, VTC, and Tape Controllers” on page 2-20
“Tape System Setup for 3494 ATL (Library Manager) or 3953 Enterprise Library
Controller” on page 2-23

Configure System Console “Configuration” on page 2-34

Authenticate login (password
broadcast)

“Login Options” on page 2-35

Load code “Code Load/Hard Drive Rebuild” on page 3-60

Rebuild hard drive “Code Load/Hard Drive Rebuild” on page 3-60

Repair the System Console “System Console Repair” on page 4-1

a
1
4
o
r3

0
3

Figure 1-1. System Console Login Screen. - Code Level Listed
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Table 1-1. Maintenance Starting Point - Quick Reference Table (continued). For Code Level V3.0.0 and Above

If you are here to . . . . . . then go to this section:

Restore configuration data “Restoring Configuration Data” on page 2-73

Setup for remote data
monitoring

“Setup for Remote Data Monitoring (VTS, VTC, A60, J70, C06)” on page 2-82

– – OR – –

“Setup for Remote Data Monitoring (3494 ATL or 3953 Enterprise Library Controller)”
on page 2-86

Telnet to an attached tape
system

“Telnet to Attached Tape System” on page 3-1

Access system remotely “Remote Access Using NetTerm” on page 3-19

Broadcast control unit code “Remote Code Broadcast By Using the Web Interface” on page 3-8

Broadcast tape drive code “Tape Drive Code Broadcast From Web Interface” on page 3-16

Set date and time “Setting Console Date and Time” on page 2-75

Notes:
v If you are here to isolate or repair a PC problem, refer to the Maintenance Information (MI) for your PC. A softcopy

of the IBM MI for the PC may be found on the Documents CD which shipped with the System Console.
v For the latest System Console information, go to the PFE website at:

http://snjlnt02.sanjose.ibm.com/tape/tapetec.nsf/pages/TSSCinfo

Console Configuration Utility Screen Menu Tree

Table 1-2 provides a graphic view of the relationship of Console Configuration Utility screen menu items.
These items appear on the screen shown in Figure 2-45 on page 2-38.

Table 1-2. Console Configuration Utility Screen Menu Items

Function Name Screen Selection and Location

Attached Systems Figure 2-46 on page 2-39

Backup/Restore
v Backup Console Configuration Data
v Restore Console Configuration Data

v Figure 2-97 on page 2-71
v Figure 2-99 on page 2-74

Call Home Queue Figure 3-28 on page 3-23

Call Home Settings
v General Settings
v Location Settings
v Phone Settings
v Machine Settings
v Disposition Settings

v Figure 2-87 on page 2-62
v Figure 2-89 on page 2-65
v Figure 2-90 on page 2-65
v Figure 2-91 on page 2-66
v Figure 2-92 on page 2-67

Console Settings
v IP Settings
v Custom Firewall Settings

v Figure 2-85 on page 2-58
v Figure 2-86 on page 2-61

Console Status
v Console Message File
v Test RETAIN Connection
v Console VPD
v Test ECC Connectivity

v Figure 3-73 on page 3-54
v Figure 2-104 on page 2-78
v Figure 3-77 on page 3-56
v Figure 2-106 on page 2-79

Console Time Figure 2-101 on page 2-76

Fix Acquisition “Fix Acquisition” on page 3-86

Modem Transmission Query Modem Transmission (not shown)
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Table 1-2. Console Configuration Utility Screen Menu Items (continued)

Function Name Screen Selection and Location

Network Information (Not shown)

Offload User Files Figure 3-38 on page 3-31

PE Packages
v System Console PE Package
v Subsystem Log Retrieval

v Figure 3-65 on page 3-49
v Figure 3-67 on page 3-50

System Interfaces Figure 3-94 on page 3-74

System tools v “Remote Code Broadcast By Using the Web Interface” on page 3-8
v “Tape Drive Code Broadcast From Web Interface” on page 3-16
v “Managing InfoCenter From Web Interface” on page 3-74
v “Adding PFE Execs From Web Interface” on page 3-80

Chapter 1. Maintenance Starting Point 1-3
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Chapter 2. Installation

Introduction

The System Console can provide remote support for as many as forty-three attached tape systems.
Remote support capabilities of the System Console, in conjunction with tape systems, include:

v Call Home problem reporting capability with staged, error-specific Data Gathering for support

v Call-in capability with authenticated access (via modem) including file transfer and multiple connections
with attached systems

v Simultaneous call home and call-in capability using dual modems (not available with IBM 3953 models)

v Automatic wellness checking for attached systems

v Ability to defer certain types of call home activity to specific business hours

v Automatic archival of log files for most attached tape systems for subsequent support reference

v Automatic download and storage of new tape drive code images via modem connection with IBM
Remote Technical Assistance Information Network (RETAIN)

Additionally, the System Console provides a convenient focal point for local service activities within the
data center. The System Console is attached via 100 Mbps ethernet to each tape system. Many tape
system service functions may actually be performed at the console. The System Console provides the
following local service tool applications:

v Ability to telnet to multiple tape systems and simultaneously perform multiple service tasks from the
System Console

v Graphic user interface for tape system and tape drive service diagnostic utilities

v Ability to broadcast control unit and tape drive code images to tape systems for subsequent activation
from the System Console

v Diagnostic tools for verifying communications with IBM RETAIN

v Graphic user interface for configuring, backing up, and restoring System Console settings

The System Console is available as Feature Code 2721 with IBM Enterprise Tape Systems and
Controllers (3494 VTS B10/B18/B20, VTC AX0/CX1, ATL L12/L14/L22, 3590 A60, 3592 J70, 3592 C06,
3956 Cxx, and 3957 Vxx). Previous remote support feature codes 2710, 2711, and 2712 only included
problem reporting capability via modem without data gathering support, and allowed fewer tape systems
per modem connections. Simultaneous inbound and outbound communications were not supported.

The data gathered during the call home process is available for IBM support personnel on the RMSS Call
Home Database at:
https://callhomedata.tucson.ibm.com

Overview
Use Figure 2-1 on page 2-2 with Table 2-1 on page 2-2 as a representation of a potential connection
scheme for the System Console.
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Table 2-1. System Console Components. Use with Figure 2-1.
1 Serial connector 6 Ethernet hub-expansion FC 2714
2 Ethernet hub FC 2722/2732 7 Cable supplied with FC 2714
3 Cable supplied with FC 2722/2732 8 Second modem FC 2716 (not on IBM 3953)
4 Cable supplied with FC 2715 9 Customer supplied Ethernet connection FC 2722/2732
5 Cable supplied with FC 2714

Note: Outbound modems can be replaced with high-speed internet connections.

Feature Codes

Notes:
v Figures representing each feature code begin with Figure 2-3 on page 2-5.
v Feature code 2713 is not mentioned in this section. This feature code only applies to server

models 6579, 6792, 8480, and 8482. FC 2713 server models are not supported in code levels
V5.0 and above.

** Feature Codes (Current) **

Feature Code 2714 (LAN Hub Attachment Expansion / Console Expansion)

v The LAN Hub Attachment Expansion (Console Expansion) feature is required when additional LAN ports
are required. Uplink ports are used to connect the hubs.

Note: This feature code also can be used on a 3953 Enterprise Library Controller, so you can use an
existing feature code 2720 as the System Console.

TS7700

2

3

4

5

6

7

a
6

9
i0

3
5

4

System Console
(TSSC)

NIC/LAN
Ethernet

Tape System

Tape System

9

1

8

Figure 2-1. System Console Connection Diagram. Use with Table 2-1
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Feature Code 2715 (Cable Attachment / Console Attachment)

v This Cable Attachment (console attachment) feature drives a single 15.2-m (50-ft) ethernet cable for
downstream-attached tape systems.

v For an IBM 7588, you will be shipped a four-port card and an ethernet cable.

Feature Code 2722 (Rack Mount TS3000 System Console. Available via Factory or MES)

This feature provides the enhanced rack-mountable TS3000 System Console, an Ethernet switch, an
Ethernet cable, KVM cable, and connectors for connection of one machine to an IBM supplied internal
modem to enable remote enhanced service. This feature is an enhanced replacement of the IBM TS3000
System Console for Service (#2721). Includes console upgrade previously provided as FC #2719 (Memory
upgrade to 4 GB total RAM and a second Ethernet card for the Service Console to allow redundant
connections into the service network). This feature applies to 3958, 3593, and 3592 machine types.

The following table shows what IS and what is NOT included in this feature code:

Table 2-2. List of Items included for FC 2722

FC 2722 Server / SMC Switch Display Tray KVM Switch

3953 Yes No * No *

3958-DD4 Yes Yes Yes

3958-AP1 Yes Yes Yes

* These parts are not shipped. They were provided on the original machine or a previous feature code.

Feature Code 2732 (Rack Mount TS3000 System Console. Available via Factory or MES)

This feature provides the enhanced rack-mountable TS3000 System Console, an Ethernet switch, an
Ethernet cable, KVM cables, console kit, and connectors for connection of one machine to an IBM
supplied internal modem to enable remote enhanced service. This feature is an enhanced replacement of
the IBM TS3000 System Console for Service (#2730). It includes console upgrade previously provided as
FC #2719 (Memory upgrade to 4 GB total RAM and a second Ethernet card for the Service Console to
allow redundant connections into the service network). This feature applies to 3958, 3593, and 3592
machine types.

The following table shows what IS and what is NOT included in this feature code:

Table 2-3. List of Items included for FC 2732

FC 2732 Server / SMC Switch Display Tray KVM Switch

3584 Yes Yes No

3592 Yes Yes No

3952 Yes Yes No

3958-DD3/DD1 Yes Yes No
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The server you received is shown below.

Feature Code 2733 (TS3000 System Console Internal Modem)

This feature provides an internal modem and customer phone line (wall) adapter based on country order.

** Feature Codes (Withdrawn) **

Feature Code 2716 (Second Modem) (not available for 3953)

v The Second Modem feature enables simultaneous, inbound and outbound communication (when two
analog lines are provided) with the System Console. The feature includes an MT5600 BA external
modem and a serial cable.

Notes:
– The Second Modem feature requires two analog telephone lines for simultaneous inbound

and outbound communication. The system can be configured to operate with one modem.
– When two modems are installed, the modem on COM1 can be configured to be the inbound

modem, and the modem on COM2 can be configured to be the outbound modem. If only
one modem is installed, it must be installed on COM1. It will be used for inbound and
outbound communication.

Feature Code 2717 (3592 A60 Attachment)

v This feature code enables the System Console to be attached to one or more A60s via a Net Interface
Card added to the A60.

Note: The A60 must be at code level 1.16.x.xx or above in order to attach to the System Console.

Feature Code 2718

v This feature code has been replaced by feature code 2721.

Feature Code 2719 (Console Upgrade)

v This feature provides a memory upgrade to 2.14GB (2GiB) of total RAM and a second ethernet card
for the System Console to allow redundant connections into the service network, and to allow
broadband call home capability. This feature only applies to System Consoles shipped with feature
codes 2718, 2720, and 2721.

Note: This feature code is required for TS7700 attachment.

Feature Code 2720 (System Console)

Power
connector

Video
connector

Serial
connector

Internal
172.31.1.x
Connection

External ECC/Call
Home Connection

Grid AOTM
Connection Modem

a
1

4
o

r5
4

4

Figure 2-2. Network Connection Diagram – x3250 M3, Type 4252 Model PCJ (FC 2722, FC 2732)
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This feature includes the listed hardware that is required to support the System Console (see feature code
2721 for 3953 Enterprise Library Controller).

Note: An existing feature code 2720 can be used with the 3953 Enterprise Library Controller, if you select
feature code 2714 for the 3953.

v IBM System Console

– A PC, complete with an Ethernet port. One MT5600 BA external modem, serial cables, and a color
monitor are packaged separately. The System Console is preloaded with software, and it is tested
prior to shipment.

v LAN Hub Attachment

– This is a 16-port unit. One hub will be included with feature code 2720, and as many as two
additional hubs can be attached downstream, with cascading, using uplink ports. This allows a
maximum of forty-three connections to each System Console.

v LAN Cabling

– Two 15.2-m (50-ft) ethernet cables are supplied with feature code 2720. One cable is used to
connect the System Console controller to the internal port on the ethernet hub. The second cable is
used to connect the external port to the first downstream tape system. Additional cables are supplied
with feature code 2714 or feature code 2715, depending on expansion port requirements.

v System Console Product Recovery CD-ROM

– Feature code 2720 includes a Product Recovery CD-ROM that will serve as the basis for rebuilding
the hard disk in the event of a failure. The code image CD is boot-able and is self-extracting. The
CD-ROM includes:

- Factory default hard drive image

- System Console dynamic update capability

- IBM PC Hardware Maintenance Information in PDF format, which may be viewed by placing the
CD in a computer with Adobe Acrobat Reader (Version 4.0 or later)

– IBM Enhanced Diagnostics CD-ROM

Feature Code 2721 (System Console - for 3953 Enterprise Library Controller only)

v This feature code is similar to feature code 2720, but is for the 3953 Enterprise Library Controller. Use
the ethernet port that is identified as 'Internal Ethernet Connector' in the following figures.

Grid Ethernet ConnectionInternal Ethernet Connection

External Ethernet Connection a
1
4
o
r3

3
6

Figure 2-3. Network Connection Diagram – 8836 (3953 Only) (FC 2718, FC 2719)
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Grid Ethernet Connection

Internal Ethernet Connection External Ethernet Connection

a
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4
o
r3

3
5

Figure 2-4. Network Connection Diagram – 8849 (FC 2719, FC 2721)

Grid AOTM Connection

Internal 172.31.1.x Connection External ECC/Call Home Connection

a
1
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5
1

Serial

Figure 2-5. Network Connection Diagram – 7978 (FC 2719, FC 2721)
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Grid
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COM1

COM2

Figure 2-6. Network Connection Diagram – 8482, 8485 (FC 2719, FC 2720)
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Performing Installation

Ensure that the prerequisites in Table 2-4 have been met before you begin the installation.

Notes:
v This connection will be used for high speed call home functionality. This connection is not

required if a modem is being used.
v See “Feature Codes” on page 2-2 for details about feature code content.

Table 2-4. Installation Prerequisites

Prerequisites Notes

Analog telephone lines - two preferred, one
minimum (3953 only allows one)

Note the modem telephone numbers for the Console Configuration
Sheet

One Ethernet connection This connection will be used for high-speed, call home functionality,
and is not required of a modem exists

Five to seven power outlets Modem uses plug transformer - may take up more than one outlet

One floppy diskette, a USB storage device,
or a CD (model dependent)

For activities such as, backing up configuration files, offloading user
files (recommended, but not required)

Completed Console Configuration Sheet See Table 2-6 on page 2-9

Accessible area for installation and
placement

Adequate space and location for installation, access, and operation

a
1

4
o
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Internal
172.31.1.x
Connection

External
ECC/Call Home

Connection

Grid
AOTM

Connection

COM2

COM1

Figure 2-7. Network Connection Diagram – 4362 (FC 2719, FC 2720)
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Here is a summary of the steps you will take in this section to install the System Console.

Note: If you are performing an MES for the following feature codes, FC 2721, FC2722, FC2730, and
FC2732, or if you are installing the FC2732 into a customer's rack, see the Installation Instructions
provided with the TSSC server.

System Console Setup

1. Unpack and assemble System Console.

2. Install modems. (When using feature code 2718 and 2721, an internal modem requires an analog
telephone line. When using feature code 2720, either one or two modems must be installed. See Step
6 on page 2-11.)

Note: Feature code 2721 has an internal modem.

3. Install ethernet switch and connect to System Console.

4. Power on the System Console.

Tape System Setup and Configuration.

1. Complete network connection to tape system for System Console attachment.

2. Perform software configuration on tape systems for System Console attachment.

System Console Configuration

1. Login to System Console.

2. Add information for attached systems.

3. Configure call home settings.

4. Backup configuration settings (recommended, but not required).

5. Set console date and time.

6. Test network connection to tape systems.

7. Test modem connection to RETAIN.

8. Log out of System Console.

Test Tape System Configuration

1. Perform test call home notification.

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
Chapter 1, “Maintenance Starting Point,” on page 1-1 to determine the code level.

Completing Installation

1. Proceed with the physical layout and installation of the System Console unit in a central location at the
customer's site. Power cords are supplied in the ship group with the feature to satisfy the various
country power requirements. Ensure that power feeds are available for the following components
(basic, wall-outlet power is sufficient). One of each of these items is provided:
v System Console unit
v Monitor *
v Modem1 *
v Modem2
v LAN Hub1
v LAN Hub2
v LAN Hub3

Note: * These items are integrated into the 3953 Enterprise Library Controller.

2. Before you configure any attached systems at the System Console, ensure that you have:
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v Chosen subsystem IP addresses

v Completed a Console Configuration Sheet (see Table 2-6)

Keep the completed Console Configuration Sheet near the System Console. Table 2-5 provides a
sample of a completed Console Configuration Sheet.

Table 2-5. Console Configuration Sheet – Sample

IP Address
Attached System

Type/Model
Serial No. Host Name Modem Tel. No.

172.31.1.1 System Console N/A tssnet1 202–555–1111

172.31.1.2 3494 B20 13AAA10 VTS1 202–555–1111

172.31.1.3 3494 B20 13ABC11 VTS2 202–555–1112

172.31.1.45 3592 J70 13ABC12 3592CU40 202–555–1113

... ... ... ... ...

IP addresses in the form 172.31.1.x (where 'x' is 2 through 253) may be assigned to tape subsystems.
The IP address choice must conform to the following guidelines:
v Assign IP addresses by using the subnet 172.31.1.x; otherwise TCP/IP communication with the

console will not work.
v IP addresses must be unique and must not be duplicated between subsystems. Entry fields on

subsystems may be pre-filled with suggested, default values. You must change these values when
more than one library complex is connected to the System Console.

v When connecting multiple subsystems with default IP address settings to the System Console
network, connect and configure the systems one-at-a-time to prevent the possibility of duplicating IP
addresses, which would create network errors. Refer to the maintenance information for each tape
system for specific recommendations.

v The System Console supports attachment of as many as forty-three systems using as many as
three ethernet hubs or switches for attachment.

v The maximum, total (cumulative), cable length for connection between the System Console and any
subsystem is 100 m (300 ft).

Use the Console Configuration Sheet in Table 2-6 to choose and pre-assign IP address for attached
tape systems. Consider making a photocopy of this blank configuration sheet, then filling-in the fields.

Note: Keep a current copy of the filled-in Console Configuration Sheet (Table 2-6) in an accessible
location for future reference and modification. You can use this to retrieve subsystem
information following a system failure.

Table 2-6. Console Configuration Sheet – Actual. Copy this table, and use that copy to fill in this information.

IP Address
Attached System

Type/Model
Serial No. Host Name Modem Tel. No.

172.31.1.1 System Console tssnet1

Modem1

Modem2

172.31.1.___

172.31.1.___

172.31.1.___

172.31.1.___

172.31.1.___
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Table 2-6. Console Configuration Sheet – Actual (continued). Copy this table, and use that copy to fill in this
information.

IP Address
Attached System

Type/Model
Serial No. Host Name Modem Tel. No.

172.31.1.___

172.31.1.___

172.31.1.___

172.31.1.___

172.31.1.___

172.31.1.___

172.31.1.___

172.31.1.___

172.31.1.___

172.31.1.___

172.31.1.___

172.31.1.___

172.31.1.___

172.31.1.___

172.31.1.___

172.31.1.___

172.31.1.___

172.31.1.___

172.31.1.___

172.31.1.___

172.31.1.___

172.31.1.___

172.31.1.___

172.31.1.___

172.31.1.___

172.31.1.___

172.31.1.___

172.31.1.___

172.31.1.___

172.31.1.___

172.31.1.___

172.31.1.___

172.31.1.___

172.31.1.___

172.31.1.___

172.31.1.___

172.31.1.___

172.31.1.___
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3. Unpack the System Console. (If you are using the 3953 Enterprise Library Controller, skip to Step 6d).

4. Attach the keyboard, the mouse, and the main power cord.

5. Unpack the monitor, and attach the appropriate power cord. The monitor VGA cable should be
attached to the video card connector.

Attention: Do not attach the monitor cable to the planar video connector, if one is present (for
NetVista models, only).

6. Unpack each external modem and each IBM serial cable.

Note: When two modems are installed, the modem on COM1 can be configured to be the inbound
modem, and the modem on COM2 can be configured to be the outbound modem. If only one
modem is installed, it must be installed on COM1, and it will be used for inbound and outbound
communication.

a. Attach the DC power converter of the modem. Do not power ON the modem power switch at this
time.

b. Attach the DB9F-end of the serial cable to the serial port of the PC that is labeled COM1. Use
COM2 for a second modem, if applicable.

Notes:
v Use Figure 2-6 on page 2-6 and Figure 2-7 on page 2-7 to guide you as you attach

cables to the COM connectors.
v IBM System x-based System Consoles do not contain labels that identify the serial

ports.
v For machine type 8480 (xSeries 205), the lower serial port (farthest from the power

cord) is COM1. The upper serial port is COM2. (not shown)
v For machine type 8482, 8485, xSeries 206, and xSeries 206M, the upper serial port

(closest to the power cord) is COM1. The lower serial port is COM2. See Figure 2-6 on
page 2-6

v For machine type 4362, xSeries 3200, the serial port directly above the video connector
is COM1. The COM2 connector is the serial port that is located to the right of these
connectors and above the fan. See Figure 2-7 on page 2-7 for location.

c. Attach the DB25M-end of the serial cable to the modem or modems (connector marked
E1ARS232C).

d. Attach the analog telephone line to the modem or modems connector that is marked "line." Note on
the Configuration sheet the telephone number of the analog line. (If you are using the 3953
Enterprise Library Controller, after completing this step, skip to Step 7.)

e. If you have a Microcomm Deskporte Modem, perform the following steps. Otherwise, go to Step
6f.

1) Remove the front panel [38 x 7.6 mm (1.5 x 0.3 in.)] (with the words "DeskPorte FAST" on it)
from the front of the modem. A series of switches is behind the panel.

2) Reset the switches to the down (D) position on the modem, as follows:
D D D D D D D D D D D D

3) Replace the front panel.

f. Power ON the modem.

Note: Modems must be connected to the console and powered on prior to booting the console.
The console initializes the modem during boot-up. If the modem is powered off or swapped
during operation, reboot the console to re-initialize the modem.

7. Use Figure 2-1 on page 2-2 to help you install all the LAN cabling. For LAN hub (P/N 18P1043) the
uplink port MUST be used for the next downstream hub in the chain (if applicable). When the uplink
port is used, it disables port 16 of that hub (that is, 15 ports + 1 uplink). For a LAN hub/switch
23R5549, you may use any port as the uplink port.

Using the supplied Ethernet cables, connect each subsystem to the hub, as follows:
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v Model B10/B20 VTS – Primary I/O drawer card slot 10

v Model B18 – Planar Ethernet port

v Model V06/V07/VEA/VEB TS7700 – FE1 port if Cisco routers are attached, and port 25 if SMC
switches are installed on the V07/VEB

v VTC – Ethernet slot 5, for 3494 AX0; Ethernet port P2 (right-hand port) for 3494 CX1

v 3590 A60

– Router WAN port (located at the rear of the SMC router) for controllers with SMC router

– Ethernet port P2 (right-hand port) for controllers without SMC router

– Non-planar Ethernet port (slot varies by configuration) for controllers without SMC router

Notes:
– The difference between P/N 18P1043 and P/N 18P5391 is:

P/N 18P1043 – LAN hub - SMC EZ Hub 10/100 5616DS - sixteen ethernet ports
(sixteen ethernet hub ports, or fifteen ethernet hub ports plus one uplink port)
P/N 18P5391 – LAN switch - SMC EZ Switch 10/100 1016DT - sixteen ethernet ports

– Do not use the planar ethernet port when attaching to a 3590 A60 controller.
– The A60 must be at code level 1.16.x.xx or above in order to attach to the System

Console.

v 3592 Tape Controllers

– Router WAN port (located at the rear of the SMC router) for controllers with SMC router

v 3494 ATL (L12, L14, L22 with 7581 controller PC only)

The bottom ethernet port on the system controller board (SBC card) in slot 3 on Model 7581 library
managers (see Figure 2-30 on page 2-24).

Notes:
– A 3494 ATL must be at code level 529 or above, a 3953 must be at code level LM531 or

above, and each must use a 7581 PC in order to attach to the System Console.
– If you are using a 7588 PC, you must have Feature Code 2715 installed, which will

provide a 4-port ethernet adapter, if one is not installed.

v 3584 library

The 3584 library requires a second 3584 ethernet port to enable the 3584 library to call home
through the System Console. To get this second ethernet port, the 3584 needs feature code 1660
and either feature code 1452 or 1453 installed in at least one Dxx frame. Most 3584 libraries in a
3953 environment have at least one Dxx frame with feature code 1452 or 1453 installed, since this
is required before putting drives in a Dxx frame. Refer to the 3584 Maintenance Information for
details.

8. For high-speed call home capability, connect a customer-supplied ethernet connection to the port that
is labelled External Ethernet Connection in Figure 2-3 on page 2-5, Figure 2-5 on page 2-6, and
Figure 2-7 on page 2-7. This interface will be set up in “Console Settings” on page 2-58.

9. Power on the System Console, and verify that the IBM TS3000 System Console screen displays, (see
Figure 2-41 on page 2-35). Continue to “Tape System Call Home Setup for VTS, VTC, and Tape
Controllers” on page 2-20, or “Tape System Setup for 3494 ATL (Library Manager) or 3953 Enterprise
Library Controller” on page 2-23 to configure each tape system for System Console attachment.

Note: When using a System Console that is integrated into a 3953 frame, to view the System Console at
the monitor, press the PrtScn key to view the KVM menu. Use the arrow keys to locate the System
Console connection, and press Enter.

Tape System Call Home Setup for TS7700 Virtualization Engine

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
Chapter 1, “Maintenance Starting Point,” on page 1-1 to determine the code level.
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Note: TS7700 attachment requires feature code 2718, 2720, or 2721. See “Feature Codes” on page 2-2
for details about feature code content.

1. From EBTERM or NetTerm login, at the IBM TS7700 Virtualization Engine Maintenance menu,
select Subsystem Configuration Menus.

2. Select Call Home / Remote Services Menu. Press Enter. Following screen is displayed.

3. Select IBM TotalStorage Master Console TCP/IP Configuration, and press Enter.

IBM TS7700 Virtualization Engine Maintenance

Move cursor to desired item and press Enter.

System Checkout Menus
SIM, Error Log, Diagnostics, Trace/Dump Menus
Utility Menus
Microcode Maintenance Menus
Subsystem Configuration Menus
Removal/Replacement Menus
3957-Vxx Online/Offline Menus
3957-Vxx Shutdown and Restart Menus
PFE/Support Tools Menus
TS7700 GRID Menus

F1=Help F2=Refresh F3=Cancel F8=Image
F9=Shell F10=Exit Enter=Do

Figure 2-8. Call Home / Remote Services Menu – Virtualization Engine Maintenance

Move cursor to desired item and press Enter.

Display Hardware Vital Product Data (lscfg)
Adapter Slot Identification
Set Date/Time Menus
Customer Network Configuration Menus
Show / Change TS7700 Vital Product Data
Customer Configurations Menus
Data Management Settings
Call Home / Remote Services Menus

F1=Help F2=Refresh F3=Cancel F8=Image
F9=Shell F10=Exit Enter=Do

Figure 2-9. Subsystem Configuration Menus

Call Home / Remote Services Menu

Move cursor to desired item and press Enter.

IBM TotalStorage Master Console TCP/IP Configuration
Change / Show Call Home / Remote Services
Change / Show Call Home Filters
Send Test Notification Menu
Remote Data Monitoring
View Call Home Log
Reset Call Home Daemon
Configure Network Port for Remote Connection

F1=Help F2=Refresh F3=Cancel F8=Image
F9=Shell F10=Exit Enter=Do

Figure 2-10. Call Home / Remote Services Menu – TCP/IP Configuration

Chapter 2. Installation 2-13



4. Select Enter the Service Console IP Address:.

5. At Figure 2-11, verify that the System Console IP address is set to the IP address (defaults to
172.31.1.1).

6. At Figure 2-11, verify that the TS7700 IP address is set to the IP address 172.31.1.x. The 'x' will be
replaced with the IP address that you designated for this subsystem.

Note: For the TS7700, the last octet of this IP address must be in an increment of 10 between 10
and 240 (that is. 10, 20 ... 230, 240). The router configuration will utilize this entire octet for
System Console configuration. All ten of these addresses must not be used by another
subsystem connected to the System Console.

7. Press F3 to return to Figure 2-10 on page 2-13. Select Change / Show Call Home / Remote Services.
Figure 2-12 displays.

Set Service Console (TSSC) Customer Network Configuration

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

[TOP] [Entry Fields]

NOTICE: TSSC IPs must be in IPv4 format
because the TSSC only supports IPv4 addresses.
TSSC IPs cannot be disabled.

* Enter the Service Console IP Address: [172.31.1.1]
NOTE: This is the IP Address for the TSSC
that will be attached to this TS7700. The
values displayed are either the default
values or the current IP that is configured.

* Enter the Service Console Hostname: [blimpie]

[MORE. . .14]

F1=Help F2=Refresh F3=Cancel F4=List
F5=Reset F6=Command F7=Edit F8=Image
F9=Shell F10=Exit Enter=Do

Figure 2-11. Set Service Console (TSSC) Customer Network Configuration Menu

Change / Show Call Home / Remote Services

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

[Entry Fields]
* Enable Serious and Acute SIMs to Call Home? yes
* LM Customer Initiated Call Home Allowed Frequency disabled
* Enable Paging? no
* Customer Business/Company Name" [IBM]
* Customer Location [TUCSON]

Remote Phone Number 1 (call home) : [18005551234]
Remote Phone Number 2 (call home) : []
Callback Phone Number [modem] []
Customer Phone Number [voice] []
Customer Offshift Phone Number []

F1=Help F2=Refresh F3=Cancel F4=List
F5=Reset F6=Command F7=Edit F8=Image
F9=Shell F10=Exit Enter=Do

Figure 2-12. Change / Show Call Home / Remote Services Menu
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8. At Figure 2-12 on page 2-14, verify that Serious and Acute SIMs to Call Home is enabled. If it is not
enabled, highlight the text, and press F4. Move the cursor to yes, and press Enter.

9. Press F3 to return to Figure 2-10 on page 2-13. Select Remote Data Monitoring. Figure 2-13
displays.

10. At Figure 2-13, verify that Call Home Data Gathering is enabled. If it is not enabled, highlight the text,
and press F4. Move the cursor to Enabled, and press Enter.

11. Press F3 to return to Figure 2-10 on page 2-13. If more attached subsystems need configuration exit
the EBTERM or NetTerm session and connect the net subsystem.

12. Return to Step 2 on page 2-13 and configure all attached systems before continuing to Step 13.

13. You have completed the TS7700 Virtualization Engine Configuration. Leave the screen active.
v Go to “Setting Up Autonomic Ownership Takeover Manager (AOTM)” if you want to set up the

autonomic takeover manager, then return here.

– – AND – –
v Go to “Tape System Call Home Setup for VTS, VTC, and Tape Controllers” on page 2-20.

– – OR – –
v “Tape System Setup for 3494 ATL (Library Manager) or 3953 Enterprise Library Controller” on page

2-23, if necessary.

Setting Up Autonomic Ownership Takeover Manager (AOTM)
The Autonomic Ownership Takeover Manager (AOTM) allows the System Console to create a temporary
communication path around a failing communication path in a multiple IBM TS7700 Virtualization Engine
configuration to determine the health of the remote system. This activity is performed independently of
human intervention. This activity is similar to actions taken by an operator who intervenes to reestablish
communications by taking over ownership of the complex (or grid), or multiple clusters. But AOTM is done
automatically by a TSSC, without a request being made by an operator.

See Figure 2-14 on page 2-16. A complex (or grid) can be defined as multiple clusters. The preferred
minimum configuration of a cluster contains one of each of the following:
v Two TS7700s
v Two TSSCs (one connected to each TS7700)
v Two grid switches (one supporting each TS7700 and TSSC pair)

Note: AOTM is also with one TSSC between two TS7700s, with the minimum configuration of the
following:
– Two TS7700s
– One TSSC (connected to each TS7700)

Notes:

Remote Data Monitoring

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

[Entry Fields]
* Change / Show Call Home Heartbeat Interval 3 days
* Error Initiated Call Home Data Gathering Enabled
* Timeout Period Between Successive Data Call Homes [24]

(In hours between 1 and 99)

F1=Help F2=Refresh F3=Cancel F4=List
F5=Reset F6=Command F7=Edit F8=Image
F9=Shell F10=Exit Enter=Do

Figure 2-13. Call Home – Remote Data Monitoring Menu
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– The Grid Network Interface should only be used for TS7700 peer-to-peer networks with the
AOTM function. Unless previously mentioned, other uses are not supported.

– No connection is made directly between any two TSSCs, but TSSCs are connected through
the grid switches.

1. You were directed here from “Console Settings” on page 2-58. On both clusters, configure the local
TSSC Grid IP address. From the TS7700 Virtualization Engine Maintenance menu, select TS7700
GRID Menus > TS7700 GRID Configuration Menus > Autonomic Ownership Takeover Manager
Menus > Set Local GRID TSSC IP. Press Enter. You see Figure 2-15.

2. In the Entry Fields field, type the TSSC Grid IP address to which the cluster's local TSSC is
configured (10.11.110.40, in this example). Press Enter.

3. Press F3 twice to return to the TS7700 Virtualization Engine Maintenance menu, and select
Configure Autonomic Ownership Takeover Manager to a Remote Cluster.

Note: The remainder of these steps apply to the failing cluster from which you want to take over
volumes.

4. Press Enter. Figure 2-16 on page 2-17 appears.

IBM
TS7700

IBM
TS7700

TSSC TSSC

Grid
Switch

a
1
4
o
r3

4
1

Grid
Switch

Site

A

Site

B

Figure 2-14. Autonomic Ownership Takeover Manager (AOTM) Layout. This is one example of how a customer might
have a complex with physically-separated clusters at multiple, separate sites, such as in multiple cities or in multiple
states.

Set Local GRID TSSC IP

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

[Entry fields]
Enter the Local GRID TSSC IP address: (10.11.110.40)

F1=Help F2=Refresh F3=Cancel
F8=Image F10=Exit Enter=Do
/=Find

Figure 2-15. Setting Local Grid TSSC IP Address

2-16 IBM TS3000 System Console Maintenance Information – 27th Edition August 2011



5. Move the cursor to the desired cluster, and press Enter. Figure 2-17 displays.

6. Add information in the appropriate fields, depicted in Figure 2-17:
Remote Cluster ID

Set to the ID that you chose in Figure 2-16. (0 in this example.) The default which appears in
this field (0 or 1) depends on the cluster from which you are initiating this configuration.

Enter the Autonomic Takeover Setting
Set to Enabled or Disabled. (enabled in this example.)

Enter the Takeover Mode
Set to Read only takeover (ROT) or Write-enabled ownership takeover (WOT). ROT allows
the local cluster to read (but not write to) volumes in the remote cluster. WOT allows the local
cluster to read from and write to any volumes that it takes over from the remote cluster.

Enter the minutes for the Grace Period
Set the number of minutes before the local cluster takes over the volumes of the remote
cluster.

Enter the minutes for the Retry Period
Set the number of minutes to wait before a retry of the takeover of the volumes occurs.

7. Press Enter. You see Figure 2-18 on page 2-18.

Select a remote cluster

Move cursor to desired item and press Enter.

# Select the Remote Cluster from the list below
#
# Remote Cluster
#- - - - - - - - - - - - - -
1 - V06

F1=Help F2=Refresh F3=Cancel
F8=Image F10=Exit Enter=Do
/=Find

Figure 2-16. Selecting a Remote Cluster. For this example, the cluster name is 'V06.'

Configure Autonomic Ownership-Takeover To a Remote Cluster

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

[Entry fields]
* Remote Cluster ID: 0
Enter the Autonomic Takeover Setting: [enabled]

*
Enter the Takeover Mode: WOT

*
Enter the minutes for the Grace Period: [25]
Enter the minutes for the Retry Period: [5]

F1=Help F2=Refresh F3=Cancel F4=List
F5=REset F6=Command F7=Edit F8=Image
F9=Shell F10=Exit Enter=Do
/=Find

Figure 2-17. Configuring AOTM To Remote Cluster
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8. Press Enter. You see Figure 2-19.

9. Press F3 until you are returned to the main menu for the TS7700 Virtualization Engine Service
Terminal.

Verify the TSSC Firewall settings:

10. Click the Custom Firewall Settings link at the top of the Console Settings page.

11. Verify the HTTP entry is properly set for the Grid interface. You should see the Grid entries configured
to allow HTTP connections, both in and out, as seen in the figure below. If either of them are set to
drop, change it to allow by selecting the option in the leftmost column.

Note: If the customer's network is configured to run AOTM over the same network as the TSSC's
External adapter, you will need to repeat this step for the External firewall entries.

12. Once the settings have been verified, click the Update Firewall Settings button.

13. You will see a message stating the firewall settings have been successfully configured.

14. Close the open window.

15. To test the AOTM, go to “Testing Autonomic Ownership Takeover Connectivity To A Remote Cluster”
on page 2-19.

ARE YOU SURE?

Continue may delete information you may want
to keep. This is your last chance to stop
before continuing.
Press Enter to continue.
Press Cancel to return to the application.

F1=Help F2=Refresh F3=Cancel
F8=Image F10=Exit Enter=Do
/=Find

Figure 2-18. Warning Message for Processing AOTM To a Remote Cluster

COMMAND STATUS

Command: �OK� stndout: yes stderr: no

Before command completion, additional instructions may appear below.

Autonomic takeover configured successfully

F1=Help F2=Refresh F3=Cancel F4=List
F5=Reset F6=Command F7=Edit F8=Image
F9=Shell F10=Exit Enter=Do

Figure 2-19. Processing AOTM To a Remote Cluster

ts
7

7
h

8
5
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Figure 2-20. TSSC Firewall Settings
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Testing Autonomic Ownership Takeover Connectivity To A Remote
Cluster
This information provides a procedure for testing autonomic ownership takeover connectivity to a remote
cluster.

The activity described in this section is a continuation of “Setting Up Autonomic Ownership Takeover
Manager (AOTM)” on page 2-15. Your cluster should have been set up to allow the Autonomic Ownership
Takeover Manager (AOTM) before you perform these steps.

1. From the TS7700 Virtualization Engine Maintenance, select TS7700 GRID Menus > TS7700 GRID
Configuration Menus > Autonomic Ownership Takeover Manager Menus > Test Autonomic
Ownership Takeover Manager to a Remote Cluster. Press Enter. You see Figure 2-21.

2. Move the cursor to the desired cluster (V06 in this example), and press Enter. Figure 2-22 displays.

3. Add information in the appropriate fields, depicted in Figure 2-22:
Remote Cluster ID

This is the same setting that you chose in Figure 2-16 on page 2-17 ('0' in this example).
Local Cluster IP

This field contains a default setting, which you cannot change.

4. Press Enter. You see Figure 2-23 on page 2-20.

Select a remote cluster

Move cursor to desired item and press Enter.

# Select the Remote Cluster from the list below
#
# Remote Cluster
#- - - - - - - - - - - - - -
0 - V06

F1=Help F2=Refresh F3=Cancel
F8=Image F10=Exit Enter=Do
/=Find

Figure 2-21. Initiating Remote AOTM Cluster Test. For this example, the cluster name is 'V06.'

Test Autonomic Ownership-Takeover To a Remote Cluster

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

[Entry fields]
* Remote Cluster ID: 0
Local Cluster IP: [ 1]

F1=Help F2=Refresh F3=Cancel F4=List
F5=Reset F6=Command F7=Edit F8=Image
F9=Shell F10=Exit Enter=Do

Figure 2-22. Testing AOTM Connectivity To Remote Cluster
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5. Press Enter to start the test, or press Cancel to return to application. If you press Enter, you see
Figure 2-24.

Notes: In the Figure 2-24 field "Based on the conditions above, will ownership takeover occur?"

False The local cluster is not taking control of the remote cluster's volume.

True The local cluster has ownership and is taking control of the remote cluster's volume.

AOTM testing is complete.

Tape System Call Home Setup for VTS, VTC, and Tape Controllers

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
Chapter 1, “Maintenance Starting Point,” on page 1-1 to determine the code level.

1. From EBTERM or NetTerm, perform the following:

a. Make the following selections from one of these screens:

v IBM Virtual Tape Server (B10/B20 VTS) Maintenance

v 3590 Subsystem Maintenance

v 3592 Subsystem Maintenance

b. Select Subsystem Configuration, and press Enter.

c. Select Call Home / Remote Services Menu, and press Enter. Figure 2-25 on page 2-21 displays.

ARE YOU SURE?

Continue may delete information you may want
to keep. This is your last chance to stop
before continuing.
Press Enter to continue.
Press Cancel to return to the application.

F1=Help F2=Refresh F3=Cancel
F8=Image F10=Exit Enter=Do
/=Find

Figure 2-23. Verifying AOTM Change

COMMAND STATUS

Command: OK stndout: yes stderr: no

Before command completion, additional instructions may appear below.

Local TSSC Connection: Successsful
Remote TSSC Connection: Successsful
Remote Node connection: Successsful
Remote node state: online

Based on the conditions above, will ownership takeover occur? false

F1=Help F2=Refresh F3=Cancel F6=Command
F8=Image F9=Shell F10=Exit /=Find
n=Find Next

Figure 2-24. Processing AOTM Changes
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Note: Ensure that the Console Configuration Sheet (Table 2-6 on page 2-9) was completed before you
perform the following steps.

2. At Figure 2-25, select Switch Call Home / Remote Services to/from System Console, and press
Enter. Figure 2-26 displays.

3. At Figure 2-26, verify that the IBM System Console IP Address is set to the IP address (defaults to
172.31.1.1). Press F4 for the pop up menu displayed in Figure 2-27 on page 2-22. Select Console
Call Home/Remote Services thru System Console, and press Enter twice.

Call Home / Remote Services Menu

Move cursor to desired item and press Enter.

Switch Call Home / Remote Services to/from
IBM System Console

IBM System Console TCP/IP Configuration
Change / Show Call Home / Remote Services
Change / Show Modem Configuration
Remove Files from Modem Send Queue
Pager Users Menu
Send Test Notification Menu
Remote Data Monitoring

F1=Help F2=Refresh F3=Cancel F8=Image
F9=Shell F10=Exit Enter=Do

Figure 2-25. Call Home / Remote Services Menu – Switch Call Home Selection

Switch Call Home / Remote Service to/from System Console

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

[Entry Fields]
* Switch Call Home/Remote Services to/from WTI +

System Console
IBM System Console TCPIP Address (dotted decimal): [172.31.1.1]
IBM System Console Hostname: []

F1=Help F2=Refresh F3=Cancel F4=List
F5=Reset F6=Command F7=Edit F8=Image
F9=Shell F10=Exit Enter=Do

Figure 2-26. Switch Call Home/Remote Services to/from System Console
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Attention:
v Step 4, Step 5 on page 2-23, and Step 6 on page 2-23 apply to tape systems without SMC router

WAN port connectivity.
v If your installation uses an SMC router for WAN port connectivity, do not use Steps 4, 5 on page

2-23, and 6 on page 2-23, but refer to the product's maintenance information for instructions to
configure the SMC router WAN and LAN IP addresses for connection to the System Console. You
must set the router configuration before proceeding. Continue at Step 7 on page 2-23 after
configuring the router WAN/LAN ports.

4. This Step only applies to 3590 A60: Select IBM System Console TCP/IP Configuration, and press
Enter. Select the presented Ethernet adapter. Figure 2-29 on page 2-23 appears.

Attention: Select the illustrated line item only at Figure 2-28. No other menu display items are
applicable for this process.

Switch Call Home / Remote Service to/from System Console

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

[Entry Fields]
* Switch Call Home/Remote Services to/from Console +

IBM System Console
IBM System Console TCPIP Address (dotted decimal): [172.31.1.1]
IBM System Console Hostname: []

lqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqk
x Switch Call Home/Remote Services to/from System Console x
x x
x Move cursor to desired item and press Enter. x
x x
x WTI Call Home/Remote Services thru WTI Switch Modem x
x Console Call Home/Remote Services thru System Console x
x x
x F1=Help F2=Refresh F3=Cancel x
x F8=Image F10=Exit Enter=Do x

F5 /=Find n=Find Next x
F9 lqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqk

Figure 2-27. Switch Call Home / Remote Services to/from System Console – IP Address

Call Home / Remote Services Menu

Move cursor to desired item and press Enter.

IBM System Console TCPIP Configuration
lqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqk

x Available Network Interfaces x
x x
x Move cursor to desired item and press Enter. x
x x
x en1 x
x x
x F1=Help F2=Refresh F3=Cancel x
x F8=Image F10=Exit Enter=Do x

F1 /=Find n=Find Next x
F9 lqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqk

Figure 2-28. Call Home / Remote Services Menu
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5. This Step only applies to 3590 A60: Use Figure 2-29 as a reference to help you add the following
information:

v A descriptive host name. This will be the name used to identify the tape system in the customer's
environment.

v An Internet ADDRESS of the form 172.31.1.x (see Table 2-6 on page 2-9 for the value 'x'). It is
important that no two internet addresses are set alike in the local Ethernet network. It is essential
that the internet addresses are assigned using the network 172.31.1.x, otherwise TCP/IP
communication with the console will not work.

v A Network Mask of 255.255.255.0. The Network Mask will be the same for each tape system.

v Change the START Now setting to yes.

Press Enter. Press F3 to return to Call Home / Remote Services Menu displayed at Figure 2-25 on
page 2-21.

6. Press F3 twice to return to Call Home / Remote Services Menu. If more attached subsystems need
configuration, exit the EBTERM/NetTerm session and connect to the next subsystem.

7. Return to Step 1 on page 2-20, and configure all attached tape systems before continuing to Step 8.

8. VTS, VTC, and tape controller configuration is complete at this point. Leave the screen active.
Continue to “Tape System Setup for 3494 ATL (Library Manager) or 3953 Enterprise Library Controller”
if necessary, then continue to “Configuration” on page 2-34 to perform System Console configuration.

Tape System Setup for 3494 ATL (Library Manager) or 3953 Enterprise
Library Controller

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
Chapter 1, “Maintenance Starting Point,” on page 1-1 to determine the code level.
System Console

For 3494, Version 3.0.0 and above

For 3953, Version 3.2.0 and above
IBM 3494 ATL Models L12, L14, L22

Code Version 529 and above (LM531 and above for 3953), using a 7581 PC. If you are using a
7588 PC, you must have Feature Code 2715 installed, which will provide a 4-port ethernet
adapter, if one is not installed.

Minimum Configuration & Startup

To Delete existing configuration data, please use Further Configuration menus

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

[Entry Fields]
* HOSTNAME [VTS13AAA00]
* Internet ADDRESS (dotted decimal) [172.31.1.2]

Network MASK (dotted decimal) [255.255.255.0]
* Network INTERFACE en1

NAMESERVER
Internet ADDRESS (dotted decimal) []
DOMAIN Name []

Default GATEWAY Address []
(dotted decimal or symbolic name)
Your CABLE Type N/A +
START Now yes +

F1=Help F2=Refresh F3=Cancel F4=List
F5=Reset F6=Command F7=Edit F8=Image
F9=Shell F10=Exit Enter=Do

Figure 2-29. Minimum Configuration and Startup Menu
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Notes:
v Either FC 5219 or FC 5220 must have been installed to enable the 3494 Specialist.
v The customer (usually an administrator) must authorize enabling the 3494 Specialist.

1. See Figure 2-30. Ensure that an ethernet connection has been completed between the 3494 ATL or
3953 SBC card port 1 (lower port) and a port on one of the System Console ethernet switches. The
ethernet cable should plug into the bottom port (Item 1 in Figure 2-30). The SBC card is in slot 3 of
the 7581.

2. Ensure that the TSSC Server is listed in the command process window. Use Ctrl + Esc to view the
window list. See Figure 2-31 on page 2-25.

1

a
1
4
o
r2

5
5

Figure 2-30. Plug Ethernet Cable Here (3494). Notice Item 1.
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Notes:
v If the TSSC Server is not included in the list depicted in Figure 2-31, you can start the

TSSC Server by typing tsmcstrt from a command line.
v You can stop the TSSC Server. Right click TSMC Server from the Figure 2-31, then click

on the Close button in the dialog box.
v You can restart the TSSC Server by stopping it, then starting it.
v If the "tsmcstrt" fails to start the "TSSC Server" window, the OS/2 device drivers may not

be installed on the 3494 ATL or the 3953. Shutdown the 3494 ATL or the 3953, and open a
service window. Run "tsmcinst". This loads the necessary OS/2 device drivers. Once
loaded, the 3494 ATL or the 3953 must be rebooted.

3. Use the 3494 ATL or 3953 menu commands Service --> Manage MasterConsole to view the dialog
box for setting any 3494 ATL or 3953 IP address or addresses. See Figure 2-32 on page 2-26.

Configure the IP address of the 3494 ATL or 3953 for the System Console network. The default
addressing scheme uses the subnet 172.31.1.x. The specific address must not be in use elsewhere
on the System Console network.

Note: You must configure the library manager before you configure the System Console.

a
1
4
o
r2

3
0

Figure 2-31. Command Process Window List – Example. The text on your screen may differ with various levels of
code or with different machine model numbers.
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4. Change the default IP addresses in the entry box to be IP addresses that are unique to the System
Console network. Click Change. After the address is successfully set, Configuration Successful is
indicated in the Configuration column. Click Exit when complete.

5. Ensure that Call Home is enabled on the 3494 ATL or 3953. Use the 3494 ATL or 3953 Menu
Commands Utilities --> Enable/Disable Functions --> LM Call Home --> Enable to enable Call
Home on the LM.

6. In order to use the System Console "Telnet to Attached Systems" tool to access the 3494 ATL or
3953, you must enable Service Access. Use the 3494 ATL or 3953 menu commands Commands -->
Service Access –>Enable Service Access. This will enable both the telnet services and the ftp
services for the 3494 ATL or the 3953. "Service" is enabled if it appears unhighlighted (grayed-out) on
the menu.

Notes:
v Either FC 5219 or FC 5220 must have been installed to enable the 3494 Specialist.

Though these feature codes are 3494-only, they are included in the 3953 F05 base frame.
v The customer administrator must authorize enabling Service Access.
v The System Console tool "Telnet to Attached Systems" will be unable to connect with this

3494 ATL or 3953 if Service Access is disabled.
v System Console FTP access to this 3494 ATL or 3953 will be unable to connect, if Service

Access is disabled.
v If the System Console tool “Telnet to Attached Systems” is unable to connect to a

subsystem, the telnet terminal screen disappears without presenting a login prompt. No
error message will be displayed.

v The customer administrator must authorize enabling the 3494 Specialist.

7. In order to view the 3494 or 3953 Specialist from the System Console, you must enable the
3494/3953 Specialist. Use the 3494 ATL or 3953 Menu Commands: > Utilities > Enable/Disable
Functions > 3494 Specialist > Activate. You may be asked for a User ID and Password. The
default User ID is 'service' and the default password is 'service".

8. After the 3494 or 3953 Specialist is enabled, wait for the hour glass icon on your screen to disappear,
then select Commands --> Specialist (Web Server) --> Settings... from the 3494 ATL or 3953
menu.

9. Either click All Yes or select Yes for each function you want to manage by using the 3494 or 3953
Specialist. Ensure that 'Manage TSSC' is set to 'Yes' to manage the System Console configuration via

a
8
3
0
0
0
8
0

Figure 2-32. Manage System Console Dialog Box. The Library Manager Frame Serial Number must be the 3953 F05
base frame number or the 3494 LXX frame serial number. The text on your screen may differ with various levels of
code or with different machine model numbers.
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the 3494 or 3953 Specialist. Figure 2-33 appears. Ask the customer administrator for any settings that
need to be changed on this screen from Yes to No, and check the No box for those settings.

10. Click Submit Access Change to change the Web Browser Access attributes. Wait for the message
“Web browser access was successfully changed.”

Notes:
v The customer administrator must authorize enabling the 3494 or the 3953 Specialist.
v No browser will be able to display the 3494 or 3953 Specialist, if the Specialist is not

activated.

11. Return to the beginning of this procedure, and perform Steps 1 on page 2-24 through 6 on page 2-26
for each 3494 ATL that you will attach to the System Console.

This completes the configuration of the 3494 ATL or 3953 for the System Console attachment. Continue at
“Test Call Home Notification for 3494 ATL or 3953 Enterprise Library Controller” on page 2-81, or go to
“Configuration” on page 2-34 if you do not intend to test the call home notification.

Using 3494 ATL or 3953 Enterprise Library Controller Web Specialist to
Change System Console Settings

This section provides supplemental information. You do not need this information to complete the setup for
a 3494 ATL or 3953. You can, however, use the 3494 ATL or 3953 (Web) Specialist to change certain
System Console settings on the 3494 ATL or 3953. You can access and enable the 3494 or 3953 Web
Specialist by using a browser on the customer's network (common approach).
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Figure 2-33. 3494 ATL or 3953 Specialist Settings. The text on your screen may differ with various levels of code or
with different machine model numbers.
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After you access the 3494 ATL or 3953 Web Specialist, you will see the Figure 2-34. A number of work
items are listed on the left side of the screen.

1. Select Service library manager, then select Administer call home. This menu contains the tasks
that are relevant for the System Console and call home. You may want to perform some or all of these
actions. From this menu you can select (in any order):
Test interface

Test network interface to System Console or send a test call home record (see “Test Interface”)
Configure settings

Enable or disable problem call home or data call home activity (see “Configure Settings” on
page 2-29)

Flush queue
Clears 3494 ATL or 3953 call home entries from the System Console call home queue (see
“Flush Queue” on page 2-30)

Set heartbeat
Set the time interval of the heartbeat call home action (see “Set Heartbeat” on page 2-30)

Configure interface parameters
Configure IP addresses for the LM and the System Console. Set the hostname alias of the LM
on the System Console network (see “Configure Interface Parameters” on page 2-31)

2. Wait for the message “The Action Completed Successfully” which indicates that the test of the interface
or the test call home was successful.

Test Interface
1. From the "Administer call home" list on the Web Specialist screen (Figure 2-34), click Test interface to

see the options shown in Figure 2-35 on page 2-29. If you are prompted for a username and
password, use the default values of service for the username and service for the password. These
values can be changed by the 3494 ATL system administrator.

From this screen (Figure 2-35 on page 2-29), you can test the (network) interface between the LM and
the System Console (from the perspective of the LM).

Test Interface
Tests the (network) interface between the LM and the System Console (from the perspective of
the LM)

Test Call Home
Causes a test call-home record to be sent from the LM via the System Console
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Figure 2-34. 3494 ATL or 3953 Web Specialist - Welcome Page
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2. Wait for the message "The Action Completed Successfully," which indicates that the interface test was
successful.

Configure Settings
1. From the “Administer call home” list on the Web Specialist screen (Figure 2-34 on page 2-28), click

Configure settings to see Figure 2-36. If you are prompted for a userid and password, use the default
values of service for the userid and service for the password. These values can be changed by the
3494 ATL system administrator.

2. Call home communication is a default action that you must choose to disable. To disable call home,
click Send diagnostic data with Call Home, select the Disabled button, click Save Call Home
Settings.

3. Wait for the message “The Action Completed Successfully,” which indicates that the call home settings
were saved.
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Figure 2-35. 3494 ATL Web Specialist - Test Interface
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Figure 2-36. 3494 ATL Web Specialist - Configure Settings
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Flush Queue

Note: This function requires that the 3494 ATL be successfully attached to the System Console. See
“Adding Attached System Information” on page 2-37.

1. From the “Administer call home” list on the Web Specialist screen (Figure 2-34 on page 2-28), click
Flush queue to see Figure 2-37. If you are prompted for a userid and password, use the default
values of service for the userid and service for the password. These values can be changed by the
3494 ATL system administrator.

2. Click Flush Queue to delete (flush) all the call home records on the System Console that are
associated with this 3494 ATL. All other call home records in the System Console's call home queue
will remain in the queue.

3. Wait for the message “The Action Completed Successfully,” which indicates that the System Console
queue settings were deleted.

Set Heartbeat

The Heartbeat Interval Setting is the elapsed time between sending heartbeat call home records.

A heartbeat call home record is verification that the 3494 ATL is operating properly. A heartbeat call home
record which does not arrive at its expected interval indicates a problem.

1. From the “Administer call home” list on the Web Specialist screen (Figure 2-34 on page 2-28), click
Set Heartbeat to see Figure 2-38 on page 2-31. If you are prompted for a userid and password, use
the default values of service for the userid and service for the password. These values can be
changed by the 3494 ATL system administrator.
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Figure 2-37. 3494 ATL Web Specialist - Flush Queue
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2. From the drop-down box, select the number of the Heartbeat Interval Setting days between 1 and 28
days, then click Set Heartbeat. Set the Heartbeat Interval Setting to 0 to disable heartbeat call home
activity.

3. Wait for the message “The Action Completed Successfully,” which indicates that the new heartbeat
interval was set.

Configure Interface Parameters

You can use this option to set the IP address and hostname alias of the 3494 ATL on the System Console
network. This option informs the 3494 ATL of the IP Address of the System Console. You also can use this
option to set the IP addresses and hostname aliases for both 3494 accessors when the 3494 ATL is part
of a high availability (HA) dual accessor complex.

This task most commonly will be used to reset the hostname alias for the 3494 ATL on the System
Console network for system identification.

1. From the “Administer call home” list on the Web Specialist screen (Figure 2-34 on page 2-28), click
Configure Interface Parameters to see Figure 2-39 on page 2-32. If you are prompted for a userid
and password, use the default values of service for the userid and service for the password. These
values can be changed by the 3494 ATL system administrator.
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Figure 2-38. 3494 ATL Web Specialist - Set Heartbeat
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2. Enter the appropriate values for the IP Addresses and hostnames, then click Save Network Settings
to update the network information.

3. Wait for the message “The Action Completed Successfully,” which indicates that the new heartbeat
interval was set.

Note: Avoid changing the System Console's IP address from the default value of 172.31.1.1. If you must
change the System Console's IP address, change it first on the System Console. Then change to
the new IP address setting on each tape system on the System Console network.

Tape System Call Home Setup for 3584 Tape Library

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
Chapter 1, “Maintenance Starting Point,” on page 1-1 to determine the code level.

Using CETool to Configure for Call Home. Follow this procedure to configure the library for Call Home via
Master Console (FC 9217).

Notes:
v CETool is a tool that is run externally from a workstation which is directly connected to a 3584

library. CETool is not run from the System Console.
v Use CETool version 3.10 or later for this procedure.
v For more information about using CETool, refer to the 3584 MI.

1. Start the CETool program.

2. Double click the CETool icon on your desktop.

3. When the CETool screen displays, click Configure Remote Service. You see Figure 2-40 on page
2-33.
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Figure 2-39. 3494 ATL Web Specialist - Configure Interface Parameters
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4. At the Remote Serviceability Configuration screen, ensure that the Disable Call Home checkbox is
not checked.

5. Ensure that the Disable Heart Beat /MRPD/Data Call Home checkbox is not checked.

6. Ensure that the Threshold Timeout field is set to 1440 minutes.

7. Enter the customer phone number in the Contact Phone # field.

8. Enter the customer offshift phone number in the Offshift Phone # field.

9. In the Master Console Options area, set the following fields:

a. Select Enable Master Console.

b. Set the Master Console IP Address field to 172.31.1.1. This is the default IP address for the
System Console.

c. Set the Master Console Subnet Mask field to 255.255.255.0.

d. Set the Master Console Host Name field to the host name of the System Console.

e. Determine the 3584 frame number for the model Dxx frame containing the ethernet-capable MCP
or MCA that will be used for the connection to the System Console. Type that number in the
Library Frame (decimal) field.

Notes:

v The Lxx frame is always frame 1, even if an HA1 frame (Service Bay A) is attached.

v Typically the two-character display on the MCP or the MCA will be flashing 00 and the
frame number.

f. Set the Library IP Address to 172.31.1.170. This is the default IP address for a 3584 library that is
attached to a System Console. If you have more than one 3584 library attached to a single
System Console, increment the last number for each additional library. As an example, the first
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Figure 2-40. Remote Serviceability via System Console

Chapter 2. Installation 2-33



library would have an IP address of 172.31.1.170, the second library would have an IP address of
172.31.1.171, the third library would have an IP address of 172.31.1.172, and so forth.

10. Select Submit.

11. Click Configure Remote Service again, and review the configuration data that you entered above.
Verify that all the data you entered is correct. Exit the CETool program. The 3584 library should now
be configured to call home via the System Console.

12. To verify that the 3584 library is configured to call home via the System Console, initiate a test call
home. At the 3584 operator panel, click Menu, and select Service —> Tests/Tools -–> Diagnostics
–> Call Home.

Configuration

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
Chapter 1, “Maintenance Starting Point,” on page 1-1 to determine the code level.

Prior to beginning System Console configuration, you must accommodate the following items:

v Attached subsystems should be configured for System Console operation. All physical cabling
connections should be complete. Subsystem IP addresses should be known, available, and documented
on a Console Configuration Sheet (see Table 2-6 on page 2-9).

v Have available the telephone number of the analog lines attached to the System Console modems, as
well as tone/pulse and dial out prefix information, and 7-digit, 10-digit, or other local dialing conventions.

v Complete the Console Configuration Sheet (see Table 2-6 on page 2-9).

User Login

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
Chapter 1, “Maintenance Starting Point,” on page 1-1 to determine the code level.

The System Console is ready for user login when you see the Console Login Screen, represented in
Figure 2-41 on page 2-35 (microcode level may vary). There are two login options.
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Login Options

There are two ways to login to the System Console:

v Non-Authenticated

v Authenticated

Non-Authenticated:

For a non-authenticated login, in the Login field (depicted in Figure 2-41) type service. Press the Tab key
to move your cursor to the Password field and enter the case sensitive password service. This type of
login will provide access to all console configuration and service tools. This username and this password
are not valid for subsequent logins to any attached system. Non-authenticated logins are not available for
remote access (see “Remote Access Using NetTerm” on page 3-19).

Authenticated:

Note: If not already done, contact IBM Support for access to the IBM Authentication Server and to be
placed on the distribution list for the System Console authentication user passwords.

Follow these steps to login to the System Console. IBM Support will provide your level of authorized
access and your personal authentication ID for accessing System Consoles and tape systems.

1. At the Console Login screen (Figure 2-41), in the username field enter Service (case sensitive). Press
the Tab key to move your cursor to the Password field, and enter ibm2serv (case sensitive).

2. At the prompt “Please enter your Authentication Id:,” enter your personal authentication ID that was
provided by IBM Support. Figure 2-42 on page 2-36 depicts a typical authentication session:
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Figure 2-41. Console Login Screen – Example. The Version number (Vx.x.x) will reflect your level of microcode.
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3. After successfully creating a user ID and password, the system attempts to copy them to all tape
systems attached to the console (making it possible to login to each device with the same user id
and password). It is possible that the attempt to copy the user id/password will not be successful.
This process will always fail on VTS/VTC systems with code levels below 2.26, and for all attached
3494 ATLs.

Note: When the process of copying your userid/password to attached tape system is not successful,
you will need to either authenticate separately for these systems (VTS code level 2.26 or above,
A60 code level 1.16 or above, any 3592 J70, A60, or C06), or login using previous access
methods (VTS code level 2.25 and below, all 3494 ATL).

The following is a list of possible responses to the process of attempting to copy user id/password to
attached tape systems. Responses other than “Ok” are not successful responses.

v Ok

v Process timed out

v System subroutine failure

v Could not create socket

v Could not establish connection

v Could not send data

v Invalid /etc/hosts file

v Invalid request

v Could not validate client

v Could not send data file

v Could not receive data file

v Could not execute remote command

Notes:

v Make a note of your password! If you lose your password, you will need to authenticate
again. Also, you will be able to use your password to log into attached subsystems (if
broadcast was successful).

v Verify the results that appear following "Waiting for completion..." This indicates the success
of copying your password to systems that are attached to the console.

v Your userid and password will be valid for the time indicated on the console, and all
systems that indicate “Ok” after “Waiting for completion...”

Group: Service (<- Your level of authorized access)
Creating user jdoe (<- Your Authentication ID)
Account expires on: 07/02/02
6792-22U-:78-KA5XBA1:1:4:1920:jdoe
Changing password for user jdoe
New password:
Retype new password:
passwd: all authentication tokens updated successfully
Initiating broadcast to... vts1
Initiating broadcast to... vts2
Initiating broadcast to... vts3
Initiating broadcast to... vts4
Waiting for completion...
vts1: Ok
vts2: Ok
vts3: Could not execute remote command
vts4: Ok

Please logout and log back in with jdoe and password abc1zyxw(<- New Password)

Press [c] to continue.

Figure 2-42. Authentication Menu – Sample
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v The “Waiting for completion...” process should take no longer than five minutes before
timing out. During the "Waiting for completion" process, you may skip the results of the
broadcast by simultaneously pressing CTRL + C. If you press CTRL + C, you will NOT be
notified of a failed username broadcast.

4. Enter c to continue. You will be returned to the Console Login Screen.

5. Login to the console using the ID and password posted on the screen. The System Console Main
Menu shown in Figure 2-43 appears.

Adding Attached System Information

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
Chapter 1, “Maintenance Starting Point,” on page 1-1 to determine the code level.

1. Right click from anywhere in the Desktop to view the Main Menu shown in Figure 2-43.

2. From the Main Menu, select System Console Actions —> Console Configuration Utility. You see
the Username and password screen shown in Figure 2-44 on page 2-38.
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Figure 2-43. System Console Main Menu. Notice that the System Console Main Menu appears after you right click
inside the Desktop Area.
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3. Type service in the Username box, type service in the Password box, then click OK to start the
Console Configuration application. You see the Console Configuration Utility screen shown in
Figure 2-45.

4. Click Attached Systems. You see the screen shown in Figure 2-46 on page 2-39.

5. To add a new system, enter the system IP Address in the input fields next to Add System, and click
Add System. A warning dialog box appears, informing you that it may take several minutes. Click OK.

You may select numerous systems by using the check boxes to the left of the attached systems.
v Use the Delete Selected, Edit Selected, and Query Selected buttons to work with the list of systems.
v Use the Query All button to query all currently-attached systems.

If the application can establish contact with the attached system, the Device-Model, Serial Number,
Host Name, and Subnet Mask fields will be filled-in automatically. Otherwise, these fields will be filled
in with "NA."
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Figure 2-44. Login Username and Password Screen
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Figure 2-45. Console Configuration Utility Screen
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6. You can set the System Console to periodically check for responses from attached systems (see Step
11 on page 2-66).

Call home records will not be sent for systems that are marked as Standby (such as 3584L23, Serial
Number 78A3457 in the example),

To set a system as Standby or to change a Standby setting, select the appropriate system by using the
check boxes to the left of the attached systems. The numeral '1' in the Standby column indicates that
system is in standby mode. A '0' in the Standby column indicates that this system is not in standby
mode.

After you have selected the appropriate systems, you may toggle between the two settings by
repeatedly pressing the button that is labeled Toggle Standby.

7. When querying a large number of systems at one time, it can take from several minutes to as long as
an hour for the attached system data to be retrieved. If you have a 3958-AP1 or 3958-DE2
configuration, continue at step 4 in “Adding a Complex System.” If all systems have been added, click
Close this window to close the screen.

Adding a Complex System

Use this task to add a complex system if you have a 3958-AP1 or 3958-DE2 configuration.

1. Right click anywhere in the Desktop to view the Main Menu as shown in Figure 2-41 on page 2-35

2. From the Main Menu, select System Console Actions –�Console Configuration Utility. You will
see the Username and password screen as shown in Figure 2-44 on page 2-38

3. Type service in the Username field; type service in the Password field, then click OK to start the
Console Configuration application. You will see the Console Configuration Utility screen as shown in
Figure 2-45 on page 2-38

4. Click Attached Systems. You will see the screen shown in Figure 2-46

5. Click the Complex View link in the upper right hand corner.

6. Select the type of Complex System you are adding from the drop down list:
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Figure 2-46. Add System Screen
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7. Enter the serial number and host name of the complex system.

8. Enter the frame IP range for the complex system. NOTE: If the systems you are creating the complex
for are 172.31.1.100 and 172.31.1.105, then enter 100 for the frame IP range. The TSSC will find the
correct systems for creating the complex with, and add them to the complex. If the 3958-AP1
complex is a single 3958-AP1 cluster, it will only add the one system to the complex.

9. Click the Add Complex button, when the system is added correctly. You will see a message
confirming the complex system was added successfully; the screen will return with the new system
shown on the right:

10. To delete a complex system click the Delete Complex link below the Complex Type.

11. When all systems have been added, click Close this window to close the screen.
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Figure 2-47. Complex System Screen.
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Figure 2-48. Add New Complex System Screen - 1.
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Figure 2-49. Add New Complex System Screen - 2.
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Adding a 3584 Model SC1 Complex System

Use the following procedures to add a 3584 model SC1 shuttle complex system.

1. Right click anywhere in the Desktop to view the Main Menu as shown in Figure 2-41 on page 2-35

2. From the Main Menu, select System Console Actions –�Console Configuration Utility. You will
see the Username and password screen as shown in Figure 2-44 on page 2-38

3. Type service in the Username field; type service in the Password field, then click OK to start the
Console Configuration application. You will see the Console Configuration Utility screen as shown in
Figure 2-45 on page 2-38

4. Click Attached Systems. You will see the screen shown in Figure 2-46 on page 2-39

5. Click the Complex View link in the upper right hand corner.

6. Under -Select Complex Type- select 3584 Complex from the drop down list:

7. Enter a 3584 Complex Name and click Add Complex.
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Figure 2-50. 3584 Complex Screen.
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Figure 2-51. Add Complex Screen.
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The following screen will be displayed showing the complex just added:

8. Click Add Library.
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Figure 2-52. 3584 Complex Added.
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Figure 2-53. Add Library.
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9. Under "Add Library to 3584 Complex" click on the Select 3584 dropdown box and select the first
library in the shuttle span. Click Apply.

10. The following screen shows the added library.
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Figure 2-54. Add Library to 3584 Complex.
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Figure 2-55. Add Library.
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11. Select Add Library to add the next 3584 library in the shuttle span. The screen now shows TWO
libraries. Note: To delete a library: Select a box under "3584 Libraries in Complex" and click Delete
Selected ).

12. Click on the serial number of each library in the "3584 Libraries in Complex" column to bring up the
Web Specialist for each library. Click Library -� Shuttle Stations. Verify the shuttle stations are
assigned to the correct logical library for each library.

13. See the following screen. In the "Station Commands" box, use the Execute Command dropdown box
to select Discover Connections.

Note: The Discover Connections command is a process where the shuttle car will move and discover
all the stations in a shuttle connection. It will then send the data gathered to all other libraries
in the shuttle span.
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Figure 2-56. Add Second Library in Shuttle Span.
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Figure 2-57. Discover Connections.
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14. In the "Station Commands" box, under the Select System dropdown box, select the IP address of
the library where the shuttle car is currently located.

15. See the following two screens. Under Select Station dropdown box, select the station number. In the
example below the station is located in frame 3. Service Bays are NOT included in the frame count.

16. Click Execute and OK.
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Figure 2-58. Select System Where Car Located.
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Figure 2-59. Select Station.
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Figure 2-60. Execute Select Station.
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17. See the following screen. In the "Station Commands" box, use the Execute Command dropdown box
to select Distribute Connections.

Note: The Distribute Connections command is a process where the shuttle car sends the data from
the Discover process to each library in the shuttle span.

18. In the "Station Commands" box, under the Select System dropdown box, select the IP address of
the library where the shuttle car is currently located.

19. See the following screens. Under Select Station dropdown box, select the station number. In the
example below the station is located in frame 3. Service Bays are NOT included in the frame count.

20. Click Execute and OK.
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Figure 2-61. Distribute Connections - Select Next Library in Shuttle String.
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Figure 2-62. Select Station.
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21. Repeat steps 13 on page 2-44 through 20 on page 2-46 for each shuttle span.

22. Ask the customer to run a host discovery command (SCS). The shuttle map is now created.

23. See the following screens. Go to the Web User Interface of each library in the span. Click on Shuttle
View X where 'X' is the selected library, and verify the configuration is correct.
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Figure 2-63. Select Station - Execute.
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Figure 2-64. Web UI Shuttle View.
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24. If the configuration and connections are good, this verifies the host discovery was successful.

25. Under Connections, use the Execute Command dropdown box to select Connection Verify which
will retrieve and move a diagnostic cartridge to each station in the connection. Do this for each span
in the complex. Connection Verify commands can be run concurrently.
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Figure 2-65. Web UI Shuttle View.
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Figure 2-66. Connection Verify.
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26. Under Connections, use the Execute Command dropdown box to select View/Set Connection
Serial. Type in the serial number of the connection on the label located on the base station (where
the agency label is located) and click Update.

27. Do the above step for each connection in the complex.

28. When completed, click Close this window to close the screen.

29. After successful completion, turn the system over to the customer.

30. Go back to the Shuttle Feature Code install instructions to complete the installation.
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Figure 2-67. View/Set Connection Serial.
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Figure 2-68. Connection Serial Number.
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Installing DS6000 Graphical User Interface (GUI)

Use this procedure to install the DS6000 graphic user interface (GUI). Only perform this procedure if you
are attaching a TS7740 (3957) with a 3956 CC6 to the System Console.

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
Chapter 1, “Maintenance Starting Point,” on page 1-1 to determine the code level.

1. Right click from anywhere in the Desktop to view the Main Menu shown in Figure 2-43 on page 2-37.

2. From the Main Menu, select Browser Functions > DS6000 GUI Functions > Install GUI. A Terminal
window appears, and prompts you to insert the DS6000 Graphical User Interface CD-ROM.

3. Insert the CD-ROM, and press Enter. Installation of the GUI begins. This can take as long as thirty
minutes to complete.

4. The message "SUCCESS" displays when the installation is complete. Remove the CD-ROM from the
System Console.
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Figure 2-69. Install DS6000 GUI
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Installing Storage Manager (SM) Graphical User Interface (GUI)

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
Chapter 1, “Maintenance Starting Point,” on page 1-1 to determine the code level. Please be sure to follow
the installation screens exactly, as you must make sure to not install the Support Monitor in code level
10.50 or greater.

1. Right click from anywhere in the Desktop to view the Main Menu shown in Figure 2-43 on page 2-37.

2. From the Main Menu, select Browser Functions > Storage Manager GUI Functions > Install GUI. A
Terminal window that is similar to Figure 2-69 on page 2-50 appears and prompts you to insert the
appropriate Storage Manager Graphical User Interface CD-ROM.

3. Insert the CD-ROM, and press Enter. Installation of the GUI begins. This can take as long as thirty
minutes to complete.

Use this procedure to install the Storage Manager graphic user interface (GUI). Only perform this
procedure if you are attaching a 3957–V06/V07 (with a DS4000 cache), 3957–VEA/VEB, 3958–DD1,
3958–DD3, 3958-DD4, or a 3958–AP1 to the System Console.

If you have a previously installed Storage Manager GUI, you will be presented the current levels of
code installed as well as the level you are currently installing. If you are installing the 10.50 level or
greater of Storage Manager GUI, the Versions to be installed: section will be blank. Press y to
continue with the install.

4. Note: If you are installing the 10.50 or greater GUI, continue through the following screen shots. If you
are installing the 10.36 GUI continue at step 5 on page 2-54

Table 2-7. Code Level 10.50 or Greater Installation Screens
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Figure 2-70. Welcome Screen
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Figure 2-71. Introduction Screen
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Table 2-7. Code Level 10.50 or Greater Installation Screens (continued)
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Figure 2-72. Copyright Statement
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Figure 2-73. License Agreement
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Figure 2-74. Overwrite Warning
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Figure 2-75. Select Custom Installation Type
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Table 2-7. Code Level 10.50 or Greater Installation Screens (continued)
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Figure 2-76. Make sure the checkbox next to the Support Monitor entry is NOT selected. All other entries should
remain checked.
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Figure 2-77. Pre-Installation Summary
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Figure 2-78. Installing the GUI
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Table 2-7. Code Level 10.50 or Greater Installation Screens (continued)
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Figure 2-79. Install Complete

5. The message "SUCCESS" displays when the installation is complete. Remove the CD-ROM from the
System Console.

Installing ProtecTIER Manager Graphical User Interface (GUI)

Use this information to install the ProtecTIER Manager graphic user interface (GUI). Use this information
only if you are installing a 3958 system to the System Console.

To read about launching the GUI, see “Launching ProtecTIER Manager Graphical User Interface (GUI)” on
page 3-73.

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
Chapter 1, “Maintenance Starting Point,” on page 1-1 to determine the code level.

1. Right click from anywhere in the Desktop to view the Main Menu shown in Figure 2-43 on page 2-37.

2. Select Browser Functions > ProtecTIER Functions > Install GUI. You are prompted to insert the CD
into the TSSC CD drive. Press Enter. Installation of the GUI begins.

3. You see the Introduction screen in Figure 2-80 on page 2-55. Click Next.
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4. Read and accept the terms which are depicted on the License screen (not shown). Select I accept
both the IBM and the non-IBM terms, and click Next.

5. You see Figure 2-81. This screen shows you where the ProtecTIER GUI Manager software will be
installed.

6. Click Install to continue. You see an Installing ProtecTIER Manager screen (not shown).

7. When the installation successfully completes, you see an Install Complete screen (not shown). Click
Done.
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Figure 2-80. Introduction to ProtecTIER GUI Manager InstallAnywhere Screen
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Figure 2-81. Pre-Installation Summary Screen
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Upgrading ProtecTIER Manager Graphical User Interface (GUI)

Use this information to upgrade the ProtecTIER Manager Graphical User Interface (GUI). Use this
information only if you are installing a 3958 machine to the System Console.

To read about launching the GUI, see “Launching ProtecTIER Manager Graphical User Interface (GUI)” on
page 3-73.

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
Chapter 1, “Maintenance Starting Point,” on page 1-1 to determine the code level.

1. Right click from anywhere in the Desktop to view the Main Menu shown in Figure 2-43 on page 2-37.

2. Select Browser Functions -� ProtecTIER Functions -�Upgrade GUI.

3. You will be informed that the existing version of ProtecTIER Manager will be uninstalled before
updating. Continue by typing y and press Enter.

4. The uninstall program will launch and you will see the Uninstall ProtecTIER Manager window shown
in Figure 2-82. Click Uninstall.

5. A message will be displayed stating that all items were successfully uninstalled. Press Done to close
this window.

6. Next you are prompted to insert the ProtecTIER Manager Graphical User Interface disk. Insert the CD
and press Enter.

7. You will see the Figure 2-83 on page 2-57. Click Next.
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Figure 2-82. Uninstall ProtecTIER Manager Window
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8. Read and accept the terms which are depicted on the License screen (not shown). Select I accept
both the IBM and the non-IBM terms, and click Next.

9. You will see the Figure 2-84. This screen shows you where the ProtecTIER GUI Manager software
will be installed.

10. Click Install to continue. You see an Installing ProtecTIER Manager screen (not shown).
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Figure 2-83. Introduction Screen
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Figure 2-84. Pre-Installation Summary Screen
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11. When the installation successfully completes, you see an Install Complete screen (not shown). Click
Done.

Console Settings

The System Console comes pre-configured with the default IP address 172.31.1.1, subnet mask
255.255.0.0, and hostname 'tssnet1,' on the Internal Network Interface (see Figure 2-85). This interface is
used to communicate with the tape subsystems, as seen in Figure 2-1 on page 2-2. Normally, you will not
need to change these settings, since the System Console operates on a dedicated network.

The System Console External and Grid Network Interfaces do not come pre-configured. You must use the
Console Settings dialog box to set up these interfaces, if you are to use Intranet (high-speed) call home
method or Autonomic Ownership Takeover Manager function.

1. Right click from anywhere in the Desktop to view the Main Menu, shown in Figure 2-43 on page 2-37.

2. From the Main Menu, select System Console Actions -–> Console Configuration Utility. The Login
screen displays, as shown in Figure 2-44 on page 2-38.

3. Type service in the Username field, type service in the Password field, then single click OK to start
the Console Configuration application. You see the Console Configuration Application screen shown in
Figure 2-45 on page 2-38.

Note: To login remotely from another System Console, you must obtain an Authentication ID (see
“Login Options” on page 2-35). Launch your browser, and enter the System Console location
into the Address field. Enter your Authentication ID into the Username field and your password
into the Password field. Click OK to start the Console Configuration utility.

4. Click Console Settings. You see Figure 2-85.
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Figure 2-85. Console Settings
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5. You can change the entries by typing new values in the indicated fields. If you need to change the
hostname or the internal IP address of the System Console, you also will need to change this
information on each tape system attached to the System Console. See “Tape System Call Home Setup
for VTS, VTC, and Tape Controllers” on page 2-20 or “Using 3494 ATL or 3953 Enterprise Library
Controller Web Specialist to Change System Console Settings” on page 2-27 to perform these
additional tasks.

Note: See “Feature Codes” on page 2-2 to locate external ports for Grid and External Network
Interfaces.

v All network interface entries display their status as either Connected or Disconnected.
These designations signify whether or not the TSSC sees a working connection at each
interface, and they can be used to help troubleshoot connectivity problems.

6. Contact your network administrator to obtain an unused Grid IP address if you plan to set up
Autonomic Ownership Takeover Manager (AOTM) for the IBM TS7700 Virtualization Engine. To set up
AOTM, connect your Grid network to the Grid Network Interface that is located in the back of your
server. See Figure 2-3 on page 2-5, Figure 2-5 on page 2-6, and Figure 2-7 on page 2-7 for locations.

Use “Setting Up Autonomic Ownership Takeover Manager (AOTM)” on page 2-15 to enter the
connection settings. Return here after setting up and testing AOTM.

Note: The Grid Network Interface should only be used for TS7700 peer-to-peer networks with the
AOTM function. Unless previously mentioned, other uses are not supported.

7. Contact your network administrator to obtain an internet connection, if you have selected the IBM
Intranet or Autoselect call home methods. To set up the broadband interface, connect the internet
connection to the External Ethernet Interface that is located in the back of your server. See Figure 2-3
on page 2-5, Figure 2-5 on page 2-6, or Figure 2-7 on page 2-7 for location. Enter the information for
this interface into the External Network Interface input area depicted in Figure 2-85 on page 2-58.

Notes:

v The External Network Interface should only be used for call home purposes. Unless
previously mentioned, other uses are not supported.

v When you set up the External Network Interface, you might need to enter a default gateway
setting. Obtain this setting from your network administrator, and enter the address into the
Default Gateway input area of Figure 2-85 on page 2-58.

v After you have entered an address, you can test the interface by pinging another location on
the customer network. Click on Network Information from the screen in Figure 2-45 on page
2-38 for this option.

v The External and Grid networks can both be assigned IPv6 addresses. This can be done
manually through DHCP (if a DHCPv6 server is running on the network) or by using IPv6
Stateless Auto-configuration.

v If IPv6 is enabled for External, the IPv6 DNS and IPv6 Default Gateway entries will appear
in System Properties.

v Selecting IPv4 will hide these entries if they are not being used. Selecting IPv6 will hide the
IPv4 entries.

8. Click Save Changes.
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Customizing Firewall Settings

Attention:

v Many procedures in this book are code specific. Before starting any procedure, go to Chapter 1,
“Maintenance Starting Point,” on page 1-1 to determine the code level.

v You must request and receive permission from the customer each time that you update firewall
properties.

Use this information to update the firewall settings.

1. Right click from anywhere in the Desktop to view the Main Menu shown in Figure 2-43 on page 2-37.

2. From the Main Menu, select System Console Actions > Console Configuration Utility.

3. From the Figure 3-93 on page 3-74, select Console Settings > Custom Firewall Settings. You see
the screen shown in Figure 2-86 on page 2-61
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4. Click the radio button in the Accept column to authorize a port or in the Drop column to disallow a port
name.
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Figure 2-86. Customize Firewall Settings
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5. Click on Update Firewall Settings after you have made all your selections.

Configuring Call Home Settings Electronic Customer Care

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
Chapter 1, “Maintenance Starting Point,” on page 1-1 to determine the code level.

1. Right click from anywhere in the Desktop to view the Main Menu shown in Figure 2-43 on page 2-37.

2. From the Main Menu, select System Console Action -> Console Configuration Utility. You see the
login prompt shown in Figure 2-44 on page 2-38.

3. Type service in the Username field, service in the Password field, then single click OK to start the
Console Configuration application. You see the menu shown in Figure 2-45 on page 2-38.

4. Select Call Home Settings. You see the screen shown in Figure 2-87.

Note: In the following steps, for any changes made to other than Delay Call Home, Unlock Call
Home, or Reset Modem, you must scroll down, if necessary, and click 'Apply'.

5. Select an interface to be used for call home. See Figure 2-87.
v Modem

– If you select the modem call home interface, the Modem Port selection box under Call Home
Communication Setup enables.

– If you select the modem port by using the Modem Port selection box: Select "/dev/ttyS0"
("/dev/ttyS0" is the serial port COM1 and "/dev/ttyS1" is serial port COM2, as labeled on the
back of the System Console).

OR

If the System Console has two modems and has two analog telephone lines attached, in the
Modem Port display, select "/dev/ttyS1" as the Call Home Modem Port.

Notes:
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Figure 2-87. General Settings Screen (Call Home and Heartbeat)
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– Using this method will disable all broadband call home.
– If "/dev/ttyS1" is selected but unavailable, no call home activity will take place on the

console and there will be no warning or error messages given.
– When two modems are installed, the modem on COM1 can be configured to be the

inbound modem, and the modem on COM2 can be configured to be the outbound
modem. If only one modem is installed, it must be installed on COM1, and it will be
used for inbound and outbound communication.

– Call Homes that are present in the Call Home Queue will be sent home every 5
minutes to ensure the modem line is not always in use.

v IBM Intranet:
– If you select the IBM Intranet call home interface, the Ethernet Communication section will

enable, under the Call Home Communication Setup.
– Select a method for broadband call home based on the customer's network configuration:

- Direct Communication implies there is not an HTTP proxy between the configured TS3000
and the outside network to IBM. Selecting this method requires no further setup.

- Connect Through HTTP Proxy implies there is a customer HTTP Proxy server which the
customer requires all call home traffic to go through. When selecting this option, enter the
Proxy IP Address and Proxy Port. If necessary, enter any required proxy server username
and password. The customer should supply these values.

Notes:
- Using this method will disable all modem call home transmission (outbound only).
- Ensure that the External Network Interface has been set up in Console Settings.
- Obtain the IP Address, Subnet Mask, and Default Gateway from the customer.
- Port 443 (HTTPS) must be free for outbound traffic. You can verify this with the

customer if a firewall is present.
- If ECC has been locked due to too many failed tries, you can clear the lock by

clicking the "Unlock Call Home" button as shown in Figure 2-88.
- Call Homes will be sent home back-to-back until the Call Home queue is empty.

v Autoselect
– If you select Autoselect call home interface, the System Console will first attempt to call home

over the IBM Intranet. If an intranet interface failure is encountered, call home is attempted over
the modem. Both Modem Port and Ethernet Connection sections should become enabled
below.

– Select a modem port and Ethernet Communication settings, as described in Modem and IBM
Intranet section above.
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Figure 2-88. Unlock Call Home
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Notes:
v If you have a 3958DD1/DD3/DD4/AP1 attached, you will add the values you recorded in

the note in Step 9 on page 2-65 into the fields of Figure 2-93 on page 2-68.
v To determine whether you need to check the Enable Software Problem Call Home box in

Figure 2-93 on page 2-68, contact your next level of support. They can help you to
determine if this option is available in your region.

v If you are uncertain whether you need to check the Enable Software Problem Call Home
box in Figure 2-93 on page 2-68, your next level of support can help you to determine if
this option is available in your region.

v If you have selected Autoselect or IBM Intranet, the call home code will connect the TSSC
to one of the following URLs.

v Call Homes that are present in the Call Home Queue will be sent home every 5 minutes to
ensure the modem line is not always in use.

Table 2-8. URL Table

Hostname IP Port(s) Description

eccgw01.boulder.ibm.com 207.25.252.197 443 ECC transaction gateway

eccgw02.rochester.ibm.com 129.42.160.51 443 ECC transaction gateway

www.ecurep.ibm.com 192.109.81.20 443 File upload for status
reporting and problem
reporting.

www6.software.ibm.com 170.225.15.41 443 File upload for status
reporting and problem
reporting. Proxy to
testcase.boulder.ibm.com

www-945.ibm.com 129.42.26.224 443 Problem reporting server v4

www-945.ibm.com 129.42.34.224 443 Problem reporting server v4

www-945.ibm.com 129.42.42.224 443 Problem reporting server v4

www.ibm.com 129.42.56.216 80, 443 Service provider file (CCF)
download

www.ibm.com 129.42.58.216 80, 443 Service provider file (CCF)
download

www.ibm.com 129.42.60.216 80, 443 Service provider file (CCF)
download

www-03.ibm.com 204.146.30.17 80, 443 Service provider file (CCF)
download

6. Ensure that the customer's network is properly configured for ECC functionality.

7. If you want to enable the System Console heartbeat, check Enable System Console Heartbeat,
then select the day interval (usually set to 3). This is the number of days between heartbeats. Select
Apply.

If Software Problem Call Home is disabled, the call home packages are deposited in the
/var/enc/SWCH directory. You may need to know this if your next level of support requests that you
locate the call home package.

8. From the top menu, select Location Settings. Figure 2-89 on page 2-65 appears.

Note: This screen has an 'Override tape system location settings' checkbox. If this box is NOT
checked, the information on this screen will NOT be sent along with all Call Home records sent to the
TSSC from attached systems. If this box IS checked, information on this screen can be changed and
sent with all Call Home records from attached systems. These changes will also be sent back to any
attached 3957 and 3592 remote systems. It will therefore be unnecessary to update this information
in those remote systems.
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Enter the information into the input areas of the Location Settings For This Site. The fields that
require you to enter information are denoted by an asterisk. Select Apply.

9. From the top menu, click Phone Settings. Figure 2-90 appears. This is required even if you have
selected the IBM intranet option.

10. Choose one of the Dialing Options.

Note: The input areas in the Phone Numbers To Dial fields are limited. If a dial-out prefix such as '9'
is needed to get to a dialing network, put the prefix number in the field that is labeled Dial Out
Prefix.This is required even if you have selected the IBM intranet option.
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Figure 2-89. Site Location Settings Screen
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Figure 2-90. Call Home Phone Settings Screen
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In the Phone List Selection area, select a country, select a state or province (U.S.A. and Canada
only), and select a location for the Location: Phone Number input area from one of the Phone
Numbers To Dial fields.

Enter information in the Phone Numbers To Dial fields. (Remove the area code if System Console will
be placing a seven-digit call.)

Select Apply.

11. From the top menu, select Machine Settings. You see the Machine Settings screen in Figure 2-91.

Enter information into the Machine Settings input areas. Enter a four-digit Machine Type (such as,
3494), a three digit model (such as, B20), and a Machine Serial Number, such as the example shown
'1370806' for one of the attached systems. The machine serial number, entered as a seven-character
alphanumeric, with no dashes, is developed from the first two digits and last five digits of the actual
machine number. For example, 13-0070806 would be entered as 1370806.

Note: For TSSCs with 3958-DE2 or 3958-AP1 complexes attached, the complex's information may
be entered into the Machine Settings section.

The System Console periodically checks for responses from attached tape systems. If a system fails
to respond, the following choices are available:

v Create and Send a Problem Report to RETAIN

v Create an Entry in the Console Log (only)

v Do nothing

The default selection is "Create and Send a Problem Report to RETAIN." However, either of the other
choices is available for selection from this panel by clicking the appropriate button located next to the
desired selection.

Mark any standby systems in the attached systems page to avoid the transmission of unnecessary
call home records(see Step 6 on page 2-39). Make a selection from the Response Check for
Attached Systems choices. Select Apply.

12. From the top menu, select Disposition Settings to develop, specify, or change a schedule for when
you would like Disposition Code 2 records to be sent to the IBM server. The Disposition Settings
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Figure 2-91. Machine Settings Screen
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screen in Figure 2-92 appears. In the Weekdays and the Weekends fields, choose on what days of
the week and during what time periods you would like notices to be sent. Select Apply.

A Disposition Code 2 problem record is typically a lower severity problem which should be sent during
normal business hours. The System Console defaults to sending these records from 0900 to 1500
Monday through Friday.

13. Select Apply to enable the new disposition information, or Restore Defaults if you want to return to
the defaults.

Note: Before ending the installation, ensure that you test the call home setup.

14. From the top menu, select SNMP Settings to request to set up SNMP trap alerts. The two options for
sending traps are:

a. Send Traps for Call Home Failures - This option will alert the customer that the TSSC was unable
to call home for one of three reasons: the failing machine is not entitled for call home, the file
already is present in ECC, and the system is not attached to the TSSC.

b. Send traps for Login/Logout - This option will alert the customer when a remote user logs into the
TSSC.

After setting the trap types, the Community, IP or Hostname and Port need to be updated.

c. The value for the Community field needs to match what is set in the customer's SNMP manager.
The default value is set to public.

d. The value for the IP or Hostname field should represent the destination server that hosts the
SNMP manager. The default value is set to localhost.

e. The value for the Port field should represent the port that the customer's SNMP manager is
listening on. The default value is set to 162.
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Figure 2-92. Disposition Settings Screen
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Initializing System Console Serial Port for connection to local devices
Complete this task to initialize a serial port on the system console.

Use this procedure to initialize a serial port on the system console. You use the serial port to set the baud
rate (or 'data transmission speed').

1. Attach to the system console the null modem adapter and serial cable that shipped with the system
console.

2. Set the system console serial port baud rate for the serial connection by using one of the following
procedures.

v “Setting Baud Rate for System Console Serial Port from System Console”

– – OR – –

v “Setting Baud Rate for System Console Serial Port from Remote Connection” on page 2-70

Setting Baud Rate for System Console Serial Port from System Console
Complete this task to set the baud rate for a System Console serial port from the System Console.

Perform the following steps to set the baud rate for a System Console serial port:

1. After logging in to the System Console, from the System Console desktop, right click on the desktop to
see Figure 2-94 on page 2-69.
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Figure 2-93. SNMP Settings screen
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2. Select Serial Port. You see Figure 2-95. Type the number of the port speed (baud rate) for the device
to which you will be connecting. The message 'Connected' appears. Press Enter.

Notes:
v You may need to try various baud rates if 19200 (2) does not work for your application.
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Figure 2-94. Serial Port Selection on System Console Screen
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Figure 2-95. Baud Rate Screen - From System Console
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v After you have completed setting the baud rate, if unexpected characters appear while you
are typing, you may have set a baud rate that is not correct for your device. Refer to the
documentation for the device to which you have connected, and confirm that you are using
the correct baud rate for your device.

v Use the ~. command to end the connection from the System Console serial port at any
time.

Setting Baud Rate for System Console Serial Port from Remote Connection
Complete this task to set the baud rate for a System Console serial port from a remote connection.

Use this procedure to set the baud rate (transmission speed) for a System Console serial port from a
remote connection. You may need to try various baud rates if 19200 (2) does not work for your application.

1. After logging in to the System Console, at the command line enter the serialport command, on the
prompt line, and press Enter.

raselmc: ~ # serialport

The baud rate screen depicted in Figure 2-96 appears.

2. At the prompt, type the number (from the list) for the port speed for the device to which you will be
connecting. The message 'Connected' appears. Press Enter. The baud rate is now set.

Notes:
v After you have completed setting the baud rate, if unexpected characters appear while you

are typing, you may have set a baud rate that is not correct for your device. Refer to the
documentation for the device to which you have connected, and confirm that you are using
the correct baud rate for your device.

v Use the ~. command to end the connection from the system console serial port at any time.

Backing Up Configuration Data
Complete this task to back up configuration data.

Note: It is recommended, but not required, that you back up configuration data.

Attention: Many procedures in this book are code-specific. Before starting any procedure, go to
Chapter 1, “Maintenance Starting Point,” on page 1-1 to determine the code level.

1. System Console configuration is complete. You may now backup your configuration settings if you
need to re-image the hard disk drive or load a new version of software. You will need a 1.44MB
DOS-formatted floppy diskette (model dependent), a USB storage device, or a CD for this procedure.
Use this procedure when reconfiguring:

v Attached systems

v Call Home settings

IBM TS3000 System Console(tm)
Connect to device through serial port
For RACK MOUNT Console (In 3953 frame), connect to single serial port
For STANDALONE Console, connect where CALL HOME modem connects (COM2)
Available baud rates:
1. 9600
2. 19200
3. 38400
4. 57600
5. 115200
6. 230400

Select baud rate (1-6) or Q to quit and press ENTER:

Figure 2-96. Baud Rate Screen - From Remote Connection
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Notes:
v You can store multiple configurations by using unique backup names. Follow the

convention for backup configuration names of <host name>-<machine type>-<serial
number>.tgz when you create a unique name.

v Model 8849: The 306m does not contain a floppy diskette drive. A USB device is the only
option.

v USB devices must support USB storage standards.

2. Right click from anywhere in the Desktop to view the Main Menu shown in Figure 2-43 on page 2-37.

3. From the Main Menu, select System Console Actions -–> Console Configuration Utility. You see
the screen shown in Figure 2-44 on page 2-38.

4. Type service in the Username field, type service in the Password field, then single click OK to start
the Console Configuration application. You see the screen shown in Figure 2-45 on page 2-38.

5. Click Backup/Restore. You see the screen shown in Figure 2-97.

6. Click Backup Console Configuration Data. You see the Restore Console Configuration Data
screen, which is similar to the Backup Configuration Data screen.

7. Click Backup Console Configuration Data To Diskette.

– – OR – –

Click Backup Console Configuration Data to a USB Drive.

– – OR – –

Click Backup Console Configuration Data to a CD.

– – OR – –

If you are attached to a 3957, 3958, or 3592, you can backup to a remote host. You are shown a box
into which you enter the IP address of the system you want to back up to. You can do this with all
3958's, but only with 3957's with code at V8.5 or higher and 3592's with microcode levels at
1.23.1.54 or higher.

Notes:
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Figure 2-97. Backup Configuration Data Screen. The options you will see on this screen are model dependent.
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v Record the IP address of the remote host that you backed up to. You may need this when
you perform a Restore in Step 7 on page 2-74.

Remote host IP address:

_______ . _______ . _______ . _______

v If you changed the hostname to something other than tssnet1, record the new host name
here.

Remote host name (if you changed it from tssnet1):

___________________________

8. A dialog box appears, requesting that you perform one of the following steps.

v Insert a 1.44MB DOS-formatted floppy diskette.

v Insert a CD.

– – OR – –

v Plug in a USB storage device.

9. Click OK. A message appears which informs you of the success of the procedure.

10. Click OK.

Note: If you have SNMP Trap Forwarding enabled for the 3958–DD1, collect and manually record
the IP addresses as a backup. You may need this address information for a later procedure:
a. On the Backup Console Configuration screen, click Close This Window.
b. From the home page, click Call Home Settings > SNMP Settings.
c. Record the IP addresses which you can acquire from the DS4000 Forwarding IP and RSA

IP fields.

DS4000 _______ . _______ . _______ . _______

RSA IP _______ . _______ . _______ . ______

11. Click Close this window to exit the Backup screen.

Scheduling Configuration Backups

Note: This procedure only works with 3958's, 3957's with microcode levels higher than V8.5, 3592-C06,
and (Enterprise Control Units in 3958-DE2) with microcode levels higher than 1.23.1.54.
v 3957 backups will be stored in the /vtd_hydlog/tsscBRConfig/ directory
v 3958 backups will be stored in the /opt/ras/persist/ directory
v 3592 backups will be stored in the /var/adm/ras/ directory.

1. Right click from anywhere in the Desktop to view the Main Menu shown in Figure 2-43 on page 2-37.

2. From the Main Menu, select System Console Actions > Console Configuration Utility. Type
service in the Username field, type service in the Password field, then click OK.

3. Select Backup/Restore. You see Figure 2-98 on page 2-73.
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4. Click on the:
v Weekly button to request a weekly backup (default)

– – OR – –

Monthly button to request a monthly backup

If you do not want to reschedule configuration backups, go to Step 7.

Note:

5. Choose the host system you want to back up to, or the Backup Host IP Address will default to the IP
address of the main attached system.

6. Select Save Backup Schedule. You are prompted with a confirmation screen. Click OK to continue.

7. If you want to determine when the last offload was performed, select Check Offload Status. The
screen refreshes. In the upper left corner, you see a message like:

Last offload was performed on Wed Feb 13 11:25:28 UTC 2008
Files were offloaded to: 172.31.1.150

8. To reset to the default schedule, select Restore Defaults.

Note: The default backup host is the primary system that is defined in Machine Settings, under the
submenu Call Home Settings.

Restoring Configuration Data

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
Chapter 1, “Maintenance Starting Point,” on page 1-1 to determine the code level.

Notes:
v Perform this procedure ONLY if it is necessary to restore Console Configuration Data.
v Restoration of configuration data from System Console Code Level V1.x.x to a system with

Code Level Version V3.x.x or V4.x.x will not work. It will be necessary to reconfigure the
console settings manually.
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Figure 2-98. Offload Schedule Screen
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1. Log in to the System Console using one of the login options in “User Login” on page 2-34.

2. Right click from anywhere in the Desktop to view the Main Menu shown in Figure 2-43 on page 2-37.

3. From the Main Menu, select System Console Action -–> Console Configuration Utility. You see
the login prompt shown in Figure 2-44 on page 2-38.

4. Type service in the Username field, service in the Password field, then single click OK to start the
Console Configuration application. The menu shown in Figure 2-45 on page 2-38 appears.

Notes:
v To login remotely from another system console, you must obtain an Authentication ID (see

“Login Options” on page 2-35). Launch your browser, and enter the System Console
location into the Address field. Enter your Authentication ID into the Username field and
your password into the Password field. Click OK to start the Console Configuration utility.

v If you are restoring configuration from a remote system, and the hostname of the TSSC is
not going to be remain tsscnet1, use the hostname that you recorded in Step 7 on page
2-71. Also you will need to reattach the subsystem that you wish to retrieve the backup
from. To reattach the subsystem, See “Adding Attached System Information” on page 2-37.

5. Click Backup/Restore. You see Figure 2-97 on page 2-71.

6. Click Restore Console Configuration Data. You see the screen shown in Figure 2-99.

7. Select Restore from diskette, Restore from CD, or Restore from USB drive. Confirm that the
floppy diskette or the CD is inserted in the drive or that the USB device is attached.

– – OR – –

If you are restoring configuration data to the default settings, select Restore to factory defaults.

– – OR – –

If you are restoring configuration data from a remote host, select Restore from remote host. You
can use the default remote host IP address or you can type in a different address, such as the one
you would have recorded in Step 7 on page 2-71.
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Figure 2-99. Restore Configuration Data Screen
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8. In the Remote host input area, type the host IP address you recorded in Step 7 on page 2-71.

9. Click Restore the Selected Configuration Data to begin the Restore. Another dialog box appears,
which informs you of the success of the previous operation, and informs you that the System Console
must be rebooted to complete the restore operation.

Note: When you select OK to continue, the System Console will reboot without further warning!

However, to close any open applications and reboot the system manually, select Cancel. Your
new configuration settings will not be fully in effect until the system console reboots. Remove
the floppy diskette from the diskette drive if you installed one.

10. If you chose Cancel as is mentioned in Step 9, you will need to perform the following steps to reboot
the system console:

a. Click Close this window to close the Restore Console Configuration Data screen.

b. Click on File -–> Exit to exit the browser.

c. Right click from anywhere in the Desktop to view the Main Menu shown in Figure 2-43 on page
2-37.

d. Select Restart Console. The restored configuration data will be available once the System
Console restarts.

11. If you collected and recorded the SNMP Trap Forwarding IPs in Step 10 on page 2-72, as a backup
for the 3958 configuration:
a. After the system has rebooted, from the TSSC Main Menu, select System Console Actions >

Console Configuration Utility > Call Home Settings > SNMP Settings.
b. Into the boxes, enter the IP addresses that you collected and recorded in Step 10 on page 2-72.
c. Click Apply.

Setting Console Date and Time
Complete this task to set the date and time on the TS3000 System Console (TSSC).

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
Chapter 1, “Maintenance Starting Point,” on page 1-1 to determine the code level.

Note: If the TSSC is connected to a 3958-DE2 complex and you have replaced the system planar board,
first remove the Internal Ethernet cable from the back of the TSSC. Use the time on the lower

Figure 2-100. Restore Remote Host. In the Remote host field, add the IP address you recorded in Step 7 on page
2-71.
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ProtecTIER server as the TSSC time for NTP Server re-syncing. Once you have updated the time
on the TSSC, you can reconnect the Internal Ethernet cable, and then start the NTP server.

1. Right click from anywhere in the Desktop to view the Main Menu shown in Figure 2-102 on page 2-77.

2. From the Main Menu, select System Console Actions -–> Console Configuration Utility. The Login
screen displays, as shown in Figure 2-101.

3. Type service in the Username field, type service in the Password field, then single click OK to start
the Console Configuration application. You see the Console Configuration Application screen, shown in
Figure 2-102 on page 2-77.

Note: To login remotely from another System Console, you must obtain an Authentication ID. Launch
your browser, and enter the System Console location into the Address field. Enter your
Authentication ID into the Username field and your password into the Password field. Click OK
to start the Console Configuration utility.

4. Click Console Time. The screen in Figure 2-101 appears.

5. See Figure 2-102 on page 2-77. If you need to change the system clock on the TSSC, you must first
ensure the NTP server is stopped. To do this, click the Stop NTP server button.

6. Enter the correct values in the Time and Date fields.

7. Click Save Changes when you are finished.

8. See Figure 2-103 on page 2-77. To start the NTP server, click the Start the NTP server button.

Note: It may be necessary to log out and log in again to refresh the date and time indicator on the
desktop application bar. It is also possible that the screensaver may be invoked when resetting
the time.
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Figure 2-101. Console Time and Date
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Test RETAIN Connection - During Installation
1. Right click from anywhere in the Desktop to view the Main Menu shown in Figure 2-43 on page 2-37.

2. From the Main Menu, select System Console Actions –> Console Configuration Utility. The Login
screen displays, as shown in Figure 2-44 on page 2-38.

3. Type service in the Username field, type service in the Password field, then single click OK to start
the Console Configuration Utility. You see the screen shown in Figure 2-45 on page 2-38.

Note: To login remotely from another System Console, you must obtain an Authentication ID (see
“Login Options” on page 2-35). Launch your browser, and enter the System Console location
into the Address field. Enter your Authentication ID into the Username field and your password
into the Password field. Click on OK to start the Console Configuration Utility.

4. Click Console Status. The Test RETAIN Connection screen shown in Figure 2-104 on page 2-78
appears.
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Figure 2-102. Stop NTP Server Screen
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Figure 2-103. Start NTP Server Screen
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5. Click Test RETAIN Connection.

6. Click one of the configured telephone numbers.

7. Click Test Problem Notification in the right-hand panel to test the PMR path, or click Test Data
Upload in the right-hand panel to test the data upload path. Details of the results of the test appear in
the screen shown in Figure 2-105. If you changed a telephone number, click Refresh to refresh the
display, then again perform Step 7.

Test Electronic Customer Care (ECC) Connectivity

This feature can be used to assist in both setting up and troubleshooting problems with ECC call home.

1. Right click from anywhere in the Desktop to view the Main Menu shown in Figure 2-43 on page 2-37.

2. From the Main Menu, select System Console Actions –> Console Configuration Utility. The Login
screen displays, as shown in Figure 2-44 on page 2-38.

3. Type service in the Username field, type service in the Password field, then single click OK to start
the Console Configuration Utility. You see the screen shown in Figure 2-45 on page 2-38.
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Figure 2-104. Test RETAIN Connection Request Screen - During Installation
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Figure 2-105. Test RETAIN Connection Results Screen - During Installation
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4. Click Console Status. Click the Test ECC Connectivity link at the top of the page. You will see the
following screen:

5. To test connectivity to the ECC servers, click on the Test Connection button. The test will begin
immediately, and you should see the results of the test on the screen.

Note: If any of the tests report "NOT OK", the listed IP address and port will need to be opened
through the customer's firewall in order to gain access to the ECC service.

6. To cancel the connectivity test, click the Cancel Test button while the test is active.

7. If you would simply like to see the current IP address and ports used by ECC, click the Show ECC
Info button. You will see results similar to the figure in the following image:

Note: All IP addresses and ports must be allowed through a customer's network in order to use all
ECC features.
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Figure 2-106. Test ECC Connectivity Screen
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Figure 2-107. ECC Test in progress showing successful connections being made
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Logging Out of System Console
After you complete your current task on the System Console, you will need to log out of the System
Console.

See Figure 2-43 on page 2-37.

1. Using the right mouse button, click on the desktop to view the Main Menu.

2. Using the left mouse button, click on Logout.... You are logged out of this console session.

You can use the Shutdown Console... menu item if you need to log out and halt the System Console. You
would use this if you needed to physically power OFF the System Console at the end of the shutdown
process. Use the Restart Console... menu item to reboot the System Console. You also can use the
Shutdown and Restart buttons on the System Console Login screen (Figure 1-1 on page 1-1) to halt or
reboot the System Console without logging in.

Test Call Home for 3494 VTS, VTC, 3590 A60, 3592 J70, and 3592 C06
1. Return to the tape system's Call Home / Remote Service Menu at the Library Manager EBTERM

Service Screen (if available). To test a call home through the System Console, select Send Test
Notification Menu, as shown at Figure 2-109. Press Enter. Figure 2-110 on page 2-81 displays.

Attention: Select the illustrated line item only at Figure 2-109. No other menu display items are
applicable for this process.

2. At Figure 2-110 on page 2-81, select Service Notification (via modem). Press Enter. Figure 2-111 on
page 2-81 displays.
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Figure 2-108. Sample output showing ECC IP addresses and ports

Call Home / Remote Services Menu

Move cursor to desired item and press Enter.

Send Test Notification Menu

F1=Help F2=Refresh F3=Cancel F8=Image
F9=Shell F10=Exit Enter=Do

Figure 2-109. Call Home / Remote Services Menu – Send Test Notification Menu
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3. Verify that the following message is received, and verify that the Test Message was received in
RETAIN®.

Test Call Home Notification for 3494 ATL or 3953 Enterprise Library
Controller

Note: This function requires that the 3494 ATL or 3953 be successfully attached to the System Console.
See “Adding Attached System Information” on page 2-37.

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
Chapter 1, “Maintenance Starting Point,” on page 1-1 to determine the code level.

This procedure requires that you previously performed “Tape System Setup for 3494 ATL (Library
Manager) or 3953 Enterprise Library Controller” on page 2-23.

1. To test call home through the System Console, use the 3494 ATL or the 3953 menu commands
Commands --> Call Home... to view the Call Home Dialog box (see Figure 2-112 on page 2-82).

Send Test Notification Menu

Move cursor to desired item and press Enter.

Service Notification (via modem)
Pager Notification (via Pager)

F1=Help F2=Refresh F3=Cancel F8=Image
F9=Shell F10=Exit Enter=Do

Figure 2-110. Send Test Notification Menu – Service Notification

Service Notification Test Result: Test message was queued successfully.

Start waiting for queue program (rsCHDaemon) to receive the Test message (qname=
DI_Vycia).
Press Ctlr-C anytime to cancel test .
11: 418, Tue Jul 10 14:32:37 2001, waittime=131 seconds, send delay after the di
splayed time..........

Figure 2-111. Send Notification Test Result Menu – Waiting
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2. Highlight the line containing 'MC' in the Subsystem column. Click Subsystem problem -> Initiate call
home... Once the call home has been created, a dialog box appears which indicates that the call
home was successfully created and sent to the System Console. The call home package should be
available for viewing within two or three minutes by using the System Console's Queue Management
tool (see “Call Home Queue Management” on page 3-23).

Once the System Console has sent the package to RETAIN, the PMR number will be available by
viewing the Call Home Log tool. To verify the record, log into the RETAIN system and search for the
PMR, or search for records from the type, model, and serial number of the 3494 ATL or the 3953.

Setup for Remote Data Monitoring (VTS, VTC, A60, J70, C06)

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
Chapter 1, “Maintenance Starting Point,” on page 1-1 to determine the code level.

Perform this procedure ONLY if Remote Data Monitoring is to be activated.

1. From the tape system Maintenance menu, select Subsystem Configuration, and press Enter.

2. At Figure 2-113, select Call Home / Remote Services Menu, and press Enter.

Attention: Select the illustrated line item only at Figure 2-113. No other menu display items are
applicable for this process.

Note: To activate Remote Data Monitoring, ensure that the Call Home/Remote Services are set
through the System Console. See Step 2 on page 2-21 and Step 3 on page 2-21.

3. At Figure 2-114 on page 2-83, select Remote Data Monitoring, and press Enter. Figure 2-115 on
page 2-83 displays.
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Figure 2-112. Call Home Dialog Box

Subsystem Configuration

Move cursor to desired item and press Enter.

Call Home / Remote Services Menu

F1=Help F2=Refresh F3=Cancel F8=Image
F9=Shell F10=Exit Enter=Do

Figure 2-113. Subsystem Configuration Menu – Call Home / Remote Services Menu
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Attention: Select the illustrated line item only at Figure 2-114. No other menu display items are
applicable for this process.

4. At Figure 2-115, select Change / Show Call Home Heartbeat Interval, and press Enter.

Attention: Select the illustrated line item only at Figure 2-115. No other menu display items are
applicable for this process.

5. In the example in Figure 2-116 on page 2-84, 7 days has been selected. Press Enter. Figure 2-117
on page 2-84 displays.

Note: The Change / Show Call Home Heartbeat Interval option allows the user to select how often a
heartbeat is sent home. A heartbeat consists of Machine Reportable Product Data (MRPD),
such as installed features and code levels, and the output of a health check program like VTS
Checkout. The frequency of these heartbeats can be between 1 and 15 days. The heartbeat
can be disabled.

Call Home / Remote Services Menu

Move cursor to desired item and press Enter.

Remote Data Monitoring

F1=Help F2=Refresh F3=Cancel F8=Image
F9=Shell F10=Exit Enter=Do

Figure 2-114. Call Home / Remote Services Menu – Remote Data Monitoring

Remote Data Monitoring

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

[Entry Fields]
* Change / Show Call Home Heartbeat Interval Disabled +
* Error Initiated Call Home Data Gathering Disabled +
* Timeout Period Between Successive Data Call Homes [24] #

(In hours between 1 and 99)

F1=Help F2=Refresh F3=Cancel F4=List
F5=Reset F6=Command F7=Edit F8=Image
F9=Shell F10=Exit Enter=Do

Figure 2-115. Remote Data Monitoring Menu – Change / Show Call Home Heartbeat Interval
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6. At Figure 2-117, select * Error Initiated Call Home Data Gathering, and press F4 to display the list
of options shown in Figure 2-118 on page 2-85.

Note: The Error Initiated Call Home Data Gathering option allows the user to enable or disable data
gathering when a call home occurs. If enabled, data collection and diagnostic programs will be
run whenever a call home event occurs, and the collected output will be sent to the Support
Center. The data that is collected contains information that will help in determining what
caused the problem leading to the call home. If disabled, no data collection will occur when a
call home event occurs.

Remote Data Monitoring

Ty lqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqk
Prx Change / Show Call Home Heartbeat Interval x

x x
x Move cursor to desired item and press Enter. x

* x x
* x [TOP] x
* x Disabled x

x 1 day x
x 2 days x
x 3 days x
x 4 days x
x 5 days x
x 6 days x
x 7 days x
x 8 days x
x 9 days x
x [MORE...6] x
x x
x F1=Help F2=Refresh F3=Cancel x
x F8=Image F10=Exit Enter=Do x
x F5 /=Find n=Find Next x

F9 lqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqk

Figure 2-116. Remote Data Monitoring Menu

Remote Data Monitoring

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

[Entry Fields]
* Change / Show Call Home Heartbeat Interval 7 days +
* Error Initiated Call Home Data Gathering Disabled +
* Timeout Period Between Successive Data Call Homes [24] #

(In hours between 1 and 99

F1=Help F2=Refresh F3=Cancel F4=List
F5=Reset F6=Command F7=Edit F8=Image
F9=Shell F10=Exit Enter=Do

Figure 2-117. Remote Data Monitoring Menu – Error Initiated Call Home Data Gathering Disabled
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7. Select Enabled, and press Enter. Figure 2-119 appears with the selected values displayed.

Note: The Timeout Period Between Successive Data Call Homes option allows the user to select the
minimum time between successive Error Initiated Call Home Data Gatherings. The user can
select any number of hours between 01 and 99 hours (leading zero is required). As an
example, assume that the user has chosen 24 hours. If a call home event occurs, extra data
gathering will be performed, and the 24-hour clock begins timing. If another Call Home event
occurs before the 24 hours has expired, no extra data gathering will be performed, even if that
option is enabled. If a call home event occurs after the 24-hour period and Error Initiated Call
Home Data Gathering is enabled, the extra data gathering will occur and the time-out period
will begin again.

8. At Figure 2-119, press Enter. A COMMAND STATUS screen (Figure 2-120 on page 2-86) displays
showing that a command is running.

Remote Data Monitoring

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

[Entry Fields]
* Change / Show Call Home Heartbeat Interval 7 days +
* Error Initiated Call Home Data Gathering Disabled +
* Timeout Period Between Successive Data Call Homes [24] #

(In hours between 1 and 99)

lqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqk
x Error Initiated Call Home Data Gathering x
x x
x Move cursor to desired item and press Enter. x
x x
x Disabled x
x Enabled x
x x
x F1=Help F2=Refresh F3=Cancel x
xF1 F8=Image F10=Exit Enter=Do x
xF5 /=Find n=Find Next x

F9 lqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqqk

Figure 2-118. Remote Data Monitoring Menu – Error Initiated Call Home Data Gathering Results

Remote Data Monitoring

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

[Entry Fields]
* Change / Show Call Home Heartbeat Interval 7 days +
* Error Initiated Call Home Data Gathering Enabled +
* Timeout Period Between Successive Data Call Homes [24] #

(In hours between 1 and 99)

F1=Help F2=Refresh F3=Cancel F4=List
F5=Reset F6=Command F7=Edit F8=Image
F9=Shell F10=Exit Enter=Do

Figure 2-119. Remote Data Monitoring Menu – Error Initiated Call Home Data Gathering Enabled
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9. The Command Status screen (Figure 2-120) displays for as long as five minutes. It is normal for there
to be no response for this period of time. DO NOT press any keys while the command is running.

10. When the execution of the command is complete, the screen shown in Figure 2-121 displays. "OK"
appears in the "Command" field.

11. Press F3 twice to return to the "Call Home / Remote Services Menu."

Setup for Remote Data Monitoring (3494 ATL or 3953 Enterprise
Library Controller)

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
Chapter 1, “Maintenance Starting Point,” on page 1-1 to determine the code level.

See “Set Heartbeat” on page 2-30.

COMMAND STATUS

Command: running stdout: yes stderr: no

Before command completion, additional instructions may appear below.

The values have been successfully changed

Figure 2-120. COMMAND STATUS Screen – Running

COMMAND STATUS

Command: OK stdout: yes stderr: no

Before command completion, additional instructions may appear below.

The values have been successfully changed

Figure 2-121. COMMAND STATUS Screen – OK
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Chapter 3. Procedures

Service Tools

Telnet to Attached Tape System

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
Chapter 1, “Maintenance Starting Point,” on page 1-1 to determine the code level.

After you complete the System Console configuration, the tool to establish telnet connections to attached
systems is automatically enabled.

1. Right click from anywhere in the Desktop to view the Main Menu shown in Figure 2-43 on page 2-37)
and select Telnet to Tape System. You see the screen shown in Figure 3-1.

2. Enter the number of the system you want to telnet to, and press enter.

3. When you have a successful telnet connection, you see the screen shown in Figure 3-2 on page 3-2.
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Figure 3-1. Telnet to Attached Tape System – Selecting
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Notes:
v Log into the system using the established security procedures for that device. If your ID and

password were successfully propagated, they can be used to log in.
v You may establish as many telnet sessions at one time, as necessary.
v You may establish multiple telnet sessions with a single system.
v If the function keys (F3, F4, F10, and so forth) do not work as intended in the SMIT

screens, use ESC+3, ESC+4, ESC+0 key sequences instead.
v The telnet screen must be a minimum of eighty columns-by-twenty-five lines in order for

SMIT screens to display properly. To change the size of the telnet screen, click and drag the
lower right corner of the screen.

v If a communication attempt with an attached system fails, the telnet screen will disappear
from the desktop, and no error message will display.

Telnet to Grid TSSC

Use this procedure to connect to another TSSC within the Grid network.

1. Right click from anywhere in the Desktop to view the Main Menu shown in Figure 2-43 on page 2-37.

2. From the Main Menu, select Telnet to Grid TSSC. You see the figure shown below. You will see
information about each Grid system as it is available, including IP address, hostname and location.

Figure 3-2. Telnet to Attached Tape System – Connection Successful
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3. To connect to a system, press its corresponding list number. To see attached system information about
a particular system, press L. Press q to exit this application.

4. If you would like to see attached system information for a particular system, press L. You will be
prompted to enter the system number. Attached System information will look like the following:

5. After viewing the Attached Systems, you can connect to the selected TSSC by pressing c. Pressing b
will take you back to the main screen.
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Figure 3-3. Telnet to Grid TSSC
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Figure 3-4. Attached Systems List
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Tape System Service Information (VTS, VTC, A60, J70, C06) - [Code
Level Below V5.3]

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
Chapter 1, “Maintenance Starting Point,” on page 1-1 to determine the code level.

After you complete the System Console configuration, the tool to update and review service information for
attached systems is automatically enabled.

1. Right click from anywhere in the Desktop to view the Main Menu shown in Figure 2-43 on page 2-37.

2. Select System Console Actions, Tape System Service Information. You see the Tape System
Service Information screen shown in Figure 3-5.

3. The Tape System Service Information screen, as depicted in Figure 3-5, shows a summary of the
status of the systems that are attached to the System Console as of the date and time that are
included in the Last Update column. The system listing is sorted in descending order of status severity.
The background color scheme provides this information:

v Red Background - A Failure has occurred

v Yellow Background - A Warning has occurred

v Green Background - No Failures or Warnings have occurred

v Gray (or White) Background - No status has ever been reported to the System Console

4. Tape System Service Information status is NOT run automatically. It is performed by selecting any
number of systems in the listing and then clicking the Update button. Systems may be selected
individually by pointing to the system list entry and clicking the left mouse button once. (Clicking the
entry again deselects the system.) Alternatively, you can select all of the systems on the list by clicking
Select All (or deselect by clicking Deselect All).

5. As the System Console receives service information from the selected tape systems during the update
process, the selected systems become deselected (un-highlighted), the date and time of last update is
changed to the current date and time, and the new status is indicated by the background color of the
system entry listing and the STATUS column (located on the left side).

Figure 3-5. Tape System Service Information – Main Screen
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Note: The update process can be lengthy for a large number of attached systems. However, this tool
will time-out at ten minutes for unresponsive systems and return control to the user. The tool is
normally unresponsive during the Update process and may appear to be locked up if attached
systems are not responding.

6. The Tape System Service Information may be reviewed at various levels of detail. The main screen
shows a one-line status summary for each system attached to the console. Selecting one or more of
the systems in the listing and clicking View Events results in a listing of the specific service events
that resulted in the failure or warning status, as shown in Figure 3-6.

7. Double-clicking one of the events shown in Figure 3-6 results in the full details of the event, as shown
in Figure 3-7 on page 3-6.

Figure 3-6. Tape System Service Information – Events
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You also can view the contents of the entire service status file for an attached system by selecting it at
the Tape System Service Information main screen (Figure 3-5 on page 3-4) and clicking View File.

Note: The Tape System Service Information tool remotely invokes rdm_bc_check (Models B10, B18,
B20) or rdm_gm_check (tape subsystem control units) service diagnostic programs and then
presents the results to the System Console as a local convenience. No modification of the
results of the diagnostic programs is performed by the console, and the service programs
remain available for direct invocation on the attached systems with proper user access.

8. From the Main Screen in Figure 3-5 on page 3-4, select Quit to quit.

Creating Attached Subsystems List

Use this procedure to create a list of all the subsystems that the System Console is attached to.

1. Right click from anywhere in the Desktop to view the Main Menu shown in Figure 2-43 on page 2-37.

2. Select System Console Actions > Console Configuration Utility. Login, as required.

3. Select Attached Subsystems. You see Figure 3-8 on page 3-7. You can sort the list by clicking on a
column heading.

Figure 3-7. Tape System Service Information – Event Detail
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Table 3-1. Color Indications for Health Check. Use with Figure 3-8.

Health Legend
Color Health Legend Indication

Green No problem returned from system health check

Yellow Warnings found in system health check

Red Failed statuses found in system health check

Black Offline Status(es) Found in the System Health Check

Blue Communication failure between TSSC and attached systems

4. You can use one group of buttons to perform Delete, Edit, and Query operations on the list of attached
subsystems. You also can use another set of buttons to interrogate the System Console for the
following operations. Click on any quantity of attached subsystems and select one of the button titles.
You see a screen like Figure 3-9 on page 3-8 with one of these reports:

Note: These choices are not available for a 3584 or a 3494L.

View Health

Returns information about the machines you choose

View Events

Returns event information on any machines for which a problem has been logged

Update Health

Performs another machine health check

Refresh

Refreshes the information and the color scheme in Table 3-1 to reflect your most recent activity
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Figure 3-8. Attached Subsystems List Screen. Use with Table 3-1.
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5. View the properties of the Attached system by selecting the hyperlinked serial number. This will display
all of the properties of that attached system. To go back to the list of the attached systems, click the
Attached Systems link at the top of the screen.

Remote Code Broadcast By Using the Web Interface

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
Chapter 1, “Maintenance Starting Point,” on page 1-1 to determine the code level. The code level
requirements are:

System Console
Code Version 5.3.x and above

IBM TS7700 Virtualization Engine
System Console must be a hardware model 8485 (x206m) or 8849 (x306m). Code Versions
8.5.XX.XX and lower. For higher code levels, refer to “Mksysb Broadcast from the Web Interface”
on page 3-82.

IBM 3494 Virtual Tape Server and Virtual Tape Controller
Code Version 2.26.xx.xx and above

IBM 3590 A60 Tape Controller
Code Version 1.16.xx.xx and above

IBM 3592 J70 Tape Controller
Code Version 1.17.xx.xx and above

IBM 3592 C06 Tape Controller
Code Version 1.20.x.x and above

IBM 3494 ATL (L12, L14, L22)
Not currently operational

You can use the web interface to copy control unit code from a source CD that you place in the CD drive
of the System Console. You then can broadcast this code to another device.

1. Right click from anywhere in the Desktop to view the Main Menu shown in Figure 2-43 on page 2-37.

2. Select System Console Actions > Console Configuration Utility. Type service in the Username
field, service in the Password field, then click OK.

3. Select System Tools > Remote Code Broadcast. You see the screen shown in Figure 3-10 on page
3-9.
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Figure 3-9. Health and Events Report Screen Example.
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4. Insert the disc which has the code you wish to broadcast into the optical disc drive of the TSSC.

5. Select one of the options for Broadcast Code Disc, then select Broadcast Code CD.
Do not overwrite existing controller code if already on this console

Select this option if you previously broadcast code to a system using the code disc that you
just inserted into the drive. This eliminates the time it takes to load code from the disc.

Note: If the image copy failed, select View the Log File. Retry Broadcast Code Disc after
you determine the cause.

Delete code images on attached machines to make room for broadcast image
Select this option to choose which images you want to delete from the target system. A list
displays. To add an image to the target system, ensure that the target system has no more
than one image.

Note: If you selected "Delete code images on attached machines to make room for broadcast
image" the screen reloads and refreshes the list of images to delete. Select the images
you want to delete. Type in the numbers of the images that you wish to delete.
Separate the numbers by spaces (for example, “0 1 4 5”). Select Submit Choices.

6. When the code copy completes, a message appears, and prompts you to select which system to
broadcast the code image to. You see a box entitled “Systems for Code Broadcast” at the bottom of
the screen.

This box contains a list of the attached systems that can be broadcast to. Table 3-2 on page 3-11 lists
the possible status conditions you might anticipate.
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Figure 3-10. Remote Code Broadcast Options
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7. Select the systems to which you want to broadcast a code image. In the "Systems for Code
Broadcast" column, type the numbers of the systems, separated by spaces. Leave this field blank if
you do not want to broadcast a code image, or you can select the Cancel button. Click on Submit
Choices.

Notes:
v This can take as long as five minutes per system.
v Figure 3-10 on page 3-9 provides an example, which depicts that the code broadcast will fail

because the attached control units are “Unavailable.”
v If an error occurs, select View the Log File from Figure 3-10 on page 3-9 to check the log

file to determine the failure.
v If the status is 2+ IMGS (which indicates "2 or more images") on the attached system you

wish to broadcast to, the image is not broadcast unless you select the “Delete images...”
option depicted in Figure 3-10 on page 3-9, and you remove the images from the target
system.

8. You also can use the following additional options which are depicted in Figure 3-10 on page 3-9:

v Option 2: After you select the systems to broadcast and the page reloads, you see a status
message at the top of the screen. Use option 2 “View the Log File” to see the details of the
broadcast. This log lists the code that was successfully broadcast and the code that was
successfully finalized. If an error occurred, the log file will specify where the load failed. Figure 3-12
on page 3-11 shows you a sample of status in a log file.

Figure 3-11. Choose Systems for Code Broadcast
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Table 3-2. Code Load Status Messages - From Web Interface. See Figure 3-12 for an example of broadcast status.

Status Meaning

OK OK to copy code to attached system

NO DIR No temporary directory exists on attached system to copy code into

PREV VER The temporary directory on the attached system is not empty

NO COMM
Unable to communicate with attached system (possibly due to downlevel code on attached
system or bad physical connection)

NO SPACE Insufficient space on attached system for copying code

NO SPC 1 Insufficient space on attached system's gdc file system for copying code

NO SPC 2 Insufficient space on attached system's usr file system for copying code

NO SPC 3 Insufficient space on attached system's gdc and usr file systems for copying code

2+ IMGS
There are two or more code images on the attached system (will not broadcast code unless
you remove images by using the "Delete code images..." option.

NOT OK Unspecified error condition has occurred

v Option 3, “Clear the Log File,” deletes the log file and clears this screen. Use this when the previous
log file is irrelevant. Only use this option if you no longer need the old log file for reference to an
error.

v Option 4, “Eject the CD,” should be used when the disc is no longer in use or when you are
attempting to copy the code from the disc for a second time. If the program reports that there is an
error mounting the disc, remove and insert the disc again.

Figure 3-12. Remote Code Broadcast Log File. See Table 3-2 for a list of the possible status messages.
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Tape Drive Service Information

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
Chapter 1, “Maintenance Starting Point,” on page 1-1 to determine the code level. The code level
requirements are:

System Console
Code Version 3.0.0 and above

IBM 3494 Virtual Tape Server and Virtual Tape Controller
Code Version 2.28.700.xx and above

IBM 3590 A60 Tape Controller
Code Version 1.16.5.xx and above

IBM 3592 J70 Tape Controller
Code Version 1.17.xx.xx and above

IBM 3592 C06 Tape Controller
Code Version 1.20.x.x and above

IBM 3494 ATL (L12, L14, L22)
Not currently operational

1. See Figure 3-13. After you complete the System Console configuration, the tool to update and review
tape drive service information for attached systems is automatically enabled. Right click from anywhere
in the Desktop to view the Main Menu shown in Figure 2-43 on page 2-37.

2. Select System Console Action --> Tape Drive Service Information.

3. The Figure 3-13 lists all systems attached to the System Console which might have tape drive
information available. The Main Screen shows a summary of the update status of the systems
attached to the System Console as of the DATE and TIME INDICATED in the right column. The
systems listed are highlighted according to the following color scheme:

Yellow Background
Tape drive information for this system has been updated
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Yellow Background (Systems with Updated Information
Gray Background (Systems which have not been queried)

(Selected systems are highlighted with a slightly darker color
than unselected systems)

Figure 3-13. Tape Drive Service Information – Main Screen
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Gray (or White) Background
No tape drive information has ever been reported to the System Console

4. Tape Drive Service Information is NOT run automatically. It is performed by selecting any number of
systems in the listing and then clicking Update. You can select individual systems by pointing to the
system list entry and clicking the left mouse button once. (Click the entry again to deselect the
system.) Alternatively, you can select all of the systems on the list by clicking Select All (or deselect by
clicking Deselect All).

5. As the System Console receives service information from the selected tape systems during the update
process, the selected systems become deselected (un-highlighted), the date and time of last update is
changed to the current time, and the new status is indicated by the background color of the system
entry listing.

Note: The update process can be lengthy with a large number of attached systems. However, this tool
will time-out after ten minutes for unresponsive systems and return control to the user. The tool
is normally unresponsive during the Update process and may appear to be locked up if
attached systems are not responding.

6. The Control Unit Tape Drive Service Information Files (code level V3.1.0 and above) show the
following information for each attached tape system, following a successful update (see Figure 3-16 on
page 3-15 and Figure 3-17 on page 3-15):

v Control Unit Error Log showing tape drive entries (see Figure 3-14)

v Control Unit Tape Drive Status (see Figure 3-15 on page 3-14)

Figure 3-14. Tape Drive Service Information – Tape Drive Error Log Details Screen
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Figure 3-15. Tape Drive Service Information – Tape Drive Status Screen
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Figure 3-16. View Tape Drive Service Information – Code Level V3.1.0 or Above
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Figure 3-17. File Viewer Showing a File Generated by Tape Drive Service Information – Code Level V3.1.0 or Above
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7. Each report may be viewed by selecting one of the systems listed on the Main Screen (Figure 3-13 on
page 3-12), then clicking View Error Log or View Drive Status. Systems may be selected by pointing
to the system list entry, and clicking the left mouse button once. (Clicking the entry a second time
deselects the system.)

For code level V3.1.0 and above, you can use the additional action View All Files. This action allows
you to view all drive service information returned by a tape system. You also can find additional
formatted or unformatted error information in these files.

8. From the Main Screen in Figure 3-13 on page 3-12, select Quit to quit.

Tape Drive Code Broadcast From Web Interface

Attention: Many procedures in this MI are code specific. Before starting any procedure, go to Chapter 1,
“Maintenance Starting Point,” on page 1-1 to determine the code level. The code level requirements are:

System Console
Code Version 5.3.x and above

IBM TS7700 Virtualization Engine
System Console must be a hardware model 8485 (x206m) or 8849 (x306m)

IBM 3494 Virtual Tape Server and Virtual Tape Controller
Code Version 2.26.xx.xx and above

IBM 3590 A60 Tape Controller
Code Version 1.16.xx.xx and above

IBM 3592 J70 Tape Controller
Code Version 1.17.xx.xx and above

IBM 3592 C06 Tape Controller
Code Version 1.20.x.x and above

IBM 3494 ATL (L12, L14, L22)
Not currently operational

1. Right click from anywhere in the Desktop to view the Main Menu shown in Figure 2-43 on page 2-37.

2. From the Main Menu, select System Console Actions > Console Configuration Utility. Type
service in the Username field, type service in the Password field, then click OK.

3. Select System Tools > Drive Code Broadcast. You see Figure 3-18.

4. Select the Manage tape drive code on this console option under Actions to view tape drive code
currently on the TSSC. From this screen you may add new code to the console or delete existing
code.

5. To add code, click on the Add new tape drive code to this console button. You will be prompted to
insert a CD-ROM containing tape drive code into the optical disc drive. Once the disc has been
inserted into the console, click OK to continue. If a valid drive code CD was inserted, you will see a
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Figure 3-18. Drive Code Broadcast Web Interface
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listing of the drive code on the disc, similar to Figure 3-19. Check the box next to each entry you want
to copy to the console and click Copy selected code to console. If you don't want to copy any code
from this disc to the console, click the Cancel button.

6. Similarly, to delete existing code, place a check mark next to the code images you wish to delete. Click
the Delete selected code button and you will be prompted to verify the delete operation. Click OK to
continue deleting the selected drive code or Cancel to return to the previous screen.

7. See Figure 3-20 on page 3-18. To broadcast tape drive code to systems attached to this console,
select the Broadcast tape drive code option under Actions. The display will change to show the
existing code on this console and all valid broadcast targets attached to this TSSC. (Optionally, you will
also see other TSSCs connected over the Grid network.) Place a check mark next to each code image
to broadcast and each target system that should receive the broadcast. You must select at least one
image and one attached system. Once your selections have been made, click the Broadcast Selected
Code button. You will be prompted to verify the operation, so click OK to continue the broadcast or
Cancel to return to the previous screen. The broadcast may take several minutes to complete
depending on how many target systems were selected. Once the broadcast has finished, you will see
a message displaying the status of each individual broadcast.
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Figure 3-19. Drive code listing. You may copy selected drive code to the console
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8. See Figure 3-21 on page 3-19. You may gather tape drive information from attached systems by
selecting the Gather tape drive information option under Actions. The display will show all valid
attached systems. Place a check mark next to each system for which you would like to see tape drive
information. Once your selections have been made, click the Gather information from selected
systems button. You will be prompted before information is gathered. Click OK to continue or Cancel
to end this process. Clicking OK will proceed with the gathering process. It may take several minutes
depending on the number of systems selected. Once finished, the screen will display tape drive
information for the selected systems.
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Figure 3-20. The broadcast screen will display all available code images and valid broadcast targets.
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Remote Access Using NetTerm

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
Chapter 1, “Maintenance Starting Point,” on page 1-1 to determine the code level.

When using a workstation or notebook (laptop) computer with a modem, it is first necessary to establish a
connection to the System Console modem. The following instructions apply for using the NetTerm tool.
(Other tools also may be used.)

Configure NetTerm for Accessing a System Console's Modem
1. From the Phone Directory window, click OK.

2. Start the NetTerm program.

3. From the NetTerm Start-up Window tool bar, select File.

4. From the File pop-up list, select Phone Directory.

5. From the Phone Directory window, select Modem Test.

6. From the Phone Directory window, modify the following fields to the values listed:
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Figure 3-21. Display showing tape drive information for a selected system
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Field Entry
Name (select a name with which you are comfortable. An example would be Customer name.)
Phone Number of Modem (from Configuration Sheet-Select modem attached to COM1-ttyS0)
Emulation IBM_3151
Keys IBM_3151

7. From the Phone Directory window, verify that the Connection field has Modem selected.

8. From the Phone Directory window, click Modem Settings. This will bring up a Communications Setup
window.

9. From the Communications Setup window, click Modems. This will bring up a Select Modem window.

10. From the Select Modem window, click Default. You can be returned to the Phone Directory window or
the Communications Setup window. To return to:

v Phone Directory window, go to Step 11.

v Communications Setup window, go to Step 12.

11. From the Phone Directory window, click Modem Settings to bring up the Communications Setup
window.

12. From the Communications Setup window, modify the following fields to the values listed:
Field Entry
Port: xxxx (Select the port for your PC/Laptop modem)
Baud Rate: 56000
Data Bits: 8
Parity: None
Stop bits: 1
Modem Initialize command-Accept Default:AT E1 V1 M1 Q0 &B1 &C1 &D2 &H1 &R2 &NO &K1 S11=50 S7=60

Control Settings (click on box to change)
DTR/DSR box unchecked
RTS/CTS box checked
XON/OFF box unchecked
Tone Dialing box checked
Direct Line box unchecked
Ignore Carrier box unchecked

Use TAPI box unchecked

13. After making the changes to the Communications Setup window, click OK. You will be returned to the
Phone Directory window.

14. From the Phone Directory window, click Desktop.

15. From the Desktop window, change the following settings:

a. Click on the Autowrap box to place a check mark (U) in that box.

b. Click on the Exit NetTerm on disconnect box to remove the check mark from that box.

16. From the Desktop window, click OK. You will be returned back to the phone Directory window.

17. From the Phone Directory window, click Color.

18. From the Screen Colors window, click on the Allow Graphics rendition code of 0 to reset colors
to default to place a check mark (U) in that box.

19. From the Screen Colors window, click OK. You will be returned to the Phone Directory window.

20. From the Phone Directory window, click Add.

Note: The Phone Directory entry (the name for this activity that you selected in Step 6 on page
3-19) may not be displayed in the phone directory list until you exit and restart the NetTerm
program.

21. From the Phone Directory window, click OK.
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Connecting to a System Console's Modem
1. From the NetTerm main menu, select File.

2. Select Phone Directory.

3. Select the Phone Directory Entry established for this console (entry previously created in Step 6 on
page 3-19).

4. Select Connect.

Note: If the LAN network is down, have the service representative or the customer administrator
install the 30.5-m (100-ft) serial cable that was shipped with the IBM 3953. It attaches to the
S0 port (S1 port on IBM 3953).

5. Login to the System Console as user Service (this login is case-sensitive) Use the password
provided from IBM Support to begin the authentication process. Enter your Authentication ID when
prompted. This will be your unique userid also provided by IBM Support.

Notes:

v This process attempts to copy your userid and password to attached VTS, VTC, or Tape
Controller systems. This process may not complete successfully on all attached systems.

CONNECT 33600

IBM TS3000 System Console Version 4.0.0-121905 Level: gint-1021

raselmc.storage.tucson.ibm.com login: �

Figure 3-22. Enter Password Screen

3.0.0
=
tssnet1 login: Service
Password:
Last login: Tue Apr 2 15:32:20 on ttyS0

Please enter your Authentication ID: jdoe

Group: Service
userdel: user jdoe does not exist
Creating user jdoe
Account expires on: 05/25/04
Changing password for user jdoe
New password:
Retype new password:
passwd: all authentication tokens updated successfully
Initiating broadcast to... vts1
Initiating broadcast to... vts2
Initiating broadcast to... vts3
Initiating broadcast to... vts4
Waiting for completion...
vts1: Ok
vts2: Ok
vts3: Could not execute remote command
vts4: Ok
Continue with the following key code.

Key: en7260wv93Lzg577XXLR7A2X2UxBhl55bv8fjy1o5me?l

Press [c] to continue.
c
Exiting

Figure 3-23. Connect to System Console Modem Screen
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v Note the results after "Waiting for completion..." This indicates the success of copying
your password to systems attached to the console.

v Your userid and password will be valid for the time indicated on the console and for all
systems that indicate "Ok" after "Waiting for completion..."

v The "Waiting for completion..." process should not take longer than five minutes before
timing out.

v For systems which do not respond with "Ok", you will need to either perform a separate
authentication, or login using methods from previous code levels.

v See “Login Options” on page 2-35 (Authenticated) for more information about systems that
do not respond "Ok".

6. Use the mouse to highlight the line containing the "Key ..." string. From the NetTerm main menu,
select Edit --> Copy to place the key on the clipboard. Enter c, and press Enter to continue and to
exit the session.

Note: Access to an IBM Authentication Server is required to perform the following step.

7. Using the key that was generated in Step 6, login to the IBM Authentication Server to retrieve your
authentication password. When requested, use the NetTerm main menu commands Edit --> Paste to
provide the key to the authentication server.

8. Make a note of your password from the IBM Authentication Server. Continue logging in to the System
Console. Your password will be valid for as long as twenty-four hours.

Note: Do not use a Copy/Paste keyboard function to enter your password for System Console login.

9. Login to the System Console, by using your unique userid and the password that were provided by
the IBM Authentication server.

10. From the command prompt, you may perform console tasks or you may alternatively communicate
with tape systems that are attached to the System Console.

Note: It is possible that the keyboard function keys (F1, F2, and so forth) and the Backspace/Delete
keys will not work as they should. When this happens, enter the following command at the
command prompt: export TERM=vt100. If the function keys still do not work as they should,
use the combination Esc+xx , where xx is the number of the function key.

11. To telnet to systems that are attached to the System Console, issue the 'tsys' command, and enter
the number of the system to which you would like to connect (see Figure 3-26 on page 3-23). You
can use the command tsys-? to view the choices for reordering the list.

UserId is jdoe, AccessLvl is Service
Please enter Key Code.

Key: en7260wv93Lzg577XXLR7A2X2UxBhl55bv8fjy1o5me?l
Key: en7260wv93Lzg577XXLR7A2X2UxBhl55bv8fjy1o5me?l

Hello jdoe Please login using password: abcd321

Figure 3-24. Userid Screen

IBM TS3000 System Console Version 4.0.0-121905 Level: gint-1021

raselmc.storage.tucson.ibm.com login: jdoe
Password:
COLOR NETTERM
jdoe@raselmc:"> �

Figure 3-25. Enter Password Screen
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You may login with your userid and password to any of the attached systems that responded with
"Waiting for completion..." –> "Ok" in Step 5 on page 3-21, above. See "Authenticated" in “Login
Options” on page 2-35 for information on how to login to systems that did not respond "Ok."

12. To logoff from the System Console, type exit at the command prompt, and press Enter.

13. From the NetTerm main screen, select File, then Exit to close the NetTerm tool.

Call Home Queue Management

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
Chapter 1, “Maintenance Starting Point,” on page 1-1 to determine the code level.

1. Right click from anywhere in the Desktop to view the Main Menu shown in Figure 2-43 on page 2-37.

2. From the Main Menu, select System Console Actions –> Console Configuration Utility. You see
the Figure 2-44 on page 2-38.

3. Type service in the Username field, type service in the Password field, then single click OK to start
the Console Configuration application.

4. Click Call Home Queue. You see the Figure 3-28. The various call home record types (in the "Type"
column) are described in Table 3-3 on page 3-24.

IBM TS3000 System Console
Telnet to Attached Tape System

# Make/Model Serial Number IP Address Hostname
--------------------------------------------------------------------------------
1: 3494B20 78B2018 172.31.1.40 rasvts
2: 3494L22 1314501 172.31.1.5 "LMA"
3: 3590A60 7000239 172.31.1.26 rasa60
4: 3592J70 100B89A 172.31.1.36 rasj70
5: 3953L05 1300004 172.31.1.11 "LMA"
6: 3953L05 1300004 172.31.1.12 "LMB"

Which system would you like to connect to (or ’q’ to quit)? �

Figure 3-26. Choose System Prompt

[jdoe@tssnet1 jdoe]# exit
logout

Figure 3-27. Logout
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Figure 3-28. Call Home Queue Management - Main Screen
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Table 3-3. Call Home Record Types. From the Type column in Figure 3-28 on page 3-23.

Type Description

DC Data Call Home (Binary)

DI Information - EC Install, Call Home Test

DT Dump/Trace (Binary)

EC EC Activation

HB Heartbeat MRPD

IS Install

PB Problem Record

PE PE Package (Binary)

PG Problem Page

PI Proactive / Warning

PT Pager Test

RI Close Problem

RL Remote Dial-In

SW Software Problem Record

The Queue Management tool offers the following capabilities:

v View current entries in Call Home queue on the System Console

v Delete or Change priority of entries

v View details of specific entries

v Offload individual packages immediately

v Offload Call Home Entries to Diskette

5. To Delete or Force Delete a Call Home Queue Entry, select the entry by clicking on the check box
next to the corresponding entry. Click Delete Selected Entries. To Show Details for a Call Home
Queue Entry, select the entry by clicking the checkbox next to the corresponding entry.

6. Click Show Selected Entry Details. Figure 3-29 on page 3-25 displays.

Note: For DC and PE packages, the TSSC will provide the following features:

v To download a specific file from the call home package, click on the Data Package link.
This will allow you to extract the files from the package, but will not affect the contents of
the package when the call home file is offloaded.

v Below the package's header information you will see a listing of all of the packages in the
call home file.
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7. To refresh the Call Home Queue listing table, select Refresh Queue.

8. To offload a Call Home Queue Entry to Diskette, select the entry by clicking the check box next to the
corresponding entry.

9. Select Offload Selected Entries to Diskette. Figure 3-30 displays.

10. Click OK.

11. To Offload an individual package immediately, select the check box next to the package you want
offloaded and click the Send Call Home Now button. The page will return with a message to confirm
the completed action.
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Figure 3-29. Call Home Queue Management – Call Home Queue Entry Details
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Figure 3-30. Call Home Queue Management – Offload Queue Entry to Diskette
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Failed Queue Management

You can use the System Console to view the Failed Queue Management screens.

1. Right click from anywhere in the Desktop.

2. From the Main Menu, select System Console Actions –�Console Configuration Utility.

3. Type service in the Username field, type service in the Password field, then click OK to start the
Console Configuration application.

4. Click Call Home Queue.

5. Click Failed Queue at the top of the page. See screen shot below.
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Figure 3-31. Call Home Queue Screen.
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This screen shows the new Failed Queue interface. The Failed Queue Management tool offers the
following capabilities:

a. View Call Home entries that have failed on the System Console.

b. Return a failed queue entry back to the active Call Home queue.

c. Delete failed queue entries.

d. Offload individual packages immediately

e. View the details and associated log files of failed queue entries.

f. Offload failed Call Home entries.

6. To Delete or Force Delete a Failed Call Home Queue Entry, select the entry by clicking on the check
box next to the corresponding entry. Click Delete Selected Entries.

7. To Show Details for a Failed Call Home Queue Entry, select the entry by clicking the checkbox next
to the corresponding entry. Click Show Selected Entry Details. See the following figure.

Note: For DC and PE packages, the TSSC will provide the following features:

v To download a specific file from the call home package, click on the Data Package link.
This will allow you to extract the files from the package, but will not affect the contents of
the package when the call home file is offloaded.

v Below the package's header information you will see a listing of all of the packages in the
call home file.

8. To refresh the Failed Call Home Queue listing table, select Refresh Queue.

9. To offload a Failed Call Home Queue Entry to Diskette, select the entry by clicking the check box
next to the corresponding entry.

a
1
4

o
r4

7
9

Figure 3-32. Call Home Queue Management. Call Home Queue Entry Details
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10. Select Offload Selected Entries to Diskette. The following figure is displayed.

11. Click OK.

12. To view the log for a specific Failed Call Home entry, click view in the Log File column for the
corresponding entry. The following screen will be displayed at the bottom of the page.

13. To Offload an individual package immediately, select the check box next to the package you want
offloaded and click the Send Call Home Now button. The page will return with a message to confirm
the completed action.

Note: There are generally three cases to look for in the log file to determine why a particular call
home failed.

a. If you see a message stating the "Primary System Properties File Not Found," this means the
system attempting to call home is not attached to the TSSC. The system must be attached to the
TSSC before it can call home. When the machine is attached, this package can be moved back
to the Call Home Queue.
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Figure 3-33. Call Home Queue Management. Offload Queue Entry to Diskette
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Figure 3-34. Failed Queue Log File.
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b. For logs containing "Failing Machine Type: [####] Serial: [#######] is NOT REGISTERED in the
[CCPF] system," the attached machine is no longer under warranty and cannot call home. The
next line of support should be contacted if further help is required.

c. The last case will say that a "Duplicate file is in testcase." This means this call home package has
already been called home, and this copy can be discarded.

Call Home Event Log

You can use the System Console to view the Call Home Event Log and see the history of Call Home
packages that have been sent by the System Console.

1. Right click from anywhere in the Desktop.

2. From the Main Menu, select System Console Actions –�Console Configuration Utility.

3. Type service in the Username field, type service in the Password field, then click OK to start the
Console Configuration application.

4. Click Call Home Queue.

5. Click Call Home Event Log at the top of the page. See screen shot below.

6. You can use the Log Viewer Controls to sort the event log entries. Sort categories include the
following:

a. Number of entries per page

b. Type of Call Home package

c. Subsystem Type

7. Certain Call Home packages offer detailed information in addition to what is displayed in the event log.
When additional information is available, a Detail link will be displayed in the far right column. See the
following figure.
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Figure 3-35. Call Home Event Log.
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Figure 3-36. Call Home Event Log entries showing the Detail link
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8. Clicking the Detail link brings up another window with additional event information as shown in the
following figure.

Offloading User Files

You can use the System Console to offload user files by various means. For example, for user service,
the directory would be /home/service/offload. If you are logging on remotely, you can use the browser to
download the files onto your system.

1. Right click from anywhere in the Desktop to view the Main Menu shown in Figure 2-43 on page 2-37.

2. Select System Console Actions –> Console Configuration Utility. Login, as required.

3. Select Offload User Files. You see Figure 3-38 on page 3-31. The directory setting defaults to your
user's offload directory. For the user service, you will be prompted for the directory you wish to
download the data. The suggested directory is "/home/service/offload." You can change to a different
directory by adding another name in the "Specify a different offload directory" field, and clicking the
Refresh button next to that input area. You may also change directories by clicking a directory name in
the file list field.
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Figure 3-37. Detailed Event Log Information
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4. Left click the check boxes next to the file names to select individual files, or left click the box next to
the heading "File Name" to select all the files. You can press Refresh below the list to clear from the
check boxes all the choices you made.

Note: Your hardware platform will determine the options that are available on this menu. Only those
options that are available for your server type appear in the list.

5. Ensure that you have installed the media you are going to offload files to. Use Table 3-4 to determine
the media type or the method you are going to use to offload user files.

Table 3-4. "Offload User Files" Options

Menu Option Purpose

Copy to Diskette Copies files to the media type you select

Copy to USB

Copy to CD

Copy to Call Home Packages files in a data call home and places them in a Call Home queue for transmission

Delete Selected Deletes files from the directory
Warning: Do not delete files that are vital to System Console function.

Download Selected Compresses files into a file called ServiceOffloadBundle.zip.
Notes:
v You also may save a single, raw file by clicking on the filename, or right-clicking the

filename and selecting "Save target as." You will be prompted with a download box. If you
rename this file, do not allow in any blank spaces in the title you give it.

v Download Selected compresses the files into a smaller package to lessen the
transmission time. This is used primarily by IBM Support.

Refresh Refresh the screen (Figure 3-38)

Note: Select "Delete After Successful Copy" if you want to remove the files that you are copying from
the listing after you copy them.

6. You see a confirmation box. Ensure that you read all the text in the confirmation box. Click OK to copy
the files.

7. If you are logged in remotely, you may offload the files directly to your hard drive by clicking on the
filename in the table.

a
1
4
o
r3

6
2

Figure 3-38. Offload User Files Menu Example. This example does not include Copy to Diskette.
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Starting and Stopping ALC (Automated Log Collector)

This tool is used to gather log data associated with specific 3584 errors.

1. Right click from anywhere in the Desktop to view the Main Menu shown in Figure 2-43 on page 2-37.

2. Select System Console Actions –> Console Configuration Utility. You see the login prompt shown
in Figure 2-44 on page 2-38

3. Type service in the Username field, service in the Password field, then single click OK.

4. Select PE Packages -� Subsystem Log Retrieval link. You will see the image below.

5. In the “Select Logs” section, use the drop down to select a 3584.

6. From the new drop down that appeared, select an attached system.
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Figure 3-39. Subsystem Log Retrieval
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Figure 3-40. Select Logs
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7. In the error code identification strings text box type the error codes you want ALC to check for. You can
type all (which will include all error codes for log gathering), none (which will not gather logs for any
error code), or a list of comma-separated 4 digit hexadecimal numbers (an X may be used as a
wildcard and will match any number in its position).

If you want to turn on NVRAM log gathering, early termination, or debugging, simply check the check
box next to the options you want.

Then input how many days you want ALC to run. Don't try to run ALC forever, and run only under the
guidance and direction of a PFE.

8. Then click Start ALC.
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Figure 3-41. Select Attached System
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ALC has been successfully started on your selected 3584 library.

Every heartbeat error found by ALC will be called home.

Stop ALC from the Web Interface

1. Right click from anywhere in the Desktop to view the Main Menu shown in Figure 2-43 on page 2-37.

2. Select System Console Actions –> Console Configuration Utility. You see the login prompt shown
in Figure 2-44 on page 2-38

3. Type service in the Username field, service in the Password field, then single click OK.

4. Select PE Packages -� Subsystem Log Retrieval link. You will see the image below.

5. In the “Select Logs” section, use the drop down to select a 3584.
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Figure 3-42. Successfully Started ALC
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Figure 3-43. Subsystem Log Retrieval
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6. From the new drop down that appeared, select an attached system.

7. Click Stop ALC.
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Figure 3-44. Select Logs
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Figure 3-45. Select Attached System

Chapter 3. Procedures 3-35



ALC has been stopped on the selected 3584 library.

Start ALC from the Command Line

1. Log into the TSSC. See Figure 2-43 on page 2-37.

2. Click anywhere on the desktop, select Browser Functions -� Launch ALC Manager. You see the
figure shown below.
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Figure 3-46. Successfully Stopped ALC
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Figure 3-47. Start an ALC Process
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Note: If there are 3584s to start ALC against, the option “Start an ALC process” will appear.

3. To start ALC press the corresponding number next to “Start an ALC process” then press Enter.

A list of attached 3584 libraries appear. Libraries that already have ALC running will not show up here.

4. Find the 3584 you want to start ALC against from the list. Press the corresponding number, then
press Enter.

The script will now ask for the error code identification strings to define which error codes to check for.

5. Type all (which will include all error codes for log gathering), none (which will not gather logs for any
error code), or a list of comma separated 4 digit hexadecimal numbers (an X may be used as a
wildcard and will match any number in its position), then press Enter.
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Figure 3-48. Start an ALC Process
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Figure 3-49. Start an ALC Process
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You will now be asked if you want to turn on NVRAM log gathering.

6. Type Yes or No, then press Enter.

You now will be asked to turn on early termination.

7. Type Yes or No, then press Enter.
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Figure 3-50. Start an ALC Process
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Figure 3-51. Start an ALC Process
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Next, you will be asked to turn on debugging.

8. Type Yes or No, then press Enter.

Finally, you will be asked how long you want ALC to run.

9. Type a number greater than zero. Don't try to run ALC forever, and run only under the guidance and
direction of a PFE.

a
1
4

o
r4

9
3

Figure 3-52. Start an ALC Process
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Figure 3-53. Start an ALC Process
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ALC will now start.

Every heartbeat error found by ALC will be called home.

Stop ALC from the Command Line

1. Log into the TSSC. See Figure 2-43 on page 2-37.

2. Click anywhere on the desktop, select Browser Functions -� Launch ALC Manager. You see the
figure shown below.

Note: If there are ALC processes running, you will be given the option to stop them.

3. To continue, press the corresponding number next to "Stop an active ALC process", then press
Enter.
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Figure 3-54. Start an ALC Process
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Figure 3-55. Stop an ALC Process
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A list of 3584s with ALC running against them appear.

4. To stop ALC on one of the 3584s press the corresponding number of the desired library and Enter.

ALC has now stopped collecting logs against that 3584 library.

Configuring Assist On-Site (AOS)

AOS is a tool that allows remote desktop connections over the External broadband ethernet adapter to the
TSSC. It utilizes the same network as broadband call home and will work on either HTTP or HTTPS. The
AOS daemon will allow outbound connections only. It will establish connections by periodically connecting
to the AOS servers to determine if remote access is needed. If so, the daemon will establish the
connection and the remote user will have desktop access to the TSSC. For information on AOS, check its
internal website: https://aos.us.ihost.com/AssistOnSiteAdmin/docs/AOS_User_Guide.pdf
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Figure 3-56. Stop an ALC Process
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Figure 3-57. Stop an ALC Process
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Note: A DNS is required for AOS to find the AOS servers. To establish connection to a DNS, see section
“Console Settings” on page 2-58. Outbound traffic needs to be enabled to the following ports:

If HTTPS traffic only is required, remove the 72.15.208.234 IP from the firewall rules.

Table 3-5. Assist On-Site Table

Hostname / GEO IP Ports

aos.us.ihost.com 72.15.208.234 80

Americas Relay 72.15.208.234 443 or 80

EMEA Relay 81.144.208.229 443 or 80

Asia Pacific Relay 203.141.90.53 443 or 80

To Enable AOS Lights Out:

Right click the desktop -� System Console Actions -� AOS Functions -� Enable Lights Out.

This will enable AOS to allow for remote access without the need to confirm the remote takeover of the
TSSC.

To Disable AOS Lights Out:

Right click the desktop -� System Console Actions -� AOS Functions -� Disable Lights Out.

This will set AOS to require local confirmation of the remote takeover TSSC.

To Start AOS:

Right click the desktop -� System Console Actions -� AOS Functions -� Start AOS.

This will launch the AOS daemon and will enable AOS to run and establish connections based on the
AOS settings on the TSSC.

To Stop AOS:

Right click the desktop -� System Console Actions -� AOS Functions -� Stop AOS.
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Figure 3-58. AOS Manager Functions
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This will stop the AOS daemon from making any new connections. Any sessions currently in progress
will not be stopped. The remote user or a local user will be required to stop any established
connections if there are any.

To Query AOS:

Right click the desktop -� System Console Actions -� AOS Functions -� Query AOS Status.

The function will show you the current AOS settings on the TSSC. The query command checks the
following settings:

-� If Lights out is enabled or disabled

-� If AOS is running or not

-� The customer name that will be presented by the AOS client for establishing a connection to this
TSSC. AOS currently reports the hostname of the TSSC.

Note: If your TSSC is set to the default tssnet1, it will be very difficult to find your TSSC in the AOS client.
We strongly suggest updating the hostname to a unique hostname.

-� The AOS customer number. All TSSC's customer number is 1010000, and this field is not
configurable.

-� Tests connectivity to the AOS site, and if it is not successful, the script displays the reason for not
being able to connect to the URL.

Note: A DNS server is required for AOS to find the appropriate IP for establishing the connection with the
AOS server. To set a DNS server, see section: “Console Settings” on page 2-58.
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Figure 3-59. AOS Manager Functions
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To Configure a Proxy Server:

1. Right click the desktop -� System Console Actions -� AOS Functions -� Configure Proxy Server.

This function will allow you to configure a proxy server for use with AOS Lights Out.

You will be prompted for three pieces of information. This information is all provided by the customer.

– the proxy server hostname (or IP address)

– the proxy server port

– the (optional) authentication credentials.

To Configure Port Forwarding:

1. Right click the desktop -� System Console Actions -� AOS Functions -� Manage Port Forwarding.
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Figure 3-60. Manage Port Forwarding Interface
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You will see an interface like the image above. There are three possible actions to take:

1. To add a port forwarding target, press a and hit enter.

You will be prompted for a port forwarding hostname. This is the target to receive the forwarded traffic.
For example, if you want to forward traffic back to the TSSC itself, enter localhost, or if you want to
forward traffic to a machine at 172.31.1.10, enter that address.

Next, you will be prompted for the port to be forwarded. This port will depend on the traffic you wish to
forward. Some common choices can be found in the table below:

Port Service

22 SSH

23 Telnet

7080 TSSC Web GUI

Press Enter to save your new entry.

2. To remove a port forwarding target, press r and hit enter.

You will be asked to enter a number corresponding to the entry you wish to delete.
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Figure 3-61. Proxy Example
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For example, to delete the entry corresponding to localhost, 22 (in the picture above) choose 1.

Enter the entry to delete and press Enter.

3. To simply cancel without making any changes, press c and hit Enter.

Offloading User Files to Call Home Database (For Remote Users)

In addition to offloading files to various media types, you can offload larger files, files for later use, and
files requested by your next level of support to be sent to the RMSS Call Home Database:
https://callhomedata.tucson.ibm.com. The files must reside in the user's offload directory. For example,
for the user "service" the directory would be /home/service/offload. Subdirectories will not be included.

Note: Files that you offload to the Call Home Database use the same call home path as normal call
homes. Call Home Setup must be complete in order to use this function. See “Configuring Call
Home Settings Electronic Customer Care” on page 2-62 for more information on Call Home Setup.

1. From the main menu, select System Console Actions > Offload User Files to Call Home. If you are
using a dial-in session, issue the command offloadpkg. File offload begins. The window depicted in
Figure 3-63 on page 3-47 appears.
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Figure 3-62. Port Forwarding Target List
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Notes:
v If the user's files exceed 10MB, a warning displays that includes a prompt to abort. Before

you offload files larger than 10MB, consider that this may delay other call home activity on
this System Console. Additionally, if subdirectories are found in the user's offload directory, a
warning displays reminding the user that subdirectories are not included. The user may
choose to abort at this warning and move the files if the files within subdirectories are
desired to be included.

v An attempt to offload user files will fail if there are no files to be found in the user's offload
directory.

2. See Figure 3-63. A data ID is assigned to the user's files. This data ID must be entered to retrieve the
files on the RMSS Call Home Database. Make note of this ID for future reference. If the ID is lost, the
user's files can still be found by locating call homes from the System Console's Primary System on the
Call Home Database. The Primary System is set in Call Home Setup (see “Configuring Call Home
Settings Electronic Customer Care” on page 2-62). To assist in recording the ID, note that the ID
always takes the form described in the following example.

You can use the above information to confirm that you have correctly noted (for later use) a data ID.

Checking files . . .
Creating PE package . . .
Converting PE package to call home . . .
Your files have been offloaded via Call Home. Write down or save the
following data ID to retrieve the files:
p78-B2018p02004102615040022999

The files can be accessed globally at https://callhomedata.tucson.ibm.com/
(Authorized IBM Intranet users only)

Press Enter to finish

Offload Files to Call Home
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Figure 3-63. Offload Files to Call Home

Example Data ID: p78-B2018p02004102615040022999
p78-B2018p02004102615040022999
p - The first character in the data ID is always a p

p78-B2018p02004102615040022999
78-B2018 - The serial number of the Primary System, with a dash (-) in the 3rd position

p78-B2018p02004102615040022999
p0 - A p followed by position in frame (always 0 except for when a VTC is the primary system)
p78-B2018p02004102615040022999
20041026 - The date in the form YYYYMMDD

p78-B2018p02004102615040022999
150400 - The time (24-hr) in the form HHMMSS

p78-B2018p02004102615040022999
22999 - These digits, usually the process ID of the Offload Files program, uniquely identify this call home

Figure 3-64. Data ID Sample

Chapter 3. Procedures 3-47



3. The user's files are sent using a special call home package. Because this package must propagate
through the normal call home path it can take a few minutes to arrive at the Call Home Database.
Once it arrives, you can locate it by using the data ID given.

4. Once loaded on the Call Home Database, the user's files will appear as a regular call home, arriving
from the System Console's Primary System, as set in Call Home Setup (see “Configuring Call Home
Settings Electronic Customer Care” on page 2-62).

5. To locate the offloaded data that is on the Call Home Database, use a web browser on the IBM
intranet to go to the address: https://callhomedata.tucson.ibm.com/

6. From the left-side of the menu, choose Single System.

7. At the Call Home ID prompt, enter the data ID that appeared while files were unloading.

8. Click Look Up Call Home Data ID.

9. After the call home has been loaded, scroll down to the Files section to find the file you offloaded from
the System Console. You can use a web browser to download these files by clicking on the filename.

Console PE Package

Note: For 3956 CC6 (DS6000) PE Package creation, refer to the TS7700 Information Center search
string "problem determination DS6000."

You can use the System Console to create a PE (Product Engineering) package, then send that package
to IBM RETAIN by using the call home path. You derive this PE Package from console events log files and
trace files which reside on the System Console. Use the console creation tool to tailor the PE Package to
specific requirements, and to investigate and diagnose System Console problems.

1. Right click from anywhere in the Desktop to view the Main Menu shown in Figure 2-43 on page 2-37).

2. From the Main Menu, select System Console Actions --> Console Configuration Utility. You see
Figure 2-44 on page 2-38.

3. Type service in the Username field, type service in the Password field, then single click OK to start
the Console Configuration application. You see the Console Configuration Application screen shown in
Figure 2-45 on page 2-38.

4. Click the PE Packages icon. You see Figure 3-65 on page 3-49.
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5. Choose one of the selections in the Overall PE Package Limits box.

v Lines - Number of lines

v Elapsed Days - Number of days

v KBytes - Size of package

– – OR – –

v No Package Size Limit - Accepts any size

6. Choose one of the selections in the File Selection box.

v All files - Include all the files

– – OR – –

v By Category - Choose those which apply to your installation

Retrieving Subsystem Logs
Complete this task to retrieve subsystem logs.

1. Right click from anywhere in the Desktop to view the Main Menu shown in Figure 3-67 on page 3-50).

2. From the Main Menu, select System Console Actions --> Console Configuration Utility. You see
Figure 3-66 on page 3-50.

3. Type service in the Username field, type service in the Password field, then single click OK to start
the Console Configuration application. You see the Console Configuration Application screen shown in
Figure 3-67 on page 3-50.

4. Click the PE Packages icon. You see Figure 3-66 on page 3-50.
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Figure 3-65. Create Console PE Package Menu
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5. Click the Subsystem Log Retrieval tab at the top of the page. You see Figure 3-67. Follow the
instructions in the Select Logs box to select an attached system from which you would like to retrieve
logs.

Notes:
v The list you see will contain only those subsystems which are eligible for log retrieval

through the System Console.
v Some early levels of subsystem code do not support Subsystem Log Retrieval.
v If you do not see your system listed, verify that it is attached and can be queried

successfully from the attached systems page.

After you have selected your desired subsystem, you see one of the following options:

v 3957 - A getlogs options menu displays. All selections are optional. You may specify a start time,
including month, day, and hour for which to gather logs. All logs will be gathered from this time
forward. You also may specify one or more components to gather logs from as well as a specific file
you would like to gather.
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Figure 3-66. Create Console PE Package Menu
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Figure 3-67. Subsystem Log Retrieval Menu
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v 3592 - A minimal getlogs menu displays. All selections are optional. You may specify a start time,
including month, day, and hour for which to gather logs. All logs will be gathered from this time
forward. You also may specify a specific file you would like to gather.

v Library Manager - A savelogs options menu displays. All selections are REQUIRED. You must
specify a start time and an end time, including year, month, day, and hour. You must specify at least
one log type. You can specify multiple log types.

a
1
4
o
r3

5
8

Figure 3-68. Retrieve Log - 3957 Menu
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Figure 3-69. Retrieve Log - 3592 Menu
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v 3584 - After you select an individual 3584, the TSSC will query the library for the list of logs that are
available for download. When the log query is successful, the available logs display for you to
select. Select the logs you would like to retrieve.

Note: The System Console uses HTTP sessions to gather the 3584 logs. If gathering the log takes
excessive time between queries, the session will expire. Refresh the page to open a new
session.
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Figure 3-70. Retrieve Log - Library Manager

3-52 IBM TS3000 System Console Maintenance Information – 27th Edition August 2011



v 3958 - You will be prompted for a start time and day, the components you want to retrieve, and the
package size. You must select either a component or you must specify a filename.

Note: The "Big" option is not available in TSSC v 5.8 and higher with ProtecTIER RAS levels 7121
and higher.

6. After you have selected a means of retrieving a log, click Retrieve Logs in the Action box. The
TS3000 System Console (TSSC) gathers your logs. You see a message when your request is fulfilled.
The logs are gathered and are placed in the /var/enc/offload directory.

7. Click on Click here to offload the logs you gathered.
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Figure 3-71. Retrieve Log - 3584

Figure 3-72. Retrieve Log - 3958
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Console Status

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
Chapter 1, “Maintenance Starting Point,” on page 1-1 to determine the code level.

1. Right click from anywhere in the Desktop to view the Main Menu shown in Figure 2-43 on page 2-37.

2. From the Main Menu, select System Console Actions -–> Console Configuration Utility. You see
Figure 2-44 on page 2-38.

3. To login from the System Console, enter service in the Username field, enter service in the Password
field, and select OK to start the Console Configuration utility. You see Figure 2-45 on page 2-38.

– – OR – –

To login remotely (from another System Console), you must obtain an authentication ID (see “Login
Options” on page 2-35 for information on obtaining an ID). Launch your browser.

a. Enter the System Console location into the Address field.

b. Type your Authentication ID into the Username field, and your password into the Password field.
Click OK to start the Console Configuration utility. You see Figure 2-45 on page 2-38.

4. Click Console Status. You see Figure 3-73.

5. Use Table 3-6 to determine the path which you wish to follow.

Table 3-6. Console Status Tool Function

Function Description

Console Message File v Displays the contents of the communication message
file

v Provides a "Find..." tool for searching the file for a
specific word or phrase

See “Console Message File.”

Test RETAIN Connection Tests the telecommunication path between the System
Console and RETAIN (see “Test RETAIN Connection - As
a Service Procedure” on page 3-55)

Console VPD Displays Vital Product Data (VPD) information for the
System Console (see “Console VPD” on page 3-56)

Test ECC Connectivity Test communication path between the System Console
and Electronic Customer Care. This can also be used to
show ECC configuration info. (See “Test Electronic
Customer Care (ECC) Connectivity” on page 2-78).

Console Message File
1. From the Console Message File screen shown in Figure 3-73, select Console Message File.

2. Click Display Message File to view the message file. You see Figure 3-74 on page 3-55.
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Figure 3-73. Console Message File Screen
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Test RETAIN Connection - As a Service Procedure
1. From the Console Message File screen shown in Figure 3-73 on page 3-54, select Test RETAIN

Connection. You see Figure 3-75.

2. Select the test you want to run from the list on this menu. You see Figure 3-76 on page 3-56.
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Figure 3-74. Message File Screen
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Figure 3-75. Test RETAIN Connection Request Screen - As a Service Procedure
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3. Select Close This Window after you have performed your choice of tests.

Console VPD
From the Console Message File screen shown in Figure 3-73 on page 3-54, select Console VPD. You see
Figure 3-77. The VPD information is listed for you in the System Console Product Information box.

RAS Menus
The RAS Menu system is a comprehensive tool used to enhance remote support capabilities from the
command line. It is an interactive, menu-driven tool that provides the same service functionality as the web
interface.
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Figure 3-76. Test RETAIN Connection Results Screen - As a Service Procedure
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Figure 3-77. Console VPD Screen
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Local access

To access the RAS menu system locally:

1. Right click from anywhere in the Desktop to view the Main Menu shown in Figure 2-43 on page 2-37.

2. From the main menu, select the Terminal entry.

3. Enter the command rsRasMenu to open the RAS menus. The interactive menu system will display in
the terminal as seen in “RAS Menus” on page 3-56.

4. The main menu is broken down into categories. Make a selection by entering the number next to any
top-level menu entry. You will be taken to submenus that correspond to your selection.

5. You may exit the menus at any time by pressing E. To navigate back to the previous menu, enter B
when prompted.

Remote access

To access the RAS menu system remotely:

1. Connect to the target TSSC via an SSH session or modem.

2. Authenticate as a Service or Enhanced RMSS user and log in to the TSSC.

3. Once logged in at the command line, enter the rsRasMenu command. The interactive menu system will
be displayed as seen in “RAS Menus” on page 3-56.

4. The main menu is broken down into categories. Make a selection by entering the number next to any
top-level menu entry. You will be taken to submenus that correspond to your selection.

5. You may exit the menus at any time by pressing E. To navigate back to the previous menu, enter B
when prompted.

Taking Console Screenshots
1. To take a screen shot of the System Console, press the Print Screen button on the console keyboard.
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Figure 3-78. The top-level menu as displayed in a terminal window
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- It is sometimes useful to delay the screen shot command. If you would like to initiate a delayed
screen shot press Shift + PrintScreen on the console keyboard. This will capture the screen five
seconds later.

2. Screen shots will be placed in the offload directory of the currently logged in user. For example, if the
service user is logged in, this would be /home/service/offload.

3. To offload these screenshots, see “Offloading User Files” on page 3-30.
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Console Code Update

Use this procedure to upgrade the System Console microcode version to a newer level. This procedure
cannot be used for all code levels. If upgrades are not supported, the update console process will prompt
you for “Code Load/Hard Drive Rebuild” on page 3-60 if you are updating from 5.7.8 and higher.

Please refer to the following matrix to determine whether or not a code update will work.

Table 3-7. Code Upgrade Table

Release Levels

Upgrading to: From: Update Available?

5.0 - 5.2.11 < 5.0 No

5.0 - 5.2.11 5.0 - 5.2.11 Yes

5.3.7 - 5.4.11 < 5.3.7 No

5.3.7 - 5.4.11 5.3.7 - 5.4.11 Yes

5.5.12 < 5.5.12 No

5.5.22 - 5.5.28 < 5.5.22 No

5.5.28 - 5.6.5 5.5.22 Yes

5.7.X < 5.7.X No

5.8.X < 5.8.X No

5.9.X < 5.9.X No

5.10.X < 5.10.X No

1. Right click from anywhere in the Desktop to view the Main Menu, shown in Figure 2-43 on page 2-37.

2. From the Main Menu, select System Console Actions > Update Console Version. A Terminal screen
appears and requests you to insert the TSSC Product Recovery CD.

3. Insert the CD labeled "IBM TS3000 System Console Product Recovery CD." Press Enter.

Note: You can use this procedure only to upgrade to a newer version of microcode. To reload this
level of microcode or to load an older version of microcode, use the procedure in “Code
Load/Hard Drive Rebuild” on page 3-60.

The tool will compare the code version on the CD with the code version on the System Console. The
tool will inform you that the versions are compatible for upgrade, and that the upgrade will begin. If the
levels are not compatible for upgrade, the tool will prompt you to perform a “Code Load/Hard Drive
Rebuild” on page 3-60. The update process can take as long as fifteen minutes.

4. After a successful upgrade, right click on the desktop of the main menu to logout.

5. Select Logout. You are returned to the login screen seen in Figure 1-1 on page 1-1. This screen
displays the new code level.

6. Click on the Restart button to restart the System Console. After the System Console has restarted,
you are returned to this same login screen. The microcode upgrade is complete.
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Code Load/Hard Drive Rebuild

Attention:

v Many procedures in this book are specific to the level of code on the System Console. Before starting
any procedure, go to Chapter 1, “Maintenance Starting Point,” on page 1-1 to determine the code level.

v Rebuilding the hard disk drive will permanently destroy any local data present on the drive. Using the
Product Recovery CD-ROM will return the console to its "as shipped" state.

v Do not load or attempt to use the Product Recovery CD-ROM on any machine type other than 6579,
6792, 7978, 7946, 8480, 8482, 8485, 8836, or 8849. If you use the Product Recovery CD-ROM on any
other machine type, the installation will fail and that machine will be unusable.

Notes:
v Backup the Console configuration files before you re-image the hard drive. See “Backing Up

Configuration Data” on page 2-70 and “Restoring Configuration Data” on page 2-73).
v Do not attempt to restore configuration settings from a V1.x.x console onto a V3.x.x or higher

console. The files are incompatible. V2.x.x files are compatible with V3.x.x or higher.
v After you use this procedure, you will need to reload some software packages if you have

TS7700s in the Attached Systems list. Some examples of affected packages might include:
– “Installing DS6000 Graphical User Interface (GUI)” on page 2-50
– “Importing InfoCenter From CD-ROM” on page 3-76

1. Place the System Console Product Recovery CD-ROM in the CD Drive.

2. Log out of the System Console by right-clicking the desktop area and choosing Logout. Click OK.

3. After returning to the login screen, click Restart in the lower left area of the screen, and click Ok when
prompted to restart.

4. The prompt in Figure 3-79 appears after the System Console reboots (with the CD-ROM in place in the
CD drive).

5. Type y (or yes) and press Enter to start the hard drive re-image process.

6. You can monitor the progress of the installation from the screen. After the re-image is complete, the
System Console will reboot automatically. Remove the CD-ROM from the CD drive.

Notes:
v This procedure can take as long as 15 minutes to complete.
v You must be present at the completion of a reboot or the re-image will restart automatically.

If you are not present to remove the CD-ROM from the CD drive tray, the tray will retract
into the CD drive and the installation will start again. At the confirmation screen, type no,
and press Enter. Remove the CD-ROM from the CD drive, and allow the reboot to occur.

7. After initial reboot, the software will discover the machine type and model number of the computer,
automatically configure the appropriate drivers and settings, and automatically reboot the System
Console. During the second boot-up, the start up background and text may look slightly different. The
second boot will produce the login screen shown in Figure 2-41 on page 2-35. If the software
determines that the machine type is not 6579, 6792, 7978, 7946, 8480, 8482, 8485, 8836, or 8849, a
warning message will display on the screen and the System Console will halt. This will continue each
time the System Console is powered on. Similar symptoms occur after software installation if the
System Console is unable to determine its machine type and model.

TSSC Not Installed. Proceed. . .

This will install the Console onto /dev/sda which will erase everything on that device
Continue? (’yes’ or ’no’)
Abort

Figure 3-79. Pre-Installation Menu
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Note: If a product with a machine type of 6579, 6792, 7978, 7946, 8480, 8482, 8485, 8836, or 8849
reports a different machine type during an installation, the BIOS may have been corrupted.
Reboot the server, and make the appropriate selection during the reboot to enter BIOS setup. In
the BIOS, check the machine type that is configured. If the machine type does not match the
specific server, you should reinstall the system BIOS. Refer to the server documentation to
reinstall the BIOS and to set the correct machine type.

8. If you backed up the configuration, restore it now. See “Restoring Configuration Data” on page 2-73.

Disk Rebuild and Configuration Restore

Attention:

v Many procedures in this book are code specific. Before starting any procedure, go to Chapter 1,
“Maintenance Starting Point,” on page 1-1 to determine the code level.

v Rebuilding the hard disk drive will permanently destroy any local data present on the drive. Using this
feature will re-install the System Console while preserving all existing settings.

1. Right click from anywhere in the Desktop to view the Main Menu shown in Figure 2-43 on page 2-37.

2. From the Main Menu, select System Console Actions -� Disk Rebuild and Config Restore. You will
see Figure 3-80.

3. Insert your TSSC Product Recovery CD and press Enter.

Note: Your configuration will be backed up and the system will restart. Leave the Product Recovery
CD in the drive to launch the installation.

4. Once the system reboots, you will be prompted to install the System Console. Type "yes" to begin
installation.

5. After several minutes the installation will complete and you will be brought back to the login screen
seen in [Figure 1-1]. After the re-image is complete, the System Console will reboot automatically.
Remove the CD-ROM from the CD drive.
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Figure 3-80. Prompt for TSSC Product Recovery CD.
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System Console Specialist
IBM service personnel and the customer (usually an administrator) can use the System Console Specialist
for the following purposes:

v Change the System Console display language

v Perform tape drive code updates

v Launch library manager and Peer-to-Peer VTS specialists

v Administer users

Online help is available from the System Console Specialist by clicking the (?) Help icon located in the
upper, right of each screen. Online help is provided using Eclipse technology. For further information,
access the website at:
http://www.eclipse.org

Customer Access to System Console via Specialist
The customer user (usually an administrator) can login to the System Console by using a userid (use
“customer”) and a password (use “customer” again). After logging in, the customer user sees the System
Console Specialist screen.

Notes:
v A customer user may add users, delete users, or change passwords for any users in the

customer group who use the Administer Users tools.
v The 'customer' userid may not be deleted.
v Anytime a customer user exits the System Console Specialist, the customer user will be logged

out of the System Console.
v A customer user cannot make changes to the user ids for service users, but service users can

make changes to customer group users.

Tape Drive Code Update via Specialist

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
Chapter 1, “Maintenance Starting Point,” on page 1-1 to determine the code level. The code level
requirements are:

System Console
Code Version 2.5.0 and above

IBM 3494 Virtual Tape Server
Code Version 2.30.xx.xx and above

IBM 3590 A60 Tape Controller
Code Version 1.16.7.xx and above

IBM 3592 J70 Tape Controller
Code Version 1.17.4.xx and above

IBM 3592 C06 Tape Controller
Code Version 1.20.x.x and above

IBM 3494 ATL (L12, L14, L22)
Not currently operational

1. Ensure that the tape drives that are attached to 3590 A60 and 3592 tape controllers are varied offline
at the host before attempting a microcode update.

2. Launch the System Console Specialist by selecting Main Menu --> Browser Functions --> System
Console Specialist. A Welcome Page displays, with links (in the left navigation area) to functions.
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3. Click Update Drive Code. A screen appears which allows you to filter which drives are displayed and
are available for updating.

4. Select the drive types you wish to display, and select the sorting preference. Click Submit. A page
displays which presents the controllers that meet the selected criteria and that are currently available
for a code update.

5. Select drives to update by clicking the small plus sign next to the Controller Type column of the
controller that contains the drives to update. This will expand the entry in the table for that controller,
listing the available drives. The current code level will be displayed in the Current Code Level column.
Select a new code level from the Available Code Levels column.

6. Once all desired code level updates are selected, proceed with the update by clicking Update Code.

7. Verify that the microcode level update is complete by viewing the History table. This table will show
when each code update has started and when it has completed. It also will indicate if the process has
failed. It will be necessary to refresh the page periodically to view the status of the operation. Clicking
an entry in the History table displays details for the entry. See Table 3-8 for control unit error codes
and see Table 3-9 on page 3-64 for single tape drive error codes.

8. Click Refresh to refresh the status. You can click on an entry in the History table to obtain more
information about it.

9. Vary online all drives that are attached to 3590 A60 and 3592 control units which were previously
varied offline.

Note: Consult with your next level of support for questions and/or direction on code levels to apply to tape
drives.

Table 3-8. Control Unit Error Codes

This error code... ...informs you that...

0 Code update process is completed and all code updates are complete

22 Code update process is completed with some incomplete code updates

23 Code update process is completed with errors

24 Could not receive codeloadstatus file from subsystem. Code update process completed

1 Code activation is currently in progress on the specified subsystem

2 Subsystem code activation function did not receive the code update request file

3 rsENDriveCodeLoad.pl -L already running on System Console

4 Could not retrieve configuration for the subsystem with specified IP address

5 Specified subsystem does not support code updates through the System Console

6 No requested images are available on System Console

7 Error creating drive code package

8 Error creating drive code update request file

9 Subsystem does not have enough storage space available for code transfer

10 Communications error prevented a command from being sent to the subsystem

11 Incorrect arguments sent to subsystem drivecodecheck program

12 Warning: the subsystem could not remove the temporary archive file

13 Code image extraction failed on subsystem

14 Code image permissions change failed on subsystem.

15 Code image archive not received on subsystem

16 Subsystem command execution failed for an unknown reason

17 Lost process synchronization between System Console and subsystem

18 Status of code update is unknown. fork() call to launch drive code update command failed
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Table 3-8. Control Unit Error Codes (continued)

19 Multiple status update failures while waiting for drive code update process

20 Code update process did not return, status of code update unknown

21 Code update process returned with unexpected failure code

Table 3-9. Single Drive Error Codes

This error
code...

...informs you that...

25 Unable to communicate with drive

26 Device is open and in use (for example, not offline)

27 Device has no more internal memory

28 Device rejected command, incompatible or corrupted microcode file

29 Non-tape drive error when loading drive code

30 Code update process has been started
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Launching Specialists
1. Launch the System Console Specialist by selecting Main Menu --> Browser Functions --> System

Console Specialist. A Welcome Page displays, with links (in the left navigation area) to functions.

2. Click the Launch Specialists link in the left navigation area of the System Console specialist user
interface. A screen appears, which displays links to Specialist user interfaces for library managers and
peer-to-peer Virtual Tape Server controllers that are attached to the System Console.

3. Click the link of the Specialist user interface that you wish to launch.

Notes:
v If unique hostname aliases have not been assigned to library managers, all of the displayed

names will be the same for the library manager specialists. The IP address displays in the
bottom status bar of the browser.

v Web specialists for tape systems are optimized for certain Microsoft Windows-based web
browsers. You may receive a warning message that states this when you attempt to display the
tape system specialist. The tape system specialists display and operate by using the System
Console's browser. However, it is possible that some functions may not display or operate
correctly. Discontinue using the System Console's browser for tape system specialists if this
occurs.

v The specialists must be operational on the tape systems in order to view them on the System
Console. Refer to the Maintenance Information manual for the appropriate tape system for
activating and configuring its web specialist.

Administer Users

Launch the System Console Specialist by selecting Main Menu --> Browser Functions --> System
Console Specialist. A Welcome Page displays, with links (in the left navigation area) to functions. Click
the Administer Users link in the left navigation area of the System Console user interface. A screen will
load with options to add users, delete users, or change user passwords.

Adding a User

To add a user to the customer group, under the Add User heading:

1. Enter a new user id in the User ID field (8-character maximum).

2. Enter a password in the New Password field and repeat the password in the Confirm Password field.
(8-character maximum).

3. Click Add.

Deleting a User

To delete a user from the customer group, under the Delete User heading:

1. Select a user ID from the User ID drop-down list.

2. Click Delete.

Changing a User Password

To change a user's password, under the Change User Password heading:

1. Select a user ID from the User ID drop-down list.

2. Enter a password in the New Password field and repeat the password in the Confirm Password field.

3. Click Change.
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Error or Defer Matrix Updates

Occasionally, updates become available for the Error Call Home and Deferred Call Home capabilities of
attached subsystems. You can use the System Console to broadcast and activate these updates to
attached subsystems or to remove previously-applied updates. Do not manually download the updates.
The System Console will automatically download these updates as they become available.

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
Chapter 1, “Maintenance Starting Point,” on page 1-1 to determine the code level. The code level
requirements are:

System Console
Code Version 3.2.0 and above

IBM 3494 Virtual Tape Server and Virtual Tape Controller
Code Version 2.32.xx.xx and above

IBM 3592 J70 Tape Controller
Code Version 1.19.xx.xx and above

IBM 3592 C06 Tape Controller
Code Version 1.20.x.x and above

Broadcast and Activate Updates

1. Right click from anywhere in the Desktop to view the Main Menu shown in Figure 2-43 on page 2-37.

2. Select System Console Actions --> Error/Defer Matrix Updates to start the Error and Defer Matrix
updates tool. The dialog window in Figure 3-81 displays. This tool enables copying error/defer matrix
updates at the System Console to attached VTS, VTC, or tape controller systems over the local
network.

3. Type 1 to select 'Browse and Apply available error/defer matrix updates,' and press Enter to display
Figure 3-82 on page 3-67.
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Figure 3-81. VTS, VTC, or Tape Controller Error or Defer Matrix Update Menu
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4. Enter the number of the update you wish to apply or remove, and press Enter. A description of the
update displays (Figure 3-83). Read the description of the update. To apply the update, type y at the
prompt, and press Enter.

5. A list of compatible subsystems appears (Figure 3-84). Only subsystems that are compatible with the
selected update are shown. Select any subsystems for which you want to activate this update by
typing their numbers into the input area of the screen ('1' in this example). Press Enter.

6. When you have finished selecting systems, with your cursor in an inactive area on the screen (on a
blank line), press Enter. The update will be broadcast to each system, 'Yes' will replace 'No,' and the
status of the update will be shown as 'complete.' See Figure 3-85 on page 3-68.

IBM TS3000 System Console(tm)
VTS/Tape Controller Error/Defer Matrix Update Menu

1. Browse and Apply available error/defer matrix updates
2. Undo a previously applied error/defer matrix update
3. View Log
4. Quit

Enter the number of your selection and press [Enter]: 1
Reading files...

# Update name Date Compatibility
-------------------------------------------------------------------------------
[1] FID80B9 3/18/2005 3494-B20

3494-B10

Select error/defer matrix update to activate
Enter selection or just press [Enter] when complete:

Figure 3-82. Error or Defer Matrix Update Menu

Enter selection or just press [Enter] when complete:
1
Selection:
FID80B9
# Filename: FID80B9
# Compatibility: 3494-B20 3494-B10
# Created: 3/18/2005
#
# Defer call home for SIMs with refcode1 of
# 60B9.
#

Please read the update description above.
Are you sure you want to use this update? [y/N]
y

Figure 3-83. Error or Defer Matrix Menu - Apply Update

Select compatible systems to activate matrix update.
Only compatible systems are shown.
NO MODEL SERIAL HOSTNAME IP ADDRESS SELECT
=========================================================
1 3494B10 78B1510 raselvts 172.31.1.150 No

Enter selections (or de-selections) separated by spaces (ex: 1 3 5 7)
or press [Enter] when complete:
1

Figure 3-84. Error or Defer Matrix Menu - Compatible Systems
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Remove Previously-Applied Updates

This utility also can remove previously applied error and defer matrix updates. Removing or attempting
to remove an update from a system that did not have the update has no effect.

7. To remove an update, select 2 from the main menu. A list of available updates appears, as shown in
Figure 3-86.

8. Repeat Step 4 on page 3-67 through Step 6 on page 3-67 to remove an update.

Launching DS6000 Graphic User Interface (GUI)

Use this procedure to launch the DS6000 graphic user interface (GUI). To read about installing the GUI,
see “Installing DS6000 Graphical User Interface (GUI)” on page 2-50.

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
Chapter 1, “Maintenance Starting Point,” on page 1-1 to determine the code level.

1. Right click from anywhere in the Desktop to view the Main Menu shown in Figure 2-43 on page 2-37.

2. From the Main Menu, select Browser Functions > DS6000 Functions > Launch GUI. You see the
browser window in Figure 3-87 on page 3-69.

Select compatible systems to activate matrix update.
Only compatible systems are shown.
NO MODEL SERIAL HOSTNAME IP ADDRESS SELECT
=========================================================
1 3494B10 78B1510 raselvts 172.31.1.150 Yes

Enter selections (or de-selections) separated by spaces (ex: 1 3 5 7)
or press [Enter] when complete:

Applying changes to raselvts...complete

Figure 3-85. Error or Defer Matrix Menu - Systems Selection Broadcast

IBM TS3000 System Console(tm)
VTS/Tape Controller Error/Defer Matrix Update Menu

1. Browse and Apply available error/defer matrix updates
2. Undo a previously applied error/defer matrix update
3. View Log
4. Quit

Enter the number of your selection and press [Enter]: 2
PLEASE NOTE: You are deactivating an error matrix update. This action will
have no effect on systems that never had the update applied.
Reading files...

# Update name Date Compatibility
-------------------------------------------------------------------------------
[1] FID80B9 3/18/2005 3494-B20

3494-B10

Select error/defer matrix update to DEACTIVATE
Enter selection or just press [Enter] when complete:

Figure 3-86. Error or Defer Matrix Menu - Available Updates
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3. At the login screen, enter the username 'admin' and the password 'ibm2serv'.

Note: If an excess quantity of failed user-authentication attempts occurred, the GUI will lock out users
who attempt to login. If this occurs, return to the System Console desktop screen. Right click to
bring up the main menu. Select Browser Functions > DS6000 Functions > Reset GUI
Password. You will see Figure 3-88, which provides status on the password reset.

When the reset has completed, press Enter. Return to Step 2 on page 3-68 to continue.

4. Once the DS6000 GUI is launched, Figure 3-89 on page 3-70 displays.
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Figure 3-87. DS6000 GUI Login Username and Password Screen
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Figure 3-88. Reset DS6000 GUI Password Screen
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5. To set up communication with a TS7700 cache subsystem, from the Welcome column in the left frame,
click on Real-time manager.

6. From the resulting list (not shown), select Manage hardware, then select Storage complexes from
that resulting list. Figure 3-90 displays.

7. Click on Select Action, and from the resulting drop-down menu select Add Storage Complex. Click
on Go. Figure 3-91 on page 3-71 displays.
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Figure 3-89. Storage Manager Welcome Screen
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Figure 3-90. Storage Complexes : Real-time Screen
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8. Enter into the "Management console 1 IP address" field the TS7700 IP Address that was used for
TSSC attachment. This address should be in the form '172.31.1.x'. Select OK. This returns you to
Figure 3-90 on page 3-70. Your storage complex should now be listed. For all further DS6000 service
information including firmware upgrade, refer to the DS6000 InfoCenter.

Launching Storage Manager (SM) Graphic User Interface (GUI)

Use this procedure to launch the Storage Manager graphic user interface (GUI). To read about installing
the GUI, see “Installing Storage Manager (SM) Graphical User Interface (GUI)” on page 2-51.

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
Chapter 1, “Maintenance Starting Point,” on page 1-1 to determine the code level.

1. If you are not already logged into the TSSC, login. In the field for Username, type service, and in the
field for Password, type service.

2. Right click from anywhere in the Desktop to view the Main Menu shown in Figure 2-43 on page 2-37.

3. From the TSSC desktop, right click to invoke the menu for IBM TS3000 System Console.

4. From the Main Menu, select Browser Functions > Storage Manager GUI Functions > Launch
GUI. You see the browser window in Figure 3-92 on page 3-72.
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Figure 3-91. Add Storage Complex Screen
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5. From the Enterprise Management Window Tape Assistant screen, select Add Storage Subsystems
to add a storage subsystem.

6. If you just installed this GUI for the first time, or want to add another subsystem, perform the
following. If not, go to Step 9. From the Select Addition Method screen, choose one of these options:
v Automatic - to interrogate for storage subsystems and to add storage subsystems that are with in

the local subnetwork. Go to Step7

- - OR - -
v Manual - to add a storage subsystem that is outside the local subnetwork. Go to Step 8

7. From the Automatic Discovery screen, select OK to begin an automatic discovery of storage
subsystems on the local sub-network, or select Cancel to discontinue. When this is completed, go to
Step 9.

8. Select Additional Method > Manual and press OK.

a. From the dialog box for Add Storage Subsystem - Manual, select the radio button for In-band
management, then type the TCP/IP address for the TS7700 in the field for Host (DNS/Network
name, IPv4 address, or IPv6 address).

Note: The address you type should be 172.31.1.xxx that is listed in Table 3-10 on page 3-73.

b. Click Add.

c. If you add a storage subsystem successfully, you will see a dialog box that says: The specified
host was added successfully.

d. If you have more than one storage subsystem to add, click Yes, otherwise click No.

9. From the navigation for IBM System Storage Manager, select Devices.

10. Verify that the status is optimal. If so, exit. If not, contact the next level of support.

11. Return to the procedure that sent you here.
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Figure 3-92. Storage Manager GUI Initial Screen
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Table 3-10. TSSC IP Addresses

Field Value Notes

Master Console IP address 172.31.1.1 IP address of the Master Console.

Master Console Hostname
tssnet1

This is the recommended hostname
for the Master Console.

3957-VEA / VEB IP address on the
Master Console Network

172.31.1.xx

This is the recommended IP address
for the first TS7720 attached to a
master console. The last octet of this
IP address must be in an increment
of 10 between 10 and 240 (that is.
10, 20 ... 230, 240). The TS7720
router configuration will utilize this
and the following 9 IP addresses
(example: .150 - .159) so no other
device should be set to an IP address
in this range.

Subnet Mask on the Master Console
Network

255.255.255.0

Launching ProtecTIER Manager Graphical User Interface (GUI)

Use this information to launch the ProtecTIER Manager graphic user interface (GUI). To read about
installing the GUI, see “Installing ProtecTIER Manager Graphical User Interface (GUI)” on page 2-54.

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
Chapter 1, “Maintenance Starting Point,” on page 1-1 to determine the code level.

1. Right click from anywhere in the Desktop to view the Main Menu shown in Figure 2-43 on page 2-37.

2. From the Main Menu, select Browser Functions > ProtecTIER Functions > Launch GUI.

3. Refer to the TS7650 User's Guide (3958 family) for additional launching instructions.

Accessing Subsystem Interfaces

Use this procedure to access available subsystem web interfaces including Specialists and the IBM
TS7700 Management Interface.

1. Right click from anywhere in the Desktop to view the Main Menu shown in Figure 2-43 on page 2-37.

2. From the Main Menu, select System Console Actions -–> Console Configuration Utility. You see
the Main Configuration screen shown in Figure 3-93 on page 3-74.

Chapter 3. Procedures 3-73



3. Click on System Interfaces. You see Figure 3-94.

4. Click on the system you would like to connect to. This opens a browser tab that is connected to the
system you selected. The tab contains either the Specialist or the TS7700 Management Interface for
the system you selected. Refer to the documentation that applies to your selected system for more
help.

Managing InfoCenter From Web Interface

Use this web interface as an alternate way to add the Information Center (InfoCenter), or to launch the
Information Center from or to delete an InfoCenter level from the TSSC.

1. Right click from anywhere in the Desktop to view the Main Menu shown in Figure 2-43 on page 2-37.

2. From the Main Menu, select System Console Action -–> Console Configuration Utility. You see the
login prompt shown in Figure 2-44 on page 2-38.

3. Type service in the Username field, service in the Password field, then single click OK to start the
Console Configuration application. You see the menu shown in Figure 2-45 on page 2-38.

4. Select System Tools > Manage InfoCenter. You see Figure 3-95 on page 3-75.
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Figure 3-93. Main Configuration Screen
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Figure 3-94. System Selection Screen
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5. To import the InfoCenter from a CD-ROM, insert the CD-ROM into the CD drive of the System
Console, and click on Import InfoCenter.

6. After the import completes, the CD ejects. The page displays at the top if it was a success or if an
error occurred.

7. To launch the InfoCenter, from Figure 3-95, click on Launch InfoCenter. A new window opens in your
browser which points to the InfoCenter.

8. To delete a level of InfoCenter, from Figure 3-95, click on Delete InfoCenter. If there is at least one
level of InfoCenter installed it will be displayed in a box similar to the one shown in Figure 3-96.

9. From this box select the InfoCenter Level(s) you want to be deleted and click on Delete Selections to
confirm.
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Figure 3-95. Manage InfoCenter from Web Interface

a
1

4
o

r5
1

6

Figure 3-96. Different InfoCenter levels installed
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Importing InfoCenter From CD-ROM
1. Right click from anywhere in the Desktop to view the Main Menu shown in Figure 2-43 on page 2-37.

2. From the Main Menu, select System Console Actions –> Import InfoCenter. The Terminal screen
shown in Figure 3-97 appears, and asks you to insert the InfoCenter CD.

3. Insert the InfoCenter CD-ROM for the desired product, and press Enter. You will see the imported
Eclipse plugins and features. Eclipse restarts.

4. You may now Launch the InfoCenter. The imported information appears. Go to “Launching InfoCenter.”

Launching InfoCenter

Use this procedure to launch the InfoCenter. To read about installing the InfoCenter, see “Importing
InfoCenter From CD-ROM.”

1. Right click from anywhere in the Desktop to view the Main Menu shown in Figure 2-43 on page 2-37.

2. From the Main Menu, select Browser Functions > Launch InfoCenter. A browser window appears,
as seen in Figure 3-98 on page 3-77. This can take as long as 15 seconds to open.
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Figure 3-97. Insert InfoCenter CD Screen
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3. You should see the TSSC InfoCenter topics, as well as any imported InfoCenter in the column to the
left. You may select your appropriate topic or use the search box to navigate through the help
information.

Delete InfoCenter

Use this procedure to delete an InfoCenter level.

1. Right click from anywhere in the Desktop to view the Main Menu shown in Figure 2-43 on page 2-37.

2. From the Main Menu, select Browser Functions > Delete InfoCenter. A Terminal screen appears
displaying the different InfoCenter levels that are installed. (If there are no InfoCenter installed, a
message indicating this will be displayed). The user can select the Infocenter to delete by entering the
number of InfoCenter displayed on screen.

Updating TS7700 Cache Controller Microcode

Note: Before you begin this procedure, you must obtain the CD-ROM that includes the latest level of the
DS6000 microcode and the SEA.jar file. You should receive a CD-ROM whenever there is an
update to the DS6000 microcode.

Use this procedure to update the TS7700 Cache Controller microcode.

1. Ensure that you close all TSSC browser sessions. From the TSSC menu, click File > Close.

2. Insert the microcode CD-ROM into the CD drive of the TSSC.

3. Right click from anywhere in the Desktop, and select System Console Actions > CD Copy to
Console. You see Figure 3-99.
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Figure 3-98. Launching InfoCenter Window. Though not shown here, your selection will appear below "TotalStorage
Master Console Help."
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Figure 3-99. Select Save Location Screen
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4. At the command prompt (Your Selection ), type 1 to select /var/enc/cdrom. Press Enter. Expect a
delay as the CD drive copies information from the CD-ROM. This can take as long as 15 minutes to
complete. You will see Figure 3-100 when the copy is complete.

Note: If the directory has an existing microcode image installed, you will be prompted to overwrite
that existing image with the new image. Select Yes to continue.

5. Right click the desktop of the TSSC, and select Browser Functions > DS6000 Functions > Launch
GUI. This action invokes the TS7700 Cache Controller graphical user interface.

6. Login by typing the username admin and the password ibm2serv.

7. From the left hand navigation menu, select Real Time Manager > Manage Hardware > Storage
Units. You must wait for several minutes while the system builds the list of storage devices.

8. If you found in the list, the TS7700 Cache Controller onto which you want to install the DS6000
microcode, go to Step 10.

– – OR – –

If you did not find the TS7700 Cache Controller onto which you want to install the DS6000
microcode, go to “Launching DS6000 Graphic User Interface (GUI)” on page 3-68 to add the TS7700
Cache Controller to the TS7700 Virtualization Engine. Return here to Step 9.

9. Click Refresh to highlight the TS7700 Cache Controller in the list.

10. Click the check box to select the TS7700 Cache Controller on which you want to upgrade the
microcode.

11. In the drop-down menu for Select Action, select Apply Firmware Update.

12. Ensure that the drop-down box for Apply Firmware Update Real Time is set to Concurrent.

13. Click Select a file.

14. Select the file directory, or type the file directory path to where you downloaded the SEA.jar file in
Step 2 on page 3-77 through Step 5. As shown in this example, you would scroll to (or type) the
directory name /var/enc/cdrom.

15. Click Open, then click OK. This action copies the SEA.jar file to the TS7700 Cache Controller.

16. Scroll to and click Transfer File. The microcode is copied to the TS7700 Cache Controller. This task
can take as long as fifteen minutes to complete.

17. Click Activate after the Transfer File task completes. This Activate task can take as long as 1.5 hours
to complete.

Resetting Modem

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
Chapter 1, “Maintenance Starting Point,” on page 1-1 to determine the code level.

If your modem is hung after you dial in, you can use this information to use the Reset Modem button.

Note: Some modems have internal locks which prevent a software reset. If you are unsuccessful using
the procedure, you might need to power cycle the modem. Consult the modem documentation for
procedures.
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Figure 3-100. TS7700 Cache Microcode Copy Complete Screen
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1. Right click from anywhere in the Desktop to view the Main Menu shown in Figure 2-43 on page 2-37.

2. From the Main Menu, select System Console Actions > Console Configuration Utility > Call Home
Settings. You see the screen shown in Figure 3-101.

3. Under Call Home Communication Setup on this screen, select the Modem Port from the list. Click
Reset Modem.

Opening SSH Tunnel

Notes:
v Use this only when directed by your next level of support.
v This function may not be available for all levels of TS7700 code.
v To use this function to remotely access any of the interfaces that are listed, you need a local

route on your system that points to the local TSSC.

Your Support contact might ask you to open a tunnel so that they can gain access. Use this procedure to
open a Secure SHell (SSH) tunnel to access one of the attached subsystems from a remote location.

1. Right click from anywhere in the Desktop to view the Main Menu shown in Figure 2-43 on page 2-37.

2. From the Main Menu, select System Console Actions > Console Configuration Utility > System
Interfaces. You see the screen shown in Figure 3-102 on page 3-80

a
1
4
o
r3

5
5

Figure 3-101. Modem Reset Settings
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3. Click Create Tunnel next to the system to which you want to open a tunnel. You are granting system
access to a Support person.

4. After you and Support are satisfied with your activity, click on Close Tunnel to release the connection.

Note: If you do not close this tunnel, it will close automatically after four hours regardless of any
current operating status. You will need to reopen the tunnel to continue your activity.

Sending User Feedback

Use this information to send a comment to an IBM support group about the System Console. for
comments about this MI, see "Send Us Your Feedback" in the "Read This First" section of this MI.

1. Right click from anywhere in the Desktop to view the Main Menu shown in Figure 2-43 on page 2-37.

2. From the Main Menu, select System Console Actions > Console Configuration Utility > User
Feedback. Enter information into the User Name, User email address, and Comments fields.

Note: Do not add or allow spaces in the username.

3. Click Send Comments. This will create and send a PE package. You can review your comments in a
file entitled "userFeedback(firstnamelastname).(timestamp).txt" that is located in the
/var/enc/log/feedback directory.

Adding PFE Execs From Web Interface

You can add PFE Exec patches to the TSSC from the web interface. This web interface allows an
alternate way to add a PFE Exec patch to the TSSC, other than using menu options from the desktop
menu.

1. Right click from anywhere in the Desktop to view the Main Menu shown in Figure 2-43 on page 2-37.

2. From the Main Menu, select System Console Actions > Console Configuration Utility. Type
service in the Username field, type service in the Password field, then click OK.

3. Select the System Tools link.

4. Select the option at the top for TSSC Exec. You see Figure 3-103 on page 3-81
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Figure 3-102. SSH Tunnel Settings
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5. If you wish to use a CD-ROM that has the patch:

a. Insert the CD-ROM that has the patch on it.

b. Select CD-ROM > Add PFE EXEC.

– – OR – –

6. If you wish to use a USB Device that has the patch on it:

a. Plug in a USB device that has the patch on it.

b. Select USB Device > Add PFE EXEC.

– – OR – –

7. You also can add the patch if it is in your Home Directory.

a. If you know the patch is in your Home Directory, select Home Directory > Add PFE EXEC.

8. You see the window in Figure 3-104 which prompts you to verify that the PFE EXEC patch is on the
selected media. Select OK.

Figure 3-103. Adding PFE Exec from Web Interface

Figure 3-104. PFE Exec Patch
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9. A box showing the available PFE EXEC patches on the selected media is displayed:

10. Select the desired patch and click on Install Patch.

11. The process proceeds, then the page reloads. A message appears above the text depicted in
Figure 3-103 on page 3-81, noting the success or providing an error message.

Mksysb Broadcast from the Web Interface

Note: This process will keep only one version of the mksysb images. If you have a previous level on the
3957 and TSSC, this process will remove it before it downloads the new version.

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
Chapter 1, “Maintenance Starting Point,” on page 1-1 to determine the code level. The code level
requirements are:

System Console:

Code Version 5.5.20 and higher. DVD drive is required for this process. TSSCs with DVD drives are: 4362,
8485, 8849, 7978, 7946.

3957 - 8.6.x and higher

1. Right click from anywhere in the Desktop to view the Main Menu shown in Figure 2-43 on page 2-37.

2. From the Main Menu, select System Console Action -� Console Configuration Utility. You see the
login prompt shown in Figure 2-44 on page 2-38.

3. Type service in the Username field, service in the Password field, then single click OK.

4. Select System Tools -�Mksysb Broadcast link. You will see the image below.
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Figure 3-105. Multiple patch options
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If you have already downloaded an image that you want to broadcast, skip to step 8 on page 3-84,
otherwise, continue to the next step.

5. Select the Copy Mksysb DVDs And Broadcast button. This will prompt you to enter the first DVD
and select OK. Once you have inserted the first DVD, select OK to continue. The process of
downloading the first disk may take up to 20 minutes.

6. When the download has completed, you are prompted to insert the second DVD and continue:

The continue button is located above the log output. Remove the first DVD, insert the second DVD
and press the Continue button as shown below. If you wish to cancel this process, press the Cancel
Copy button, and you will return to the initial screen.
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Figure 3-106. Mksysb Broadcast Screen
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Figure 3-107. Mksysb Broadcast Screen - DVD Copy OK
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7. When the download of the second DVD has completed, a success message, "Broadcast list created
successfully. Please select machines to broadcast to" will display.

8. Below the logs, you will be able to select which machines you can broadcast this new mksysb image
to.

9. When submitting your systems for broadcasting you can send to an attached 3957-V06/V07 and
3957-VEA/VEBs, as well as other TSSCs with 5.5.20 or higher code levels in the same AOTM
network. The list of available systems will be presented as shown in the screen above. The screen
presents the Machine Type, Model, Manufacturing Code and Serial number, Local IP address,
Hostname, Code Level, and if the system has a copy of a mksysb image already present as well as
the date and time the file was sent.

Note: The 3957 will only keep one level of mksysb on the machine at a time.

Select systems for broadcast by typing the numbers in the box you wish to broadcast to (separated
by spaces) or leave it empty (for example 0 1 2 3).

v If you wish to broadcast to all systems, type "all" and hit submit

v If you wish to control the order of the broadcasts, specify them in the order you would like them to
be broadcast. (for example 2 3 0 1 will broadcast to 2 first, 3 second, 0 third, and 1 fourth)

v If you wish to broadcast to some systems in parallel, then instead of using a space to separate the
systems use a tilde (~). For example 0~1~2 3 will broadcast 0, 1, and 2 at the same time. Then 3
will broadcast as soon as 0, 1, and 2 have finished.

When the image broadcasting is complete, the screen will return and will present logs of the
transactions.
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Figure 3-108. DVD Copy for Mksysb Broadcast
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Figure 3-109. Choose Systems for Code Broadcast
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10. Select System Tools -�Mksysb Broadcast link. See Figure 3-106 on page 3-83. Make the
appropriate selection(s) as follows:

v Select 3. View the Log File

v Select 4. Clear the Log File

v Select 5. Eject the DVD

Setting 3958 and 3592 SNMP Trap Forwarding

Note: To use this to forward SNMP traps to the customer's network, you must obtain the IP address from
the customer.

1. Right click from anywhere in the Desktop to view the Main Menu shown in Figure 2-43 on page 2-37.

2. From the Main Menu, select System Console Actions > Console Configuration Utility > Call Home
Settings > SNMP Settings.

3. You will see a box for ProtecTIER SNMP Trap Forwarding if a 3958 is attached, and a box for Control
Unit SNMP Trap Forwarding if a 3592 is attached. You will see one of the following screens:

4. Select the Enable to IP Address button. This allows you to enter the IP address into the fields on this
screen.

5. Enter the IP address to which you want to forward SNMP traps. Select Apply.

Note: Select Disable to stop sending traps to the customer's network.

Tape System Reporter (TSR)

Note: The Tape System Reporter is a tool developed by the 3584 team that gathers statistical information
about the usage of the 3584 libraries attached to the TSSC. TSR data will be sent to the Call Home
Database when the TSSC performs a Heartbeat call home. See Figure 2-87 on page 2-62.

Starting Tape System Reporter (TSR)

1. Log into the TSSC. Figure 2-43 on page 2-37.
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Figure 3-110. Enabling ProtecTIER SNMP Trap Forwarding
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Figure 3-111. Enabling Control Unit SNMP Trap Forwarding
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2. Click anywhere on the desktop, select Browser Functions -�TSR Functions -� Start TSR.

Note: If TSR is running when a backup and restore is issued, TSR will restart. Also when the TSSC
reboots, TSR will restart.

Stopping Tape System Reporter (TSR)

1. Log into the TSSC.

2. Click anywhere on the desktop, select Browser Functions -�TSR Functions -� Stop TSR.

Fix Acquisition

Use this feature to find and download system and microcode updates for IBM Tape Storage devices.

1. Right click anywhere in the Desktop to view the Main Menu as shown in Figure 2-43 on page 2-37.

2. From the Main Menu, select System Console Action --> Console Configuration Utility. You see the
login prompt shown in Figure 2-44 on page 2-38.

3. Type service in the Username field, service in the Password field, then single click OK.

4. Select the Fix Acquisition link. You will see the following image:

5. To find all available updates, click the Find Updates button. Once the updates have been found, they
will be displayed on a screen similar to the image shown below:

6. Place a check in the box next to each update you wish to download. When the download selections
have been made, click the Download Selected Updates button to continue. If you want to exit without
downloading any updates, click the Cancel button instead.

7. Once all updates have been downloaded, you will see a success message.

v All downloaded updates can be found in the /var/enc/ecc/downloads folder. Each update is placed in
its own unique subdirectory.
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Figure 3-112. Fix Acquisition Main Menu
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Figure 3-113. Fix Acquisition Updates
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v The TSSC can be used to offload these packages, see “Offloading User Files” on page 3-30.

8. To delete previously downloaded updates from the TSSC, click the Clear Downloaded Updates
button as shown on Figure 3-112 on page 3-86

Mount/Unmount USB or CD-ROM

Note: This task mounts and unmounts a USB or CD-ROM drive.

1. Ensure the desired USB drive is connected to the TSSC, or a usable disk is inserted in the CD-ROM
drive.

2. Right click on the desktop and go to System Console Actions.

3. Under System Console Actions go to Mount Functions.

4. If a USB device has been connected and needs to be mounted, select Mount USB. If a disk was
inserted and needs to be accessed, select Mount CD-ROM. Select Unmount USB or Unmount
CD-ROM if the USB or CD-ROM device is no longer in use.

Mount/Unmount USB or CD-ROM Remotely

Note: A user can mount and unmount USB devices and CD-ROMs remotely through the command line.

1. To mount a USB device remotely type rsMount.sh usb and press Enter.

2. To unmount a USB device remotely type sudo rsUnmount.sh usb and press Enter.

3. To mount a CD-ROM remotely type rsMount.sh cd and press Enter.

4. To unmount a CD-ROM remotely type sudo rsUnmount.sh cd and press Enter.
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Figure 3-114. Fix Acquisition Success
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Chapter 4. Repair/Troubleshooting

System Console Repair

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
Chapter 1, “Maintenance Starting Point,” on page 1-1 to determine the code level.

In most cases, the standard procedures for PC repair apply for the System Console. The Product
Recovery CD-ROM contains the file XXXXSVC.PDF (the XXXX represents the PC Type, that is, 6579,
6792, 8480, or 8482) which is the Hardware Maintenance Information for the IBM PC.

This System Console MI details repair and replacement procedures for the System Console, and does not
address PC repair. Additionally, the service diagnostic program PC-Doctor is available on a separate
CD-ROM (see “IBM Enhanced Diagnostics CD-ROM” on page 4-3). If the online version of the MI
becomes corrupted on the System Console, you must reload the code to retrieve the MI.

There are two procedures which will require additional attention:

v Hard Disk Drive Replacement: When replacing the hard disk drive, replace it with at least a (30GB)
drive. After replacing the hard disk drive, follow the procedure outlined in “Code Load/Hard Drive
Rebuild” on page 3-60 to install the System Console for Service software (Model 8482 requires (80GB)
serial ATA HDD; see “Parts List” on page 4-4).

v Planar Replacement: When replacing the system planar, transfer the microprocessor and memory
modules from the removed system planar to the new system planar [at least 268MB (256MiB) of RAM
is required]. It also is important to reset the BIOS settings for Console Date/Time and Drive Selection
Startup Sequence, as outlined in Table 4-1.

It may be necessary to download the BIOS for a new planar upon installation. For downloadable files for
your machine type and model, see
http://www.ibm.com/support/us

Troubleshooting the TS3000 System Console

Attention: Many procedures in this book are code specific. Before starting any procedure, go to
Chapter 1, “Maintenance Starting Point,” on page 1-1 to determine the code level.

Table 4-1. Troubleshooting

You are here for this reason Perform this action

User interface "Lock Up" (mouse/menu items
inoperative)

Simultaneously press the Alt, Ctrl, and Backspace keys to
end the session and return to the login screen.

External modems connected and powered ON but
cannot be detected, and call home does not function

Use the reset modem function in call home settings to reset
the firmware settings for external modems. See “Configuring
Call Home Settings Electronic Customer Care” on page 2-62
for instructions.

Simultaneously pressing the Alt + Ctrl + Backspace
keys does not properly end session

(Only to be done as a last resort; can result in loss of data)
Disconnect the power cord, wait 10 seconds, reconnect the
power cord, and power ON the System Console.
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Table 4-1. Troubleshooting (continued)

You are here for this reason Perform this action

Perform service diagnostics on the console Use the IBM Enhanced Diagnostics CD-ROM to reboot the
System Console.
See:
v “Parts List” on page 4-4 for the part number
v Note 1 in “Parts List” on page 4-4 for details about

interoperability
v “IBM Enhanced Diagnostics CD-ROM” on page 4-3 for

usage instructions

Review hardware maintenance manual for IBM PC Insert the Product Recovery CD-ROM into a computer with
Adobe Acrobat Reader (version 4.0 or later). Open the file on
the CD-ROM entitled XXXXSVC.PDF (the XXXX represents
the PC Type, such as 6579, 6792, 8480, or 8482).

Attention: Do not attempt to install the Product Recovery
CD-ROM into any machine other than a System Console. You
will cause permanent and unrecoverable damage to that other
machine.

Perform procedure to set console date and time.
(See also “Setting Console Date and Time” on page
2-75.)

1. Power OFF the System Console for at least 10 seconds.

2. During power-up initialization, press F1 to enter the BIOS
Configuration/Setup Utility. Power ON the System
Console.

3. Use the Up/Down keyboard arrow keys to navigate to
Date/Time, then press Enter.

4. Enter the correct time of day HH:MM:SS (HH is 00 to 24;
use the arrow keys to navigate).

5. Enter the correct date MM:DD:YYYY.

6. Press ESC when finished.

7. Use the down arrow to select Save Settings. Press Enter
to continue.

8. Use the down arrow to select Exit Setup. Select Yes to
exit the Setup Utility.

Normal reboot should now occur.

Perform procedure to reset the proper drive selection
startup sequence. In the event of a planar
replacement, it will be necessary to reset the boot-up
sequence to Floppy Drive -> CD-ROM -> Hard Disk
Drive in order for the System Console to boot the
CD-ROM, if present.

1. During power-up initialization, press F1 to enter the BIOS
Configuration/Setup Utility. Power ON the System
Console.

2. Use the Up/Down keyboard arrow keys to navigate to
Start Options, then press Enter.

3. Press Enter again to set the Startup Sequence.

4. Use the arrow keys to navigate and to set the following:
v [Diskette Drive 0]
v [CD-ROM]
v [Hard Disk 0]
v [Disabled] Automatic Power On Startup Sequence

5. Press the Esc key twice when finished.

6. Use the Down arrow key to select Save Settings. Press
Enter to continue.

7. Use the Down arrow key to select to Exit Setup. Select
Yes to exit the Setup Utility.

Normal reboot should now occur.
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IBM Enhanced Diagnostics CD-ROM
This topic describes using the IBM Enhanced Diagnostics CD-ROM.

The IBM Enhanced Diagnostics program is a self-starting, DOS-based, diagnostic utility CD-ROM that you
can use to detect failing hardware components. IBM and PC-Doctor, Inc., maker of the PC diagnostic
software, have developed this diagnostic application to support the IBM PC 300, PC 700, NetVista,
IntelliStation, Netfinity 1000 and 3000, and certain xSeries products.

Starting the IBM Enhanced Diagnostics Program

1. Place the IBM Enhanced Diagnostics CD-ROM in the CD-ROM drive.

2. Logout of the System Console, and select the Reboot option.

3. The IBM Enhanced Diagnostics Program will start automatically.

4. After the diagnostic has completed, remove the CD-ROM and reboot the System Console to return to
normal operation.

Navigating the IBM Enhanced Diagnostics Program

You can use either the mouse or the keyboard to navigate the IBM Enhanced Diagnostics program. To
select an item with the mouse, click the item. To use the keyboard:
v Use the cursor-movement keys to highlight an item.
v Press Enter to select a highlighted item.
v Press Esc to return to the previous screen or menu.
v Press Enter to display online help.

Running Diagnostic Tests

To run the diagnostic tests, you select items from a list of test categories. The first two items in the list are:

Run Normal Test
Runs a predefined set of tests from the list of categories

Run Quick Test
Runs a subset of the Run Normal Test. The Run Quick Test takes less time to run than the Run
Normal Test.

To run diagnostics tests, perform these steps:

1. From the toolbar, select Diagnostics. A list of all the test categories appears.

2. Select and run diagnostic tests in any of the following ways.

a. Select Run Normal Test or Run Quick Test to run a predefined set of tests.

b. Select any category from the list. In the list of tests that appears, selected tests are indicated by
chevrons (>>).

c. To select or deselect a test, click beside the test, or highlight the test and press the Spacebar on
your keyboard. Press Ctrl+Enter to run all the selected tests in the category, or exit from that
category and display another category to make additional selections. When you have finished
making your selections, press F5 to run all the selected tests in all the categories.

d. Select any category from the list. In the list of tests that appears, select one test. This runs only
that test.

To stop a test at any time, press Esc.

As each test runs, the test results (N/A, PASSED, FAILED, ABORTED, or USER QUIT) are displayed on
the screen, beside each test name. Test results are also entered into a test log file.
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Using the IBM Advanced Memory Diagnostics

You can use the IBM Advanced Memory Diagnostics to identify a particular memory module (SIMM or
DIMM) that fails during testing.

Refer to the "System Board Layouts" section in the latest PC 300/700, NetVista, IntelliStation, Netfinity
1000 or 3000, or xSeries Hardware Maintenance Manual (HMM) to locate the memory sockets, or press
F1 twice to display the Online Manual, and select Chapter 11, SIMM/DIMM Locator.

The HMMs for the System Console PCs are included on the IBM System Console Rebuild and Product
Recovery CD-ROM as files xxxxSVC.PDF, where xxxx = the type of the PC. These files may be viewed on
any computer using Adobe Acrobat Reader.

You can perform either a full memory test or a quick memory test on all memory in the computer or on a
single memory socket.

v The full memory test detects marginal, intermittent, and solid (stuck) memory failures. It takes
approximately 80 seconds per 1.05 MB (1MiB) of memory.

v The quick memory test detects solid (stuck) memory failures only. It takes approximately 20 seconds
per 1.05 MB (1MiB) of memory.

Only populated sockets can be selected for testing. An unpopulated socket is indicated by "........" beside
the socket-test name.

To run the IBM Advanced Memory Diagnostics, perform the following steps.

1. From the toolbar, select Diagnostics.

2. Select Memory Test-Full or Memory Test-Quick.

Using the Hard-Disk Formatting Utilities

The IBM PC Enhanced Diagnostics program has two hard-disk formatting utilities.

v Quick Erase Hard Drive

v Full Erase Hard Drive

Attention: Using this program will render the System Console's Hard Disk Drive unusable by destroying
the Master Boot Record. The Master Boot Record is not replaced when re-imaging the Hard Disk Drive.
Do not use these utilities. It should not be necessary to reformat the hard disk drive in normal operation.

Viewing the Test Log

To view a list of test results and the details of failures, perform the following steps.

1. From any test-category screen, press F3 to display the test log.

2. Press F3 again to save the test log to a diskette, or press F2 to print the test log.

Parts List
This topic provides information for locating the parts list.

For part numbers that are related specifically to the PC, insert the IBM TS3000 System Console
Documentation CD-ROM in a Windows PC or notebook with Adobe Acrobat Reader (version 4.0 or later).
From the CD-ROM, open the file entitled IBM xSeries XXXX.PDF (the XXXX represents the PC Type; that
is, 6579, 6792, 8480, 8482, 8836, or 8849). Also open 'TSSC_Parts_Master_List.PDF' which lists specific
field replacable units (FRUs) for each model type.
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Notices

References in this publication to IBM programs or services do not imply that IBM intends to make these
available in all countries in which IBM operates. Any reference to an IBM product, program, or service is
not intended to state or imply that only IBM's product, program, or service may be used. Any functionally
equivalent product, program, or service that does not infringe any of IBM's intellectual property rights may
be used instead of the IBM product, program, or service. Evaluation and verification of operation in
conjunction with other products, except those expressly designed by IBM, is the user's responsibility.

This publication could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication. IBM
may make improvements and/or changes in the products and/or programs described in this publication at
any time.

This document contains general information, as well as requirements, for use on IBM and third-party
products. IBM makes no warranty, express or implied, as to its completeness or accuracy, and the data
contained herein is current only as of the date of publication. It assumes that the user understands the
relationship among any affected systems, machines, programs, and media.

IBM or third parties may have patents or pending patent applications covering subject matter described in
this document, including appearance design patents or applications. The furnishing of this document does
not constitute or imply a grant of any license under any patents, patent applications, trademarks, copyright,
or other rights of IBM or of any third party, or any right to refer to IBM in any advertising or other
promotional or marketing activities. IBM assumes no responsibility for any infringement of patents or other
rights that may result from use of this document or from the manufacture, use, lease, or sale of apparatus
described herein.

Licenses under IBM's utility patents are available on reasonable and non-discriminatory terms and
conditions. IBM does not grant licenses under its appearance design patents. You can send license
inquiries, in writing, to the IBM Director of Licensing, IBM Corporation, 500 Columbus Avenue, Thornwood
NY 10594, U.S.A.

For on-line versions of this book, we authorize you to:

v Copy, modify, and print the documentation contained on the media, for use within your enterprise,
provided you reproduce the copyright notice, all warning statements, and other required statements on
each copy or partial copy.

v Transfer the original unaltered copy of the documentation when you transfer the related IBM product
(which may be either machines you own, or programs, if the program's license terms permit a transfer).
You must, at the same time, destroy all other copies of the documentation.

You are responsible for payment of any taxes, including personal property taxes, resulting from this
authorization.

THERE ARE NO WARRANTIES, EXPRESS OR IMPLIED, INCLUDING THE WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.

Some jurisdictions do not allow the exclusion of implied warranties, so the above exclusion may not apply
to you.

Your failure to comply with the terms above terminates this authorization. Upon termination, you must
destroy your machine readable documentation.
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Trademarks
The following terms are trademarks of the IBM Corporation in the United States of America, other
countries, or both:

9076 SP2 AIX® AIX 6000
Application System/400® AS/400® Enterprise System/9000
ES/9000 ESCON® IBM
IntelliStation Netfinity(R) 1000 and 3000 NetVista
PC 300 and PC 700 POWERparallel RETAIN
RS/6000® Scalable POWERparallel Systems® SP2
System/390® System Storage TotalStorage
TotalStorage Master Console TS3000 Virtual Tape Controller
Virtual Tape Server xSeries

The following terms are trademarks of other companies:

Eclipse is a service mark of the Eclipse Foundation
Windows™ is a trademark of Microsoft, Inc.
PC Doctor™ is a trademark of PC Doctor, Inc.
UNIX is a registered trademark, licensed exclusively through X/Open Company Limited.
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Compliance Statements

Federal Communications Commission (FCC) Class A Statement
This equipment has been tested and complies with the limits for a Class A digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference when the equipment is operated in a commercial environment. This equipment generates,
uses, and can radiate radio frequency energy and, if not installed and used in accordance with the
instruction manual, may cause harmful interference to radio communications. Operation of this equipment
in a residential area is likely to cause harmful interference, in which case the user will be required to
correct the interference at his own expense.

Properly shielded and grounded cables and connectors must be used in order to meet FCC emission
limits. IBM is not responsible for any radio or television interference caused by using other than
recommended cables and connectors or by unauthorized changes or modifications to this equipment.
Unauthorized changes or modifications could void the user's authority to operate the equipment.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:
(1) this device may not cause harmful interference, and (2) this device must accept any interference
received, including interference that may cause undesired operation.

Industry Canada Class A Emission Compliance Statement
This Class A digital apparatus complies with Canadian ICES-003.

Avis de conformité à la réglementation d'Industrie Canada
Cet appareil numérique de la classe A est conform à la norme NMB-003 du Canada.

Taiwan Class A Electronic Emission Statement

Taiwan Contact Information
IBM Taiwan Product Service Contact Info:
IBM Taiwan Corporation
3F, No 7, Song Ren Rd., Taipei Taiwan
Tel: 0800-016-888
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Japan VCCI Council Class A Statement

Translation: This is a Class A product based on the standard of the VCCI Council. If this equipment is
used in a domestic environment, radio interference may occur, in which case, the user may be required to
take corrective actions.

European Union EMC Directive Conformance Statement
This product is in conformity with the protection requirements of EU Council Directive 2004/108/EC on the
approximation of the laws of the Member States relating to electromagnetic compatibility. IBM cannot
accept responsibility for any failure to satisfy the protection requirements resulting from a
non-recommended modification of the product, including the fitting of non-IBM option cards.

Attention: This is an EN55022 Class A product. In a domestic environment this product may cause radio
interference in which case the user may be required to take adequate measures.

Responsible manufacturer:
International Business Machines Corp.
New Orchard Road
Armonk, New York 10504
Tel: 919-499-1900

European community contact:
IBM Technical Regulations, Department M456
IBM-Allee 1, 71137 Ehningen, Germany
Tel: +49 7032 15-2937
E-mail: tjahn@de.ibm.com
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Glossary

This glossary defines the special terms,
abbreviations, and acronyms that are used in this
publication. If you do not find the term you are
looking for, see the “Index” on page X-1, or refer
to the IBM Glossary of Computing Terms, which is
located at the website:
www.ibm.com/ibm/termnology

Italicized text indicates terms found elsewhere in
this glossary.

A
AIX. (1) Advanced Interactive Executive. (2) IBM's
implementation of the UNIX operating system. The
RS/6000 system, among others, runs the AIX operating
system

AOTM. autonomic ownership takeover manager

ATL. Automated Tape Library

attention (notice). A word for calling attention to the
possibility of danger to a program, device, or system, or
to data. Contrast with caution and danger

B
baud. (1) A unit of signaling speed equal to the
number of discrete conditions or signal events per
second. (2) In asynchronous transmission, the unit of
modulation rate corresponding to one unit interval per
second; that is, if the duration of that unit interval is 20
milliseconds, the modulation rate is 50 baud. Also see
baud rate.

baud rate. (1) In remote communications, the
transmission rate that is synonymous with signal events.
The baud rate, or signal change rate, is usually
expressed in bits per second. Stated another way, the
baud rate is a measure of how many times per second
a signal changes or could change. (2) The default rate
of the IBM 3592 drive is 9600 baud. Also see baud.

BIOS. basic input/output system

C
caution (notice). A word to call attention to possible
personal harm to people. Contrast with attention and
compact disk-read only memory

CD-ROM. compact disk-read only memory

CE. (1) IBM customer engineer (2) Synonym for
service representative

code. A shortened term for microcode, which is used
throughout this MI

command. A control signal that initiates an action or
the start of a sequence of actions

controller. Deprecated term for control unit

control unit. (1) A device that provides the interface
between a system and one or more tape drives. (2)
Synonym forcontroller

CU. control unit

customer engineer (CE). Synonym for IBM service
representative

D
danger (notice). A word to call attention to possible
lethal harm to people. Contrast with attention and
caution

data. Any representations such as characters or
analog quantities to which meaning is or might be
assigned

deprecated. Not favored or not fully approved

E
EBTERM. Terminal emulator for OS/2

ELC. Enterprise Library Controller

EMT. electronic master transfer

error log. A dataset or file in a product or system
where error information is stored for later access

ESCON. Enterprise Systems Connection

F
FCC. Federal Communications Commission

FE. (1) field engineer (2) Though the term is not used
in this MI, it may be used in other documentation as a
synonym for customer engineer. (3) Synonymous with
service representative

Federal Information Processing Standards. See
FIPS

field replaceable unit (FRU). An assembly that is
replaced in its entirety when any one of its components
fails
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FIPS. (1) Federal Information Processing Standards
(2) Standards and guidelines developed and issued by
the National Institute of Standards and Technology
(NIST) and approved for Federal computer systems by
the Secretary of Commerce. When no acceptable
industry standards or solutions exist, NIST develops
FIPS to satisfy compelling Federal government
requirements, such as for interoperability and for
security measures like encryption. The pertinent
standard for this publication is FIPS PUB 140-2,
Security Requirements for Cryptographic Modules

format. The arrangement or layout of data on a data
medium

FP. file protect

FRU. field replaceable unit

G
GUI. graphical user interface

I
IBM. International Business Machines Corporation

identifier (ID). (1) In programming languages, a lexical
unit that names a language object. For example, the
names of variables, arrays, records, labels, or
procedures. An identifier usually consists of a letter
optionally followed by letters, digits, or other characters
(2) One or more characters used to identify or name a
data element and possibly to indicate certain properties
of that data element (3) A sequence of bits or
characters that identifies a program, device, or system
to another program, device, or system

intervention required. Manual action is needed

I/O. input/output

IOP. input/output processor

IPL. initial program load

L
LAN. (1) local area network (2) In a comparison of
geographic breadth, a LAN is a computer network that
is smaller than a MAN or a WAN

LED. light-emitting diode

LM. library manager

M
MAN. (1) metropolitan area network (2) Data network
designed for a town or a city. In a comparison of

geographic breadth, a MAN is a computer network that
is larger than a LAN but smaller than a WAN

MB. (1) megabyte (2) one million bytes

MI. Maintenance Information

microcode. (1) One or more micro-instructions (also
called ‘microprogram’). Resides in a part of storage that
is not program-addressable (2) Also called code in this
MI

MRPD. machine reportable product data

N
N/A. not applicable

NVS. (1) nonvolatile storage (2) A storage device
whose contents are not lost when power is cut off

O
offline. Pertaining to the operation of a functional unit
without the continual control of a computer, a server, or
other peripheral device. Contrast with online

online. Pertaining to the operation of a functional unit
that is under the continual control of a computer, a
server, or other peripheral device. Contrast with offline

P
PE. Product Engineering

PMH. problem management hardware

PMR. (1) problem management record (2) A PMR
number is assigned by RETAIN. This number is
returned to the system console when a problem is
successfully opened in RETAIN. In conjunction with a
Branch Office number, this uniquely identifies a problem
event for tracking through the RETAIN process

PMS. problem management software

R
RAM. random access memory

RAS. (1) reliability, availability, and serviceability (2)
Abbreviated term for product design characteristics, and
the Development team that manages those
characteristics

RETAIN. (1) IBM Remote Technical Assistance
Information Network (2) IBM Employees use this online
system to help resolve customer problems with IBM
products. The system contains records about reported
problems and the solutions (or fixes) that are developed
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for those problems. RETAIN also holds records of the
hardware and software owned by each IBM customer.

RMSS. Removable Media Storage Solutions sector of
IBM

S
SBC. system controller board

SCSI. small computer system interface

service representative. (1) Person who services your
equipment. (2) Synonymous with CE and customer
engineer

SIM. service information message

small computer system interface (SCSI). An input
and output bus that provides a standard interface
between the host system and the drive

SNMP. simple network management protocol

subsystem. A secondary or subordinate system,
usually capable of operating independently of, or
asynchronously with, a controlling system

System i. Term for IBM AS/400 products formerly
known as iSeries

System p. Term for IBM AIX-type products formerly
known as pSeries

System x. Term for IBM personal
computer/server-type products formerly known as
xSeries

System z. Term for IBM S/390-type processor
products formerly known as zSeries

T
TCP/IP. Transmission Control Protocol/Internet
Protocol. When in a tape library, the LAN
communication path between the host and the Library
Manager. This communication path is used for tape
library commands that do not require the tape drive,
while the SCSI bus is used for commands, data, and
responses that require the tape drive. All SCSI-attached
processors require an RS-232 or a LAN attachment for
library control

TSMC. (1) TotalStorage Master Console (2) Original
name of the TS3000 System Console (TSSC)

TSSC. TS3000 System Console

U
utility. utility program

utility program. A computer program in general
support of the processes of a computer. For instance, a
diagnostic program

V
VPD. (1) Vital Product Data. (2) The information
contained within the tape drive that requires nonvolatile
storage used by functional areas of the drive, and
information required for Manufacturing, RAS, and
Engineering

VTC. Virtual Tape Controller

VTS. Virtual Tape Server

W
WAN. (1) wide area network (2) In a comparison of
geographic breadth, a WAN is a computer network that
is larger than a LAN or a MAN

WEEE. European Union's Waste Electrical and
Electronic Equipment standards directive
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Index

Special characters
(Automated Log Collector), Starting and Stopping 3-32
(ECC) Connectivity, Test Electronic Customer 2-78
(TSR), Tape System Reporter 3-85

Numerics
3494

ATL
remote data monitoring 2-86
set up (LM) 2-23
test call home notification 2-81
web specialist 2-27

publications xvii
3584 publications xvii
3953

ATL remote data monitoring 2-86
feature code 2-5
frame serial number 2-25
modem 2-8
publications xvii
set up 2-23
specialist settings 2-26

3956 CC6
creating PE package (also refer to the TS7700

Information Center) 3-48
feature code 2-1

3958
enabling SNMP trap forwarding 3-85

A
abbreviations B-1
about this document

sending comments Y-1
access

for customer or CE to specialist 3-62
management interfaces 3-73
remote using NetTerm 3-19
tape drive code for update 3-62
via specialist to

system console 3-62
tape drive code update 3-62

acronyms B-1
add

attached system information 2-37
PFE exec from web interface 3-80
users to customer group 3-65

Adding a 3584 Model SC1 Complex System 2-41
Adding a Complex System 2-39
administer users 3-65
ALC (Automated Log Collector), Starting and

Stopping 3-32
AOTM

setting up 2-15
testing 2-19

ATL web specialist (3494)
tape system setup 2-23
using to change system console settings 2-27

authenticate server userid 2-35
autonomic ownership takeover manager

setting up 2-15
testing 2-19

B
backing up configuration data 2-70
baud rate, set for system console from

remote connection 2-70
system console 2-68

BIOS
definition B-1
enter 4-1
reload corrupted 3-60

broadcast
drive code from web interface 3-16
remote code from

web interface 3-8
Broadcast from the Web Interface, Mksysb 3-82

C
call home

configuring 2-62
notification test for

3494 ATL or 3953 Enterprise 2-81
VTS, VTC, A60, J70, and C06 2-80

offload contents to database (for remote
users) 3-46

queue management 3-23
record types 3-24
setting up 2-62
test notification for

3494 ATL or 3953 Enterprise 2-81
VTS, VTC, A60, and J70 2-80

TS7700 set up 2-12
VTS set up 2-20

Call Home Event Log 3-29
catalog, parts 4-4
CD-ROM

drive rebuild 3-60
feature code for drive rebuild 2-5
IBM enhanced diagnostics 4-3
offloading user files to 3-26, 3-30
product recovery 3-60

CD-ROM, Mount/Unmount USB 3-87
CD-ROM, Mount/Unmount USB Remotely 3-87
change

configuration 2-34
language 3-62
password 3-65
system console settings 2-27
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code
broadcast

from web interface 3-16
remote from web interface 3-8

load 3-60
rebuild 3-60
update console 3-59
update drive 3-62

code level V3.0.0 and above
access for tape drive code update 3-62
adding attached system information 2-37
backing up configuration data 2-70
call home queue management 3-23
call home record types 3-24
code load/hard drive rebuild 3-60
configuration 2-34
configure call home settings 2-62
console configuration sheet

sample 2-9
usable 2-9

console date and time, setting 2-75
console settings 2-58
console status 3-54
electronic customer care 2-62
error or defer matrix updates 3-66
feature codes 2-2
installing system console

about 2-1
performing 2-7

introduction 2-1
maintenance starting point quick reference table 1-1
offload

user files 3-30
user files to call home database (for remote

users) 3-46
procedures 3-1
restoring configuration data 2-73
service tools 3-1
set up for 3494 ATL (LM) 2-23
set up for 3953 Enterprise Library Controller 2-23
set up VTS, VTC, tape controllers 2-20
setting console date and time 2-75
setup for remote data monitoring 2-82
system overview 2-1
tape system service information 3-4
telnet to attached tape system 3-1
user login 2-34

code level V3.1.0
control unit tape drive service information files 3-13
view all files 3-16

code level V5.3.0 and above
remote code broadcast from web interface 3-8
schedule configuration backups 2-72

code load status
from web interface 3-11

code load/hard drive rebuild 3-60
comments

sending Y-1
comments about this MI iii
communication statements A-3
compliance statements A-3

components, system console 2-2
configuration

adding attached system information 2-37
backing up configuration data 2-70
call home settings 2-62
console date and time 2-75
data, backing up 2-70
electronic customer care 2-62
interface parameters 2-31
login options

authenticated 2-35
non-authenticated 2-35

prerequisites 2-34
restoring configuration data 2-73
router 2-22
schedule backups (code level V5.3.0 and

above) 2-72
setting baud rate for system console serial port

from remote connection 2-70
from system console 2-68

settings 2-29
sheet

sample 2-9
usable 2-9

test call home notification 2-80
test call home notification for 3494 ATL 2-81
user login 2-34
web specialist settings 2-29

configuring
Assist-on Site Session 3-41

Configuring Assist On-Site (AOS) 3-41
connect

to modem 3-21
to RETAIN 2-77

console
code update 3-59
configuration sheet
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edition
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this 27th edition iii
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Test 2-78
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Storage Manager
installing 2-51
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HTTP proxy IP address 2-62
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K
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L
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select system console specialist 3-62
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InfoCenter

from web interface 3-74
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reset 3-78
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Mount/Unmount USB or CD-ROM 3-87
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NetTerm
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overview of product 2-1

P
parameters, configure interface 2-31
parts list 4-4
password

change 3-65
resetting DS6000 GUI 3-68
resetting Storage Manager GUI 3-71
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specialist

about 3-62
access to tape drive code 3-62
administer users 3-65
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system console (continued)
specialist (continued)

launch 3-65
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parts list 4-4
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How to send your comments

Your feedback is important in helping to provide the most accurate and highest quality information. To
submit any comments about this book or any other product documentation:

v Send your comments by e-mail to starpubs@us.ibm.com. Be sure to include the following information:

– Exact publication title and Edition

– Publication Part Number and EC Number found on the back cover

– Page, table, or illustration numbers that you are commenting on

– A detailed description of any information that should be changed

© Copyright IBM Corp. 2002, 2011 Y-1
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